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Owner’s Record

The model and the serial numbers are 
located at the bottom. Record the serial 
number in the space provided below. Refer 
to these numbers whenever you call upon 
your Sony dealer regarding this product.

Model No. ______________
Serial No. ______________

WARNING

To reduce the risk of fire or electric 
shock, do not expose this 
apparatus to rain or moisture.

To avoid electrical shock, do not 
open the cabinet. Refer servicing to 
qualified personnel only.

IMPORTANT SAFETY 
INSTRUCTIONS
When using your telephone equipment, 
basic safety precautions should always be 
followed to reduce the risk of fire, electric 
shock and injury to persons, including the 
following:

1. Do not use this product near water, for 
example, near a bath tub, wash bowl, 
kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using a telephone (other than a 
cordless type) during an electrical storm. 
There may be a remote risk of electric 
shock from lightning.

3. Do not use the telephone to report a gas 
leak in the vicinity of the leak.

4. Use only the power cord and batteries 
indicated in this manual. Do not dispose 
of batteries in a fire. They may explode. 
Check with local codes for possible 
special disposal instructions.

SAVE THESE INSTRUCTIONS

ATTENTION
The electromagnetic fields at the specific 
frequencies may influence the picture of this 
unit.

CAUTION
To reduce the risk of fire, use only No. 26 
AWG or larger telecommunication line 
cord.

When installing the installation space must 
be secured in consideration of the ventilation 
and service operation.
• Do not block the ventilation slots at the left 

side and right side panels, and vents of the 
fans.

• Leave a space around the unit for 
ventilation.

• Leave more than 40 cm of space in the rear 
of the unit to secure the operation area.

When the unit is installed on the desk or the 
like, leave at least 4 cm of space in the left 
and right sides. Leaving 40 cm or more of 
space above the unit is recommended for 
service operation.

WARNING: THIS WARNING IS 
APPLICABLE FOR USA ONLY.
If used in USA, use the UL LISTED power 
cord specified below.
DO NOT USE ANY OTHER POWER 
CORD.

Plug Cap Parallel blade
(NEMA 1-15P 
Configuration)

Cord Type NISPT-2 or 
SPT-2, two 16 or 18 
AWG wires

Length Minimum 1.5 m (4 ft 
11 in), Less than 2.5 m 
(8 ft 3 in)

Rating Minimum 7 A, 125 V

Using this unit at a voltage other than 120 V 
may require the use of a different line cord or 
attachment plug, or both. To reduce the risk 
of fire or electric shock, refer servicing to 
qualified service personnel.
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WARNING: THIS WARNING IS 
APPLICABLE FOR OTHER 
COUNTRIES.
1. Use the approved Power Cord (2-core 

mains lead) / Appliance Connector / Plug 
that conforms to the safety regulations of 
each country if applicable.

2. Use the Power Cord (2-core mains lead) / 
Appliance Connector / Plug conforming 
to the proper ratings (Voltage, Ampere).

If you have questions on the use of the above 
Power Cord / Appliance Connector / Plug, 
please consult a qualified service personnel.

IMPORTANT
The nameplate is located on the bottom.

WARNING
Use the AC power adapter provided with 
this equipment as a power supply source. 

Manufacture Type No.
Sony VGP-AC19V45

Any other power sources may result in 
hazards such as a fire.
Disconnect device of this equipment is the 
mains plug of the AC adapter.
The mains plug on this equipment must be 
used to disconnect mains power.
Please ensure that the socket outlet is 
installed near the equipment and shall be 
easily accessible.
In the event of abnormal operations, 
disconnect the mains plug.

For the customers in the U.S.A.
This equipment has been tested and found to 
comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide 
reasonable protection against harmful 
interference when the equipment is operated 
in a commercial environment. This 
equipment generates, uses, and can radiate 
radio frequency energy and, if not installed 
and used in accordance with the instruction 
manual, may cause harmful interference to 
radio communications. Operation of this 
equipment in a residential area is likely to 
cause harmful interference in which case the 
user will be required to correct the 
interference at his own expense.

You are cautioned that any changes or 
modifications not expressly approved in this 
manual could void your authority to operate 
this equipment.

All interface cables used to connect 
peripherals must be shielded in order to 
comply with the limits for a digital device 
pursuant to Subpart B of Part 15 of FCC 
Rules.

This device complies with Part 15 of the 
FCC Rules. Operation is subject to the 
following two conditions: (1) this device 
may not cause harmful interference, and (2) 
this device must accept any interference 
received, including interference that may 
cause undesired operation.

This equipment complies with FCC 
radiation exposure limits set forth for an 
uncontrolled environment and meets the 
FCC radio frequency (RF) Exposure 
Guidelines in Supplement C to OET65. This 
equipment has very low levels of RF energy 
that it deemed to comply without maximum 
permissive exposure evaluation (MPE). But 
it is desirable that it should be installed and 
operated keeping the radiator at least 20 cm 
or more away from person’s body 
(excluding extremities: hands, wrists, feet 
and ankles).

This transmitter must not be co-located or 
operated in conjunction with any other 
antenna or transmitter.

For the customers in Canada
This Class A digital apparatus complies with 
CAN ICES-3 (A).
Cet appareil numérique de la classe A est 
conforme à la norme CAN NMB-3(A).

This device complies with Industry Canada 
licence-exempt RSS standard(s). Operation 
is subject to the following two conditions: 
(1) this device may not cause interference, 
and (2) this device must accept any 
interference, including interference that may 
cause undesired operation of the device.

The term “IC:” before the radio certification 
number only signifies that Industry Canada 
technical specifications were met.
IC:7424A-ZM260
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This equipment complies with IC radiation 
exposure limits set forth for an uncontrolled 
environment and meets RSS-102 of the IC 
radio frequency (RF) Exposure rules. This 
equipment has very low levels of RF energy 
that it deemed to comply without maximum 
permissive exposure evaluation (MPE). But 
it is desirable that it should be installed and 
operated keeping the radiator at least 20 cm 
or more away from person’s body 
(excluding extremities: hands, wrists, feet 
and ankles).

For the customers in Europe, 
Australia and New Zealand

WARNING
This is a Class A product. In a domestic 
environment, this product may cause radio 
interference in which case the user may be 
required to take adequate measures.
In the case that interference should occur, 
consult your nearest authorized Sony service 
facility. 

For the customers in Europe
The manufacturer of this product is Sony 
Corporation, 1-7-1 Konan, Minato-ku, 
Tokyo, 108-0075 Japan.

The Authorized Representative for EMC 
and product safety is Sony Deutschland 
GmbH, Hedelfinger Strasse 61, 70327 
Stuttgart, Germany. For any service or 
guarantee matters please refer to the 
addresses given in separate service or 
guarantee documents. 

This apparatus shall not be used in the 
residential area. 

NOTICE
Each of PCS-XG100S/XG77S and PCS-
RFZ1 contains an RF (Radio Frequency) 
transmitting and receiving module. 
Operation is subject to applicable local radio 
communication regulations in each country.
This equipment should be installed and 
operated with minimum distance 20 cm 
between the radiator & your body. This 
transmitter must not be co-located or 
operating in conjunction with any other 
antenna or transmitter.

For the customers in Taiwan only 

For the customers in Europe (PCS-XG100S/PCS-XG77S)

This manual focuses on using ISDN lines 
to conduct a videoconference, but it also 
covers non-ISDN lines. If you use ISDN 
lines, consult your Sony dealer for more 
information.
• The ISDN service may not be available 

in some areas.

Language Informal DoC

Bulgarian

С настоящето Сони Корпорация декларира, че този PCS-XG100S/  
XG77S/HD Visual Communication System отговаря на основните   
изисквания и другите сьответстващи клаузи на Директива 1999/5/EC.  
Подробности може да намерите на Интернет страницата :: 
http://www.compliance.sony.de/.
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Czech

Danish

Undertegnede Sony Corporation erklærer herved, at følgende udstyr 
PCS-XG100S/XG77S/HD Visual Communication System overholder de 
væsentlige krav og øvrige relevante krav i direktiv 1999/5/EF.
For yderligere information gå ind på følgende hjemmeside:
http://www.compliance.sony.de/

Dutch

Hierbij verklaart Sony Corporation dat het toestel PCS-XG100S/XG77S/HD 
Visual Communication System in overeenstemming is met de essentiële eisen 
en de andere relevante bepalingen van richtlijn 1999/5/EG. 
Nadere informatie kunt u vinden op: http://www.compliance.sony.de/

English

Hereby, Sony Corporation, declares that this PCS-XG100S/XG77S/HD Visual 
Communication System is in compliance with the essential requirements and 
other relevant provisions of the Directive 1999/5/EC. 
For details, please access the following URL: http://www.compliance.sony.de/

Estonian

Sony Corporation kinnitab käesolevaga seadme PCS-XG100S/XG77S/HD 
Visual Communication System vastavust 1999/5/EÜ direktiivi põhinõuetele ja 
nimetatud direktiivist tulenevatele teistele asjakohastele sätetele. 
Üksikasjalikum info: http://www.compliance.sony.de/.

Finnish

Sony Corporation vakuuttaa täten että PCS-XG100S/XG77S/HD Visual 
Communication System tyyppinen laite on direktiivin 1999/5/EY oleellisten 
vaatimusten ja sitä koskevien direktiivin muiden ehtojen mukainen. 
Halutessasi lisätietoja, käy osoitteessa: http://www.compliance.sony.de/

French

Par la présente Sony Corporation déclare que l’appareil PCS-XG100S/XG77S/ 
HD Visual Communication System est conforme aux exigences essentielles et 
aux autres dispositions pertinentes de la directive 1999/5/CE. 
Pour toute information complémentaire, veuillez consulter l’URL suivante: 
http://www.compliance.sony.de/

German

Hiermit erklärt Sony Corporation, dass sich das Gerät PCS-XG100S/XG77S/ 
HD Visual Communication System in Übereinstimmung mit den grundlegenden 
Anforderungen und den übrigen einschlägigen Bestimmungen der Richtlinie 
1999/5/EG befindet. 
Weitere Informationen erhältlich unter: http://www.compliance.sony.de/

Greek

Hungarian

Language Informal DoC

Sony Corporation tímto prohlašuje, že tento PCS-XG100S/XG77S/HD 
Visual Communication System  je ve shodě se základními požadavky a 
dalšími  příslušnými ustanoveními směrnice 1999/5/ES. 
Podrobnosti lze získat na následující URL: 

http://www.compliance.sony.de/

Με την η Sony Corporation δηλώνει τι PCS-XG100S/XG77S/

και τις λ της 1999/5/EK. 

http://www.compliance.sony.de/

HD Visual 

Alulírott, Sony Corporation nyilatkozom, hogy a(z) PCS-XG100S/
XG77S/HD Visual Communication System megfelel a vonatkozó 
alapvető követelményeknek és az 1999/5/EC irányelv egyéb előírásainak.  
További információkat a következő weboldalon találhat: 
http://www.compliance.sony.de/
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Italian

Con la presente Sony Corporation dichiara che questo PCS-XG100S/XG77S/ 
HD Visual Communication System è conforme ai requisiti essenziali ed alle 
altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE. 
Per ulteriori dettagli, si prega di consultare il seguente URL: 
http://www.compliance.sony.de/

Latvian

Lithuanian

Norwegian

Sony Corporation erklærer herved at utstyret PCS-XG100S/XG77S/HD Visual 
Communication System er i samsvar med de grunnleggende krav og øvrige 
relevante krav i direktiv 1999/5/EF. 
For flere detaljer, vennligst se: http://www.compliance.sony.de/

Polish

Niniejszym Sony Corporation oświadcza, że PCS-XG100S/XG77S/HD 
Visual Communication System jest zgodne z zasadniczymi wymaganiami 
oraz innymi stosownymi postanowieniami Dyrektywy 1999/5/WE. 
Szczegółowe informacje znaleźć można pod następującym adresem URL: 
http://www.compliance.sony.de/

Portuguese

Sony Corporation declara que este PCS-XG100S/XG77S/HD Visual 
Communication System está conforme com os requisitos essenciais e outras 
disposições da Directiva 1999/5/CE. 
Para mais informacoes, por favor consulte a seguinte URL: 
http://www.compliance.sony.de/

Romanian

Slovak

Slovenian

Language Informal DoC

Prin prezenta, Sony Corporation declară că acest PCS-XG100S/XG77S/
HD Visual Communication System respectă cerinţele esenţiale ș i  este în  
conformitate cu prevederile Directivei 1995/5/EC. 
Pentru detalii, vă rugăm accesaţi următoarea adresă: 

http://www.compliance.sony.de/ 

Sony Corporation týmto vyhlasuje, že PCS-XG100S/XG77S/HD Visual 
Communication System splňa základné požiadavky a všetky príslušné 
ustanovenia Smernice 1999/5/ES. 

Podrobnosti získate na nasledovnej webovej adrese: 

http://www.compliance.sony.de/

 

Sony Corporation izjavlja, da je ta PCS-XG100S/XG77S/HD Visual 
Communication System v skladu z bistvenimi zahtevami in ostalimi 
relevantnimi določili direktive 1999/5/ES. 
Za podrobnosti vas naprošamo, če pogledate na URL: 

http://www.compliance.sony.de/
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For the customers in Europe (PCS-RFZ1)

Spanish

Por medio de la presente Sony Corporation declara que el PCS-XG100S/
XG77S/ HD Visual Communication System cumple con los requisitos 
esenciales y cualesquiera otras disposiciones aplicables o exigibles de la 
Directiva 1999/5/CE. 
Para mayor información, por favor consulte el siguiente URL: 
http://www.compliance.sony.de/

Swedish

Härmed intygar Sony Corporation att denna PCS-XG100S/XG77S/HD Visual 
Communication System står I överensstämmelse med de väsentliga egenskapskrav 
och övriga relevanta bestämmelser som framgår av direktiv 1999/5/EG. 
För ytterligare information gå in på följande hemsida: 
http://www.compliance.sony.de/

Language Informal DoC

Bulgarian

Czech

Danish

Undertegnede Sony Corporation erklærer herved, at følgende udstyr 
PCS-RFZ1/ RF Remote Commander overholder de væsentlige krav og øvrige 
relevante krav i direktiv 1999/5/EF.
For yderligere information gå ind på følgende hjemmeside:
http://www.compliance.sony.de/

Dutch

Hierbij verklaart Sony Corporation dat het toestel PCS-RFZ1/RF Remote 
Commander in overeenstemming is met de essentiële eisen en de andere 
relevante bepalingen van richtlijn 1999/5/EG. 
Nadere informatie kunt u vinden op: http://www.compliance.sony.de/

English

Hereby, Sony Corporation, declares that this PCS-RFZ1/RF Remote 
Commander is in compliance with the essential requirements and other relevant 
provisions of the Directive 1999/5/EC. 
For details, please access the following URL: http://www.compliance.sony.de/

Estonian

Sony Corporation kinnitab käesolevaga seadme PCS-RFZ1/RF Remote 
Commander vastavust 1999/5/EÜ direktiivi põhinõuetele ja nimetatud 
direktiivist tulenevatele teistele asjakohastele sätetele. 
Üksikasjalikum info: http://www.compliance.sony.de/.

Language Informal DoC

С настоящето Сони Корпорация декларира, че този PCS-RFZ1/RF 
Remote Commander отговаря на основните изисквания и другите 
сьответстващи клаузи на Директива 1999/5/EC. 
Подробности може да намерите на Интернет страницата: 
http://www.compliance.sony.de/.

Sony Corporation tímto prohlašuje, že tento PCS-RFZ1/RF Remote 
Commander je ve shodě se základními požadavky a dalšími příslušnými 
ustanoveními směrnice 1999/5/ES. 
Podrobnosti lze získat na následující URL: 

http://www.compliance.sony.de/
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Finnish

Sony Corporation vakuuttaa täten että PCS-RFZ1/RF Remote Commander 
tyyppinen laite on direktiivin 1999/5/EY oleellisten vaatimusten ja sitä 
koskevien direktiivin muiden ehtojen mukainen. 
Halutessasi lisätietoja, käy osoitteessa: http://www.compliance.sony.de/

French

Par la présente Sony Corporation déclare que l’appareil PCS-RFZ1/RF Remote 
Commander est conforme aux exigences essentielles et aux autres dispositions 
pertinentes de la directive 1999/5/CE. 
Pour toute information complémentaire, veuillez consulter l’URL suivante: 
http://www.compliance.sony.de/

German

Hiermit erklärt Sony Corporation, dass sich das Gerät PCS-RFZ1/RF Remote 
Commander in Übereinstimmung mit den grundlegenden Anforderungen und 
den übrigen einschlägigen Bestimmungen der Richtlinie 1999/5/EG befindet. 
Weitere Informationen erhältlich unter: http://www.compliance.sony.de/

Greek

Hungarian

Italian

Con la presente Sony Corporation dichiara che questo PCS-RFZ1/RF Remote 
Commander è conforme ai requisiti essenziali ed alle altre disposizioni 
pertinenti stabilite dalla direttiva 1999/5/CE. 
Per ulteriori dettagli, si prega di consultare il seguente URL: 
http://www.compliance.sony.de/

Latvian

Lithuanian

Norwegian

Sony Corporation erklærer herved at utstyret PCS-RFZ1/RF Remote 
Commander er i samsvar med de grunnleggende krav og øvrige relevante krav i 
direktiv 1999/5/EF. 
For flere detaljer, vennligst se: http://www.compliance.sony.de/

Polish

Niniejszym Sony Corporation oświadcza, że PCS-RFZ1/RF Remote 
Commander jest zgodne z zasadniczymi wymaganiami oraz innymi 
stosownymi postanowieniami Dyrektywy 1999/5/WE. 
Szczegółowe informacje znaleźć można pod następującym adresem URL: 
http://www.compliance.sony.de/

Language Informal DoC

τις
 

http://www.compliance.sony.de/

Alulírott, Sony Corporation nyilatkozom, hogy a(z) PCS-RFZ1/RF Remote 
Commander megfelel a vonatkozó alapvető követelményeknek 
és az 1999/5/EC irányelv egyéb előírásainak. 
További információkat a következő weboldalon találhat: 

http://www.compliance.sony.de/

Ar šo Sony Corporation deklarē, ka PCS-RFZ1/RF Remote Commander 
atbilst Direktīvas 1999/5/EK būtiskajām prasībām un citiem ar to 
saistītajiem noteikumiem. 
Plašāka informācija ir pieejama: http://www.compliance.sony.de/

Šiuo Sony Corporation deklaruoja, kad šis PCS-RFZ1/RF Remote 
Commander atitinka esminius reikalavimus ir kitas 1999/5/EB Direktyvos 
nuostatas. 
Susipažinti su visu atitikties deklaracijos turiniu Jūs galite interneto 
tinklalapyje: http://www.compliance.sony.de/
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For the customers in Norway
Use of this radio equipment is not allowed in 
the geographical area within a radius of 
20 km from the centre of Ny-Ålesund, 
Svalbard.

For kundene i Norge
Det er ikke tillatt å bruke dette radioutstyret 
innen en radius på 20 km fra sentrum av 
Ny-Ålesund, Svalbard.

Portuguese

Sony Corporation declara que este PCS-RFZ1/RF Remote Commander está 
conforme com os requisitos essenciais e outras disposições da Directiva 1999/5/
CE. 
Para mais informacoes, por favor consulte a seguinte URL: 
http://www.compliance.sony.de/

Romanian

Slovak

Slovenian

Spanish

Por medio de la presente Sony Corporation declara que el PCS-RFZ1/RF 
Remote Commander cumple con los requisitos esenciales y cualesquiera otras 
disposiciones aplicables o exigibles de la Directiva 1999/5/CE. 
Para mayor información, por favor consulte el siguiente URL: 
http://www.compliance.sony.de/

Swedish

Härmed intygar Sony Corporation att denna PCS-RFZ1/RF Remote 
Commander står I överensstämmelse med de väsentliga egenskapskrav och 
övriga relevanta bestämmelser som framgår av direktiv 1999/5/EG. 
För ytterligare information gå in på följande hemsida: 
http://www.compliance.sony.de/

Language Informal DoC

Prin prezenta, Sony Corporation declară că acest PCS-RFZ1/RF Remote 
Commander respectă cerinţele esenţiale ș i este în conformitate cu 
prevederile Directivei 1995/5/EC. 
Pentru detalii, vă rugăm accesaţi următoarea adresă: 

http://www.compliance.sony.de/ 

Sony Corporation týmto vyhlasuje, že PCS-RFZ1/RF Remote 
Commander splňa základné požiadavky a všetky príslušné ustanovenia 
Smernice 1999/5/ES. 

Podrobnosti získate na nasledovnej webovej adrese: 

http://www.compliance.sony.de/

 

Sony Corporation izjavlja, da je ta PCS-RFZ1/RF Remote Commander v 
skladu z bistvenimi zahtevami in ostalimi relevantnimi določili direktive 
1999/5/ES. 

Za podrobnosti vas naprošamo, če pogledate na URL: 

http://www.compliance.sony.de/
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Precautions

Operating or storage location
Avoid operating or storing the system in the 
following locations:
• Extremely hot or cold places
• Humid or dusty places
• Places exposed to strong vibration
• Close to sources of strong magnetism
• Close to sources of powerful 

electromagnetic radiation, such as radios 
or TV transmitters

• Noisy places

Cleaning
Use a soft, dry cloth to gently wipe the 
cabinet and panel when cleaning the unit.
For heavier cleaning, use a cloth lightly 
moistened with a mild detergent to remove 
the dust, and finish by wiping again with a 
dry cloth. Do not use volatile solvents such 
as alcohol, benzene, thinners, or insecticides 
as they may damage the surface finishes.

For the customers in the U.S.A.
SONY LIMITED WARRANTY - Please 
visit http://www.sony.com/psa/warranty 
for important information and complete 
terms and conditions of Sony’s limited 
warranty applicable to this product.

For the customers in Canada
SONY LIMITED WARRANTY - Please 
visit http://www.sonybiz.ca/solutions/
Support.do for important information and 
complete terms and conditions of Sony’s 
limited warranty applicable to this 
product.

For the customers in Europe
Sony Professional Solutions Europe - 
Standard Warranty and Exceptions on 
Standard Warranty.
Please visit http://www.pro.sony.eu/
warranty for important information and 
complete terms and conditions.

For the customers in Korea
SONY LIMITED WARRANTY - Please 
visit http://bpeng.sony.co.kr/handler/
BPAS-Start for important information and 
complete terms and conditions of Sony’s 
limited warranty applicable to this 
product.

Note on laser beams
Laser beams may damage a CMOS image 
sensor. You are cautioned that the surface 
of a CMOS image sensor should not be 
exposed to laser beam radiation in an 
environment where a laser beam device is 
used.
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Using This Manual

The chapters cover the following contents; 
please read the chapters that may be required 
for your type of communication.

Chapter 1: Installation and 
Preparation
This chapter guides you through the system 
configuration and information required to 
use your HD Visual Communication System 
for the first time. It shows you how to install 
and connect your Communication System, 
to turn the system on/off and how to access 
basic on-screen menus.

Chapter 2: Registration and Setup for 
System Administrators
This chapter describes how to register and 
set up all the necessary items for system 
administrators, using the on-screen menus. 

Chapter 3: Basic Connection
This chapter guides you through the basic 
operations and settings for connecting to a 
remote party. You will learn how to start 
connection to finish it. It is recommended 
that this chapter be read by participants in a 
communication.

Chapter 4: Connection with Optional 
Equipment
This chapter shows advanced 
communication using the optional 
equipment, and functions such as streaming, 
recording, presentation and annotation.

Chapter 5: Encrypted Connection
This chapter shows how to connect to a 
remote party using an encrypted video and 

audio data, and encrypted data from a 
computer.

Chapter 6: Multipoint Connection
This chapter shows you how to connect your 
system to multiple sites. Multipoint 
connection requires installation of the 
optional PCSA-MCG106/MCG109 HD 
MCU software in your Visual 
Communication System.

The PCSA-MCG106/MCG109 software 
cannot be installed on the PCS-XG77S.

Chapter 7: Web Control Function
This chapter shows you how to control the 
Visual Communication System or set it up 
via a Web browser.

Chapter 8: Camera Units
This chapter describes the cameras that are 
recommended for use with this unit.

Appendix
The appendix contains descriptions of the 
controls and connectors on the components 
of the HD Visual Communication System, 
troubleshooting list, specifications, and a 
glossary.

Chapter 1: 
Installation and 
Preparation

Note
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Features

The PCS-XG100S/XG77S HD Visual 
Communication System is a communication 
system that provides face-to-face 
communications with a remote party by 
transmitting and receiving images and sound 
via LAN (Local Area Network) or ISDN 
(Integrated Services Digital Network) 
connections.

Supports ITU-T international 
standard
The HD Visual Communication System 
complies with ITU-T Recommendations 
defined by WTSC for easy connection with 
remote parties overseas.
ITU: International Telecommunication 
Union
WTSC: World Telecommunications 
Standardization Committee

Transmission and reception of 
high-definition images enabled
The Communication System supports the 
H.264 Baseline Profile and High Profile 
video encoding format, enabling 
transmission and reception of 1080p60 (Full 
HD) progressive video signals with a high 
resolution of 1920 × 1080 or 1280 × 720 by 
a maximum of 60 frames per second.

The PCS-XG77S does not support progressive 
video signals with a resolution of 1920 × 1080. 
However, installing the PCSA-RXG77 HD 
Upgrade Software (not supplied) allows 
transmission and reception of 1920 × 1080 
progressive video at a maximum of 60 frames 
per second.

Transmission and reception of wide 
range of stereo sound capability
The audio compression format of the 
Communication System supports MPEG4 
AAC (Advanced Audio Coding) stereo 
sound and 22 kHz monaural sound, allowing 
high-quality audio transmission and 

reception. The built-in echo canceller 
supports up to 16 kHz.

Supports data communication
Image output from a computer can be 
transmitted simultaneously with camera 
images.

High transmission speeds and 
high-quality picture capability
The Communication System accepts a LAN 
communication bit rate of up to 16 Mbps (up 
to 4 Mbps on the PCS-XG77S). It also 
allows you to connect to as many as three 
ISDN lines and use 6B channels with the 
optional PCSA-B384S ISDN Unit, and as 
many as six ISDN lines and use 12B 
channels with the optional PCSA-B768S 
ISDN Unit. 

When the PCS-XG100S is connected to other 
models (excluding the PCS-XG80S), the 
maximum communication bit rate is 4 Mbps.

Wide range of video/audio 
compression format selectable
The Communication System supports the 
H.264, H.263+, H.261 and MPEG4* video 
compression formats. It also supports the 
MPEG4 AAC**, G.722, G.728, and G.711 
audio compression formats.

* Supports MPEG4 only for connection using 
SIP.

** Supports MPEG4 AAC only for IP and 
ISDN connection.

“H.261” will be supported in version 2.0.

Annotation capability
The annotation function allows you to write 
letters or graphics on the screen or point with 
a pointer during communication using the 
optional pen tablet.

Note

Note

Note
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Up to 100 preset camera settings
Up to 100 settings for camera angle and 
zoom can be registered in the preset memory 
of the System. You can easily switch the 
shooting area only by recalling the preset 
position.

RF (Radio Frequency) Remote 
Commander adopted
The supplied Remote Commander controls 
the Communication System using the radio 
frequency of 2.4 GHz. The Remote 
Commander can be programmed for pairing 
with the System on a one-to-one basis to 
prevent interference from other systems.

On-screen keyboard
The on-screen keyboard displayed on the 
monitor screen allows you to input a 
number, address, etc. without moving your 
eyes away from the screen.

QoS (Quality of Service) function 
for optimization of bandwidth and 
traffic packet through network
The Communication System includes the 
“Packet Resend Request”, “Adaptive Rate 
Control”, and “Forward Error Correction” 
functions. Depending on the network status, 
these functions are used in Hybrid to 
guarantee consistent, high-quality 
communications.

Equipped with an HDMI connector 
The HDMI connector allows you to connect 
an HDMI display unit to the Communication 
System easily. Up to two displays can be 
connected to the PCS-XG100S.
In addition, only the PCS-XG100S allows 
video inputs from external devices via the 
HDMI connectors.

Supports USB storage
The Communication System is equipped 
with USB ports, allowing you to create a 
Private Phone Book and store the 

customized settings on a USB storage 
device.

For details on supported USB storage devices, 
consult your Sony dealer.

HD recording
Video and audio can be recorded to a USB 
storage device and can be viewed on a 
computer later.

HD streaming
You can broadcast streaming video and 
audio. This allows people who cannot attend 
the communication to watch the proceedings 
over the Web using a computer. You can 
also select whether to broadcast both video 
and audio or audio only. 

Supports a connection using SIP
The Communication System allows 
connection to a remote party with an IP phone, 
etc. using SIP (Session Initiation Protocol). 

The maximum communication bit rate during 
SIP connection is 4 Mbps.

Supports encrypted connection
The system allows you to make a strictly 
confidential connection using standard 
encryption, which complies with the H.233, 
H.234 and H.235 standardized by the ITU-T.

Supports multipoint connection
Installing the optional PCSA-MCG106/
MCG109 HD MCU software in your Visual 
Communication System allows connection 
among multiple points via a LAN or/and 
ISDN line.

This software cannot be installed on the 
PCS-XG77S.

Supports KIOSK mode
You can simplify operations and make 
calling with one-touch dial the only 
available operation.

Note

Note
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System Components
The PCS-XG100S/XG77S HD Visual Communication System is composed of 
basic system components for a basic communication, and optional equipment 
for an enhanced communication.

This manual explains how to operate the following systems.
• PCS-XG100S

HD Visual Communication System package that includes the main unit and two 
PCS-A1 Microphone units.

• PCS-XG77S
HD Visual Communication System package that includes the main unit and one 
PCS-A1 Microphone unit.

Components packaged in the PCS-XG100S

Basic System Components

Note

Unit Description
PCS-XG100S HD Visual 
Communication System

Contains the video codec, audio codec, echo 
canceller, network interfaces and system controller.

PCS-RFZ1
Remote Commander

Use this to control the HD Visual Communication 
System after pairing it with the system.

VGP-AC19V45 AC adaptor Supplies power to the Communication System.

PCS-A1 Microphone Omni-directional microphone that picks up sound 
relatively from all directions, allowing participants to 
speak from any location. It is recommended to use in 
a quiet situation (two pieces supplied).

F1
F2

F3
F4

T

W

/
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Components packaged in the PCS-XG77S

Optional equipment especially designed for use with the Communication 
System

The following optional devices are used to enhance your videoconference.

Unit Description
PCS-XG77S HD Visual 
Communication System

Contains the video codec, audio codec, echo 
canceller, network interfaces and system controller.

PCS-RFZ1
Remote Commander

Use this to control the HD Visual Communication 
System after pairing it with the system.

VGP-AC19V45 AC adaptor Supplies power to the Communication System.

PCS-A1 Microphone Omni-directional microphone that picks up sound 
relatively from all directions, allowing participants to 
speak from any location. It is recommended to use in 
a quiet situation (one piece supplied).

Optional Equipment

Unit Description

PCSA-B384S ISDN Unit Used to connect to an ISDN line. Up to three ISDN 
lines; 6B channels usable.

ISDN will be supported in version 2.0.

PCSA-B768S ISDN Unit Used to connect to an ISDN line. Up to six ISDN 
lines; 12B channels usable.

ISDN will be supported in version 2.0.

F1
F2

F3
F4

T

W

/

Note
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Cable
Use the following cable to connect a device in this system.

HDMI cable

PCSA-MCG106/MCG109 
HD MCU Software

Software required for multipoint connection using 
LAN or/and ISDN.

This software cannot be installed on the PCS-XG77S.

PCSA-RXG77 HD Upgrade 
Software

Use this to enable transmission and reception of 
progressive video signals with a resolution of 1920 × 
1080 on the PCS-XG77S.
When installed, the software allows transmission and 
reception at a maximum of 60 frames per second.

This software cannot be installed on the 
PCS-XG100S.

Cable Part No. Number

HDMI cable (3 m (9.8 ft)) 1-838-020-1x 1

Unit Description

Note

Note
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System Configuration
The PCS-XG100S/XG77S HD Visual Communication System has various 
system configuration capabilities using the basic components and optional 
equipment. This section describes the capabilities and necessary equipment for 
some typical configuration examples.

Although two PCS-A1 Microphones are depicted in the system configurations, only one 
microphone is supplied with the PCS-XG77S. 

This allows you to:
• Have a point-to-point HD visual communication over LAN.
• Pick up sound in stereo by using two microphones connected to the system.

System configuration

Note

System Configuration via a LAN

T

W

/

1 PCS-XG100S/XG77S HD Visual 
Communication System

2 PCSA-CXG100 HD Camera Unit (not 
supplied)

3 PCS-RFZ1 Remote Commander
4 TV monitor (not supplied)
5 PCS-A1 Microphones
23System Configuration



Connection to ISDN is required to use the PCSA-B384S or PCSA-B768S 
ISDN Unit especially designed for use with this system.

ISDN will be supported in version 2.0.

This allows you to:
• Have a point-to-point HD visual communication over ISDN.
• Pick up sound in stereo by using two microphones connected to the system.
• Hold an HD visual communication with high speeds and highest quality 

image transmission by connecting up to three ISDN lines (when using the 
PCSA-B384S) or by connecting up to six ISDN lines (when using the 
PCSA-B768S).

System configuration

About the number of ISDN lines and B (bearer) channels
Up to three ISDN lines (6B channels) with the PCSA-B384S ISDN Unit or up 
to six ISDN lines (12B channels) with the PCSA-B768S ISDN Unit can be 
connected to one Communication System. The more channels you use for a 
single communication, the faster speeds and higher-quality picture you can 
obtain for your network communication.

When connecting to the ISDN Unit, Use the ports in ascending order.
Yes: 1, 2, 3…
No: 1, 6, 5…

System Configuration via an ISDN

Note

Note

PCS-RF1
RF

F1 F2 F3 F4

T

W

/

1 PCS-XG100S/XG77S HD Visual 
Communication System

2 PCSA-CXG100 HD Camera Unit 
(not supplied)

3 PCS-RFZ1 Remote Commander
4 TV monitor (not supplied)
5 PCSA-B384S or PCSA-B768S 

ISDN Unit (not supplied)
6 PCS-A1 Microphones

This diagram depicts a system 
configuration using the PCSA-B768S 
ISDN Unit.

ISDN
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This allows you to:
• Have an HD visual communication with an IP telephone, etc. using SIP.
• Pick up sound in stereo by using two microphones connected to the system.

System configuration

Use the 1 (LAN1) connector (  (LAN) connector on the PCS-XG77S) on the 
Communication System when connecting your system via a SIP. Connection to a SIP 
server through the 2 (LAN2) connector is not available.

System Configuration via a SIP

Note

T

W

/

1 PCS-XG100S/XG77S HD Visual 
Communication System

2 PCSA-CXG100 HD Camera Unit 
(not supplied)

3 PCS-RFZ1 Remote Commander
4 TV monitor (not supplied)
5 PCS-A1 Microphones
6 SIP server
7 IP telephone, etc.

1
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This allows you to:
Connect your system to two networks using the 1 (LAN1) and 2 (LAN2) 
connectors. You can use the 1 connector to connect a private network in 
your company and 2 connector to connect to an intranet outside your 
company.

• The 2 connector is not available on the PCS-XG77S.
• If your system is connected to a LAN using the 2 connector, some of the intranet/

internet functions of your system, such as SIP server connection, gatekeeper 
connection, Telnet access, and Web access, are not available. If your system is 
connected to one LAN, use the 1 connector.

 For details, see “Restrictions on the Use of LAN2 (PCS-XG100S only)” on 
page 96.

System configuration

System Configuration Using Two LAN Connections (PCS-XG100S 
only)

Notes

T

W

/

1 PCS-XG100S HD Visual Communication System
2 PCSA-CXG100 HD Camera Unit (not supplied)
3 PCS-RFZ1 Remote Commander
4 TV monitor (not supplied)
5 PCS-A1 Microphones

Internet

1

2
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You need to install the PCSA-MCG106/MCG109 HD MCU software.

• A license key must be purchased and installed to use the HD MCU software. For 
details on purchasing license keys, consult your Sony dealer.

For details on installing license keys, see “Adding Optional Software” on 
page 187.

• This software cannot be installed on the PCS-XG77S.

This allows you to:
Have a multipoint HD visual communication among up to 16 sites over LAN.

System configuration

System Configuration via a LAN for Multipoint (PCS-XG100S only)

Notes

T

W

/

T

W

/

1 PCS-XG100S HD Visual Communication System
2 PCSA-CXG100 HD Camera Unit (not supplied)
3 PCS-RFZ1 Remote Commander
4 TV monitor (not supplied)
5 PCS-A1 Microphones
6 PCSA-MCG106/MCG109 HD MCU software (not supplied)
27System Configuration



You need to connect the optional PCSA-B384S or PCSA-B768S ISDN Unit 
especially designed for use with this system and to install the optional 
PCSA-MCG106/MCG109 HD MCU software.

• ISDN will be supported in version 2.0.
• This software cannot be installed on the PCS-XG77S.
• A license key must be purchased and installed to use the HD MCU software. For 

details on purchasing license keys, consult your Sony dealer.

For details on installing license keys, see “Adding Optional Software” on 
page 187.

This allows you to:
Have a multipoint HD visual communication among up to six sites over ISDN. 
(Connections with up to six points will be possible when either 
PCSA-MCG106/MCG109 is installed.)

System configuration

System Configuration via an ISDN for Multipoint (PCS-XG100S 
only)

Note

T

W

/

1 PCS-XG100S HD Visual Communication System
2 PCSA-CXG100 HD Camera Unit (not supplied)
3 PCS-RFZ1 Remote Commander
4 TV monitor (not supplied)
5 PCS-A1 Microphones
6 PCSA-MCG106/MCG109 HD MCU software (not supplied)
7 PCSA-B384S (not supplied) or PCSA-B768S (not supplied) ISDN Unit

This diagram depicts a 
system configuration using 
the PCSA-B768S ISDN Unit.

ISDN
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Installing the PCSA-MCG106/MCG109 HD MCU software in two 
PCS-XG100S HD Visual Communication Systems enables you to connect to 
multiple sites up to 10 via mixed LAN and ISDN lines.

• ISDN will be supported in version 2.0.
• This software cannot be installed on the PCS-XG77S.
• A license key must be purchased and installed to use the HD MCU software. For 

details on purchasing license keys, consult your Sony dealer.

For details on installing license keys, see “Adding Optional Software” on 
page 187.

This allows you to:
Have a multipoint HD visual communication among up to 10 sites over LAN 
and ISDN.

Be sure to connect two Communication Systems with the HD MCU software installed 
over LAN.

System configuration

System Configuration via a LAN and ISDN for Multipoint 
(PCS-XG100S only)

Notes

Note

T

W

/

1 PCS-XG100S HD Visual Communication System
2 PCSA-CXG100 HD Camera Unit (not supplied)
3 PCS-RFZ1 Remote Commander
4 TV monitor (not supplied)
5 PCS-A1 Microphones
6 PCSA-MCG106/MCG109 HD MCU software (not supplied)
7 PCSA-B384S (not supplied) or PCSA-B768S (not supplied) ISDN Unit

This diagram depicts a system 
configuration using the PCSA-
B768S ISDN Unit.

ISDN
ISDN
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System Connections
This section describes the typical system connections.

• Be sure to turn off all the equipment before making any connections.
• Do not connect/disconnect the camera cable, interface cable, or pen tablet with the power 

on. Doing so may damage the Camera Unit, Communication System or ISDN Unit.
• For safety, do not connect the 1000BASE-T connector to a network that applies 

excess voltage via the 1000BASE-T connector.
• Used with the ISDN Unit for the first time, the Communication System may 

automatically upgrade the software of the connected equipment. Upgrade the 
software according to the message displayed on the monitor screen. Be sure not to 
turn off the Communication System or disconnect the cable during upgrading. 
Otherwise, it may cause a malfunction of the system.

• We recommend using Sony’s HDMI cable.

Notes
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• Normally, connect the UTP cable to the 1 (LAN1) connector (indicated in green). 
If the UTP cable is connected to the 2 (LAN2) connector, some of the functions 
of your system may be restricted.

For details, see “Restrictions on the Use of LAN2 (PCS-XG100S only)” on 
page 96.

• The REC OUT jack is used to make an audio recording of a communication. This is 
not used during regular communication.

System Connection via a LAN

Notes

PCSA-CXG100 HD Camera Unit4)

to VIDEO 
OUT, VISCA 
IN, DC 12V

PCS-XG100S/XG77S1) HD 
Visual Communication System

Camera cable3)

Power cord3)

to CAMERA

to LAN

TV monitor4)

to a wall outlet

to DC19.5V

AC adaptor3) to a wall outlet

1) The HDMI IN, HDMI-2 OUT, and 2 
connectors are not available on the 
PCS-XG77S.

2)  connector on the PCS-XG77S
3) Supplied
4) Not supplied 

UTP cable (category 6, straight)4)

PCS-A1 microphone

to MIC (A1)

to 12)

to
HDMI-1

OUT

HDMI cable3)

to HDMI  IN
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ISDN will be supported in version 2.0.

The REC OUT jack is used to make an audio recording of a communication. This is not 
used during regular conferences.

System Connection via an ISDN 

Note

Note

PCSA-CXG100 HD Camera Unit3)

to TERMINAL

Camera cable 2)

Power cord2)

to 
CAMERA

TV monitor3)

to a wall outlet

Interface 
cable 
(supplied 
with ISDN 
Unit)

to ISDN UNIT

to VIDEO 
OUT, VISCA 
IN, DC 12V

PCSA-B384S ISDN Unit3)

to ISDN 1-6

ISDN Unit3)

to ISDN 1-3

ISDN modular cable3)

PCSA-B768S
ISDN Unit3)

AC adaptor2)

to a wall outlet

to 
DC19.5V

to ISDN

PCS-A1 Microphone

to MIC 
(A1)

to
HDMI-1

OUT

HDMI cable2)

to HDMI  IN

PCS-XG100S/XG77S1) HD Visual 
Communication System

1) The HDMI IN, HDMI-2 OUT, and 2 connectors are not available on the PCS-XG77S.
2) Supplied
3) Not supplied 
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• Normally, connect the UTP cable to the 1 (LAN1) connector (indicated in green). 
If the UTP cable is connected to the 2 (LAN2) connector, some of the functions 
of your system may be restricted.

For details, see “Restrictions on the Use of LAN2 (PCS-XG100S only)” on 
page 96.

• The REC OUT jack is used to make an audio recording of a communication. This is not 
used during regular communication.

System Connection via a SIP

Notes

PCSA-CXG100 HD Camera Unit4)

Camera cable3)

Power cord3)

to CAMERA

TV monitor4)

to a wall outlet

to VIDEO 
OUT, VISCA 
IN, DC 12V

SIP server

UTP cable (category 6, 
straight)4)

AC adaptor3)

to a wall outlet

to DC19.5V

PCS-A1 microphone

to MIC (A1)

to 12)

to LAN
connector

to LAN 
connector

IP telephone, etc.

to
HDMI-1

OUT

HDMI cable3)

to HDMI  IN

PCS-XG100S/XG77S1) 
HD Visual 
Communication System

1) The HDMI IN, HDMI-2 OUT, and 2 connectors are 
not available on the PCS-XG77S.

2)  connector on the PCS-XG77S
3) Supplied
4) Not supplied 

to LAN
connector
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To attach the Camera Unit to a tripod

Attach a tripod to the screw hole used for attaching a tripod on the bottom of 
the Camera Unit.
The tripod must be set up on a flat surface and tightened firmly by hand.
Use a tripod with screws of the following specifications.

4 = 4.5 – 6 mm
4 = 0.18 – 0.24 inches

Attaching the Camera Unit to a Tripod
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Preparing the System

CAUTION
Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type recommended by the manufacturer.
When you dispose of the battery, you must obey the law in the relative area or country.

Most of the operations with the HD Visual Communication System can be 
controlled with the supplied Remote Commander. 

1 Remove the battery compartment cover.

2 Insert two size AA (R6) batteries (supplied) with correct polarities into the 
battery compartment.

3 Replace the cover.

Be sure to insert the batteries E side first. Inserting them forcibly e side first may 
damage the insulated film covering the batteries and cause a short circuit.

Battery life
When the batteries are exhausted, the LED indicator does not light if you press 
any button and the Remote Commander does not function properly. Replace 
both batteries with new ones. 

Notes on batteries
To avoid damage from possible battery leakage or corrosion, observe the 
following:

Inserting Batteries into the Remote Commander

Note
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• Make sure to insert the batteries with the polarities in the correct direction.
• Do not mix old and new batteries, or different types of batteries.
• Do not attempt to charge the batteries.
• If you do not intend to use the Remote Commander for a long period of time, 

remove the batteries.
• If battery leakage occurs, clean the battery compartment and replace all the 

batteries with new ones.

Installing batteries
Two size AA (R6) batteries are supplied for the PCS-RFZ1.
To avoid risk of explosion, use size AA (R6) manganese or alkaline batteries.

The supplied Remote Commander controls the HD Visual Communication 
System using the radio frequency of 2.4 GHz. The Remote Commander and 
the Communication System are paired to prevent interference from other 
Remote Commanders and Systems.
Pairing between the Remote Commander and the Communication System is 
programmed at the factory. You can use the following procedure if you need 
to perform pairing with the main unit again. 

When performing a pairing procedure, be sure to turn off other HD Visual 
Communication Systems located nearby that are not targets for pairing. If multiple 
devices are turned on, the Remote Commander might pair device other than the target 
one.

To pair the Remote Commander with the main unit

1 Press the 1 (power) switch on the Communication System to turn it on.

The 1 (power) switch indicator on the Communication System flashes. 
The indicator lights in green when the Communication System turns on.

Pairing the Remote Commander with the Main Unit

Note

/

F1 F2 F3 F4

T

W

1 2 3

4 5 6

7 8 9

0

/

GHI JKL MNO

PQRS TUV WXYZ

ABC DEF

PRESENTATION

LAYOUT

RETURN

CONNECT

ON/OFF

MIC

BACK
SPACE DISCONNECT

TONE DOT

TOOLS

VOLUME ZOOM

VIDEO INPUT CAMERA

ENTER

LAN1-ALERT-LAN2      ONLINE

1080 60P

1

LED indicator

3
2
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2 Within 5 minutes after the power is on, locate the Remote Commander 

closer to the Communication System, and press the RETURN and TOOLS 
buttons at the same time.

The LED indicator flashes rapidly.

3 Press the ENTER button on the Remote Commander.

If the LED indicator flashes slowly 2 times, pairing between the units has 
succeeded.

When pairing has failed
After about 30 seconds, the LED indicator on the Remote Commander flashes 
slowly 5 times and then begins flashing rapidly. In this case, press the ENTER 
button on the Remote Commander again.

To cancel pairing
When the LED indicator on the Remote Commander is flashing rapidly, press 
the 1 (power) switch on the Communication System.

• When the LED indicator does not flash even if you press any button on the Remote 
Commander, the batteries might be exhausted. Replace both batteries with new ones.

• Once pairing is established between the units, it will not be erased even if the batteries 
are replaced.

• The operating range for the Remote Commander is 10 m. Depending on conditions, 
this range may be larger.

Notes
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Turning the System On/Off
This section describes how to turn on or off the Communication System.

1 Turn on the TV monitor.

2 Turn on the power of any other equipment to be used for this connection.

3 Press the 1 (power) switch on the Communication System to turn it on. 

The 1 (power) switch indicator on the Communication System flashes. 
The indicator lights in green when the Communication System turns on. 

The Home menu will appear on the monitor screen and the picture shot by 
the local camera will also appear in the Home menu.

Home menu

• After the power is turned on, the camera moves automatically for trial operation. Be 
careful not to catch your finger.

• If you use force to prevent the camera from moving, the camera may stop moving and 
the picture may not be displayed. In this case, turn off the System, and turn it on again.

Turning On

Notes

1 (power) switch

Connect

Camera

5/11/2008 13:00IP:XXX.XXX.XXX.XXX

Home

AAA Ready
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• When you turn on the power of the Communication System for the first time after 

installation, the setup wizard will appear after the self-diagnosis is completed. Set up 
your system following the wizard.

For setups using the wizard, see “Setting Up the System Immediately after 
the Installation – Initial Setup Wizard” on page 42.

• Used with an optional device especially designed for use with this system, such as the 
ISDN Unit, for the first time, the Communication System may automatically upgrade 
the software of the connected device. Upgrade the software according to the message 
displayed on the monitor screen. Be sure not to turn off the Communication System 
or disconnect the cable during upgrading. Otherwise, it may cause a malfunction of 
the system. System malfunction may also occur when a system power-off has been 
caused by an accidental problem such as a power interruption during upgrading. If 
connection of the Camera Unit, ISDN Unit, etc. to the Communication System is not 
re-established even after the system power is recovered, consult a Sony dealer.

• You can check the versions of the Communication System, optional dedicated 
equipment connected and the application software installed using the Machine Status 
menu.

For details on the Machine Status menu, see page 91.

To save power, the Communication System will enter standby mode if you do 
not operate it for a specified period of time. When the Communication System 
is in standby mode, the 1 (power) switch indicator lights in orange.
You can turn on the Communication System with any button on the Remote 
Commander if the System is in standby mode.
Once the Communication System receives a call, the standby mode is 
automatically released.

1 Display the Home menu on the monitor screen, then press the @/1 button 
on the Remote Commander.

The message “Power off?” appears on the monitor screen.

2 Press the V, v, B or b button on the Remote Commander to select OK, then 
press the ENTER button. 

Alternatively, you can press the @/1 button on the Remote Commander.

The Communication System enters standby mode, and the 1(power) 
switch indicator on the Communication System lights in orange.

To cancel setting the system to standby
Select “Cancel” with the V, v, B or b button on the Remote Commander, then 
press the ENTER button in step 2 above.

Standby Mode Function

Setting the HD Visual Communication System to Standby Mode
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To release the standby mode
Press any button on the Remote Commander.

To specify the standby time
Specify the time that you want the system to remain on before entering into 
standby mode (1 to 99 minutes) by setting “Standby Time” of the Device Setup 
page of the General setup menu. If you do not want the system to enter the 
standby mode, set “Standby Mode” to “Off”.

For the settings, see “Standby Time” and “Standby Mode” in the General 
setup menu on page 81.

1 Press the 1 (power) switch on the Communication System.

The message “Power off?” appears on the monitor screen.

2 Press the V, v, B or b button on the Remote Commander to select “Power 
off”, and press the ENTER button.

You can power off the system by pressing the @/1 (power) button on the 
Remote Commander.

The system turns off.

3 Turn off the power of other equipment used for the communication.

• Turn off the power switch on the Communication System when the system will not 
be used for an extended period. While the power switch is off, you cannot receive a 
call from a remote party.

• Be sure to unplug the power cord after the power of the system is turned off 
completely.

• If the system is unplugged for about 10 days or longer, the clock setting of the system 
may be reset. In this case, re-set the date and time in the Clock Set page of the General 
setup menu.

The procedure for volume adjustment during system setup differs from the 
procedure during communication.
Adjust the volume on the TV monitor during system setup, and adjust the 
volume on the Communication System while in communication.

Volume adjustment during setup

Before adjusting the volume on the TV monitor, set the volume on the 
Communication System to the appropriate position.

Turning Off

Notes

Adjusting the Volume on the TV Monitor
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1 Press the VOLUME +/– buttons on the Remote Commander to set the 

volume level on the adjustment bar displayed on the screen to the middle 
position.

2 Adjust the volume on the TV monitor so that you can properly hear a 
remote party’s speaking.

Do not activate the TV’s surround sound feature as it may cause the echo canceller of 
the Communication System not to function properly and make strange sounds.

Volume adjustment during communication

Press the VOLUME +/– buttons on the Remote Commander to adjust the 
volume on the Communication System during communication.

Note

11
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Setting Up the System Immediately 
after the Installation – Initial Setup 
Wizard

When you turn on the Communication System for the first time after 
installation and the self-diagnosis is completed, the setup wizard appears on 
the monitor screen. Register your local system data with the setup wizard using 
the Remote Commander. 
You can change the settings made with the setup wizard later using the setup 
menus.

The setup wizard will also be displayed when you install the PCSA-B384S or PCSA-
B768S ISDN Unit to your system later. Perform the setup again.

To select the on-screen language

1 Use the V, v, B or b button on the Remote Commander to select “Select 
Language” in the setup wizard, then press the ENTER button.

Note

Back to Tools

English

2007.11.29 14:21

IP

XXX.XXX.XXX.XXX

 Wizard

5/11/2008 13:00IP:192.168.0.11

Home Select Language

Set Region and Clock

Select Line I/F

Set up LAN

Set up ISDN

Set up SIP

Wizard Select Language

5/11/2008 13:00IP:192.168.0.11

Select the on-screen language.

English

CancelSave 

Select Language
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2 Use the V, v, B or b button on the Remote Commander to select the 

language to be used for the on-screen menus and messages.

Select from among English, French, German, Japanese, Spanish, Italian, 
Simplified Chinese, Portuguese, Traditional Chinese, Korean, Dutch, 
Danish, Swedish, Finnish, Polish, Russian, Arabic, Thai, Turkish, 
Norwegian, Welsh, Czech and Hungarian.

3 Use the V, v, B or b button on the Remote Commander to select “Save”, 
then press the ENTER button.

The setup wizard is restored.

To set the region and clock

1 Use the V, v, B or b button on the Remote Commander to select “Set 
Region and Clock” in the setup wizard, then press the ENTER button.

2 Set the region and clock items.

Select the region: Select the country or region where the system is used.
Select the display pattern: Select the display pattern of year, month and 

day.
Enter the year, Enter the month, Enter the day, Enter the time: Enter 

the date and time using the number buttons on the Remote 
Commander.

For the procedure to enter the numbers using the Remote Commander, see 
“Entering Characters Using the Remote Commander” on page 55.

3 Use the V, v, B or b button on the Remote Commander to select “Save”, 
then press the ENTER button.

The setup wizard is restored.

To select the line interface

1 Use the V, v, B or b button on the Remote Commander to select “Select 
Line I/F” in the setup wizard, then press the ENTER button.

Set Region and Clock

Wizard

Select the display pattern

Select the region

Enter the year

Enter the month

Enter the day

Enter the time

CancelSave

Year/Month/Day

Set Region and Clock
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2 Select the line interface to be used.

Which is your Line I/F?: Select from among IP, ISDN and SIP.
Which is your primary Line I/F?: If you select two or more interfaces 

with “Which is your Line I/F?”, select the interface you most use. 
Select from among IP, ISDN and SIP.

3 Use the V, v, B or b button on the Remote Commander to select “Save”, 
then press the ENTER button.

The setup wizard appears.

To set up a LAN connection

Select “Set up LAN” in the setup wizard, then set up a LAN connection.

To set up an ISDN line

Select “Set up ISDN” in the setup wizard, then set up an ISDN line connection.

To set up a SIP

Select “Set up SIP” in the setup wizard, then set up a SIP connection.

Select Line I/F

Wizard

Which is your Line I/F? (Multiple selection available)

IP

Which is your primary Line I/F?

ISDN SIP

IP ISDN SIP

CancelSave

Select Line I/F
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Using the Menus
The HD Visual Communication System uses the on-screen menus to make 
various adjustments and settings. This section explains how to adjust or set the 
items in the menus and gives a brief introduction to the menus.

The Home menu is displayed on the monitor screen when the system is
turned on and has not been connected to a remote party. The Home menu 
displays the image shot by the local camera, local system name, current date 
and time and buttons to open the menus.
You can select the items shown in the Home menu using the Home Menu1 to 
Home Menu3 pages in the Home Menu setup menu.
The descriptions of the items displayed in the Home menu are given below 
using the default menu and the menu with all items shown, as the examples.

Home menu (default)

Identifying the Home Menu

DialIPConnect

Camera

5/11/2008 13:00IP:XXX.XXX.XXX.XXXIP:XXX.XXX.XXX.XXX

Home

AAA Ready

1

8

qs

qf

23 4 6 7
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Home menu (with all items shown)

1 IPELA logo

B Background screen
Image shot by the camera is displayed.

C Local terminal name
The local terminal name set in the menu is displayed.

D IP address of the local system
The IP address of the local system is shown.
When “Internet Protocol” is set to “IPv4/IPv6” in the Administrator setup 
menu, the IPv6 IP address is also displayed.

• “IPv4/IPv6” for “Internet Protocol” will be supported in version 2.0.
• The first set of digits is not displayed for IPv6 IP addresses.

By changing the “Number Display” setting (page 83) on the Home Menu1 
page of the Home Menu setup menu, you can display the gatekeeper’s user 
name and user number, NAT address, etc. instead of the IP address.

E ISDN line number
The ISDN line number of the local system is shown.

ISDN will be supported in version 2.0.

F Local system status
The status on the local terminal is shown.

Notes

Note

Detailed Dial

Camera

Tools

History

Phone Book

DialIP

Office EOffice ARoom 201

F2

Room 101

F1 F3 F4

5/11/2008 13:00IP:XXX.XXX.XXX.XXX IPv6:XXXX:XXXX:XXXX:XXXXAAA Ready

Home NEAR

1

8
9

0
qa

qd

3 5 6 74

qf qg qh qj qk

ql

2
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G Date and time

The current date and clock are displayed.

H Camera button
The Camera menu opens when you select the button and press the ENTER 
button on the Remote Commander.
The Camera menu is used to adjust the camera angle or brightness, or to 
preset the camera adjustments and to move the camera to the preset 
position.

Camera menu

For details on the Camera menu, see page 135.

I Tools button
The Tools menu opens when you select the button and press the ENTER 
button on the Remote Commander.
The menu is used to carry out presentation, streaming, recording, 
annotation, etc. The Machine Status menu or Setup menus can be displayed 
using the buttons in the Tools menu.

Tools menu

For details on the Tools menu, see page 150.

For details on the Machine Status menu, see page 91.

For details on the Setup menu, see page 58.

Details

Previous

Adjustments

Brightness

Preset

Camera

5/11/2008 13:00

Machine Status

Setup

Home Presentation

Streaming

Recording

Annotation

[Suspended]

[Suspended]

[Suspended]

[Suspended]

Icon display

Reject Answer

Screen Capture

Tools

On

Off

Execute

Execute

Execute

Execute

Execute
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J History button
The History menu opens when you select the button and press the ENTER 
button on the Remote Commander.
The menu is used to check the incoming call and outgoing call histories or 
to call a remote party from the history list.

History menu

For details on the History menu, see page 112.

K Phone Book button
The Phone Book opens when you select the button and press the ENTER 
button on the Remote Commander.
The menu is used to register a remote party to the Phone Book or to call a 
remote party registered in the Phone Book.

Phone Book

For details on the Phone Book, see page 121.

L Connect button
The Connect menu opens when you select “Connect” in the Home menu 
and press the ENTER button on the Remote Commander.
The Connect menu is used to call a remote party.

Detailed Dial

History

Phone Book

IP:192.168.0.11

Home

5/11/2008 13:00

Missed Call

Answer

Dial Dial History1
 111.111.111.112 2008/05/01 00:00 (12:34:56)

Dial History2
 555-555-555 2008/05/26 00:00 (03:25:45)

Dial History3
 17.17.17.17 2008/05/26 00:00 (01:00:17)

Dial History4
 18.18.18.18 2008/05/26 00:00 (01:00:18)

Dial History5
 19.19.19.19 2008/05/26 00:00 (01:00:19)

Dial History6
 20.20.20.20 2008/05/26 00:00 (01:00:20)

Dial History7
 66.66.66.66 2008/05/26 00:08 (00:00:00)

Dial History8
 88.88.88.88 2008/05/26 00:08 (01:00:06)

Office ARoom 102Room 101

Office ERoom 202Room 201

ISDN 98-7654-3210IP 255.255.255.255ISDN 01-2345-6789

ISDN 01-2345-6789IP 123.456.789.012IP 0.0.0.0

Detailed Dial

History

New Entry

Group Edit

Phone Book

Home

Group1

Default Group

Group2

Group3

Group4

Group5

Group6

Group7

Group8

Group9
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Connect menu

For details, see “Calling a Remote Party by Using the Connect Menu” on 
page 108.

M Detailed Dial button
The Detailed Dial menu opens when you select the Detailed Dial button 
and press the ENTER button on the Remote Commander.
The menu is used to call a remote party by setting the details of the dial 
setup options.

Detailed Dial menu

For details on the Detailed Dial menu, see page 115. 

N Instruction display
The instructions for the operation in the Home menu are displayed.

O Line interface select button
Selecting the button opens the drop-down list of the line interface. Select 
the interface to be used, then press the ENTER button.

P Number input box
To call a remote party not registered in the Phone Book, select the box and 
enter the party’s IP address, Domain name, ISDN line number, etc.

Select from History

Previous

Enter Number/Address

Select from Phone Book

Connect

IP:192.168.0.11 5/11/2008 13:00

1Number of Connected Sites

History

Detailed Dial

1Mbps

1B (64K)

IP

Phone Book

Dial to:

Line I/F

Communication 
Bit Rate

Number of Lines

Home

CancelSaveConnect
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Q Dial button
To call a remote party whose number or address has been entered in the 
number input box, select this button, then press the ENTER button on the 
Remote Commander.

R One-touch dial buttons
The submenu is displayed when you select a thumbnail for a remote party 
you want to call and press the ENTER button on the Remote Commander. 
Using the submenu you can call the remote party.
You can also call the remote parties assigned to the one-touch buttons by 
pressing the F1 to F4 buttons on the Remote Commander.

S Display

1 Video input 
The selected video input on the local system is displayed.
The displayed video input is shown as the label set in “Custom Input 
Label” in the Video setup menu.

2 Audio input
The selected audio input on the local system is displayed.

3 LAN status
The current status of LAN connection is shown. The LAN indicator is 
shown in white when LAN is enabled for use and in gray when it is 
disabled.

4 ISDN status
The current status of the ISDN unit ports is shown. The port indicator is 
shown in white when it is enabled for use and in gray when it is disabled.

5 Indicators
The status indicators for when the microphone is off, a USB storage device 
is inserted, a pen tablet is connected, streaming broadcast is being 
executed, recording is being executed, etc. are displayed.

6 Audio level meter
The current audio input level is displayed.

Home
NEAR

321 4 5 6

87
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7 Volume 

The volume-level bar is temporarily shown when you adjust the volume of 
the Communication System.

8 Warning messages
If system malfunction occurs, a warning, instruction, etc. are displayed.
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The basic operation through the menu is explained taking manual brightness 
adjustment in the Camera menu as an example.

Buttons used for menu operations

1 Display the Home menu.

Operation Using the Menu

F1 F2 F3 F4

T

W

1 2 3

4 5 6

7 8 9

0

/

RFZ

GHI JKL MNO

PQRS TUV WXYZ

ABC DEF

PRESENTATION

LAYOUT

RETURN

CONNECT

ON/OFF

MIC

BACK
SPACE DISCONNECT

TONE DOT

TOOLS

VOLUME ZOOM

ENTER

VIDEO INPUT CAMERA

PCS-RFZ1

DOT button

Number buttons

ENTER button

V/v/B/b buttons

RETURN button

Connect

Camera

5/11/2008 13:00IP:XXX.XXX.XXX.XXX

Home

AAA Ready
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2 Use the V, v, B or b button on the Remote Commander to select “Camera”, 

then press the ENTER button.

The Camera menu appears.

3 Use the V, v, B or b button on the Remote Commander to select 
“Brightness”, then press the ENTER button.

The Brightness menu appears.

4 Press the ENTER button on the Remote Commander.
Now you can select the adjustment mode.

5 Use the V, v, B or b button to select the desired item from the drop-down 
list, then press the ENTER button.

The menu goes to Manual Adjustment mode.

Details

Previous

Adjustments

Brightness

PresetCamera

5/11/2008 13:00

Adjustments > Brightness

Auto Adjustment

Previous

5/11/2008 13:00

Adjustments > Brightness

Manual Adjustment

Previous

5/11/2008 13:00
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6 Use the V, v, B or b button on the Remote Commander to select the 
brightness adjustment bar, then press the ENTER button.

7 Use the V, v, B or b button to adjust the brightness of the image, then press 
the ENTER button.

8 Use the V, v, B or b button on the Remote Commander to select 
“Previous”, then press the ENTER button after the adjustment is finished.
You can also use the RETURN button on the Remote Commander.

The Brightness menu is restored.

9 Use the V, v, B or b button on the Remote Commander to select 
“Previous”, then press the ENTER button. You can also use the RETURN 
button on the Remote Commander.

The Camera menu is restored.

When the “Save” button is displayed in the menu
When the setting or adjustment is finished, press the V, v, B or b button on the 
Remote Commander to select “Save” and press the ENTER button. The setting 
or adjusted value becomes effective.

When the “Cancel” button is displayed in the menu
If you press the V, v, B or b button on the Remote Commander to select 
“Cancel” and press the ENTER button, the setting or adjustment is canceled 
and the previous one is restored.

Adjustments > Brightness

Manual Adjustment

Previous

5/11/2008 13:00
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This section explains how to enter the letters, numbers or symbols in the text 
box in the menu using the Remote Commander.

To enter letters or numbers

1 Press the F1 button repeatedly to enable the letters or numbers to be input.

2 Press the number buttons to enter a letter or number you want.

You can enter the letter shown on each button by pressing it repeatedly.

You can enter the number shown on each button by pressing it once.

To enter a symbol
Press the F2 button repeatedly to select the desired symbol. Pressing the 0 
button repeatedly also enables you to enter a symbol.

To enter a dot (.) for an IP address
Press the b button or DOT button.

Entering Characters Using the Remote Commander

F1 F2 F3 F4

T

W

1 2 3

4 5 6

7 8 9

0

/

RFZ

GHI JKL MNO

PQRS TUV WXYZ

ABC DEF

PRESENTATION

LAYOUT

RETURN

CONNECT

ON/OFF

MIC

BACK
SPACE DISCONNECT

TONE DOT

TOOLS

VOLUME ZOOM

ENTER

VIDEO INPUT CAMERA

PCS-RFZ1

Number buttons

BACK SPACE button

b button

F1 button

DOT button

F3 button

F2 button
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• When “Internet Protocol” is set to “IPv6” or “IPv4/IPv6” in the Administrator setup 
menu, you can enter colons (:).
When “IPv4/IPv6” is specified, only colons can be entered with the b button. When 
“IPv4/IPv6” is specified and you are calling using IPv4, press the DOT button twice 
to enter a dot.

• “IPv4/IPv6” for “Internet Protocol” will be supported in version 2.0.

To delete a character
Press the BACK SPACE button. The last entered character is deleted.

To delete all the characters entered
Press the F3 button.

This section explains how to enter the letters or numbers in the text box in the 
menu using the on-screen keyboard displayed on the monitor screen.

When “Display On-Screen Keyboard” is set to “On” in the Menu Screens page 
of the General setup menu (page 82), the on-screen keyboard automatically 
appears on the screen if character input is required in the menu.

You can also use the buttons on the Remote Commander even when the on-screen 
keyboard is displayed on the screen.

To enter letters or numbers

1 Use the V, v, B or b button on the Remote Commander to select “Num” 
or “Alpha” on the on-screen keyboard, then press the ENTER button.

Select “Num” to enter numbers, and “Alpha” to enter alphabetic letters.

2 Use the V, v, B or b button on the Remote Commander to select the button 
on the on-screen keyboard on which the desired character is indicated, then 
press the ENTER button.

When you select a number, the selected number is entered.

Notes

Entering Characters Using the On-Screen Keyboard

Note

Num ABC DEF

MNO

1

GHI JKL

PQRS TUV WXYZ Symbol

0 Dot

Space

End Cancel

Alpha

Back
Space
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When you select an alphabetic letter, a submenu with available letters 
appears on the on-screen keyboard. Select the desired letter and press the 
ENTER button on the Remote Commander. The selected letter is entered.

3 Repeat step 2 to enter all the letters or numbers.

4 After the input is complete, select “End”, then press the ENTER button on 
the Remote Commander.

To enter a symbol

1 Select “Symbol” on the on-screen keyboard, then press the ENTER button 
on the Remote Commander.

The submenu with available symbols are displayed.

2 Use the V, v, B or b button on the Remote Commander to select the 
desired symbol, then press the ENTER button.

The selected symbol is entered.

3 Repeat steps 1 and 2 to enter all the symbols.

4 After the input is complete, select “End”, then press the ENTER button on 
the Remote Commander.

To enter a dot (.) for an IP address
Select “b” or “Dot” on the on-screen keyboard, then press the ENTER button 
on the Remote Commander.

To enter a space
Select “Space”, then press the ENTER button on the Remote Commander.

To delete a character
To erase the last entered character, select “Back Space”, then press the ENTER 
button on the Remote Commander.

To delete all the characters entered
Select “Cancel”, then press the ENTER button on the Remote Commander.
Pressing the F3 button on the Remote Commander also deletes all the 
characters entered.

ABC

Alpha

DEF

MNO

1

GHI JKL

PQRS TUV WXYZ Symbol

0 Dot

Space

End Cancel

Back
SpacePrevious

A B C

a b c
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This chapter describes the registration and settings to be carried out by the 
system administrator. The chapter is intended to be read by the system 
administrator.

Registering Local Information
Before connecting, set up the local system using the Setup menus. This section 
describes how to display the Setup menus and gives a introduction to the 
menus.

1 Press the Tools button on the Remote Commander, or use the V, v, B or b 
button to select “Tools” in the Home menu, then press the ENTER button.
The Tools menu appears on the monitor screen.

Chapter 2: 
Registration and 
Setup for System 
Administrators

Opening the Setup Menu

Machine Status

Setup

Home Presentation

Streaming

Recording

Annotation

[Suspended]

[Suspended]

[Suspended]

[Suspended]

Icon display

Reject Answer

Screen Capture

Tools

On

Off

Execute

Execute

Execute

Execute

Execute
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2 Use the V, v, B or b button to select “Setup”, then press the ENTER button 
on the Remote Commander.
The Setup menu appears on the monitor screen.

Menus available from a setup menu
The Setup menus are grouped into the following depending on the setting 
items. The setup menus that include many setting items are divided into 
multiple pages. Select an appropriate menu button to set the respective 
item.
The commonly-used menu buttons are displayed on the screen at the 
factory. Pressing the F4 button on the Remote Commander allows you to 
display the maximum number of setup menu buttons. To restore the 
commonly-used setup display, press the F4 button again.

For a description of each setup menu, see the page for that menu indicated 
below.
Line Interface setup menu (see page 62)
Dial setup menu (see page 62)
Answer setup menu (see page 63)
Multipoint setup menu (see page 63)
Communication setup menu (see page 64)
Audio setup menu (see page 68)
Video setup menu (see page 71) 
LAN setup menu (see page 73)
QoS setup menu (see page 76)
TOS setup menu (see page 78)
SIP setup menu (see page 78) 
ISDN setup menu (see page 79)
Annotation setup menu (see page 81)
Camera setup menu (see page 81)
General setup menu (see page 81)
Home Menu setup menu (see page 83)
Administrator setup menu (see page 85)
Encryption setup menu (see page 90)
Shared Phone Book setup menu (see page 90)

Setup Line I/F

Back to Tools

Home Line Interface

IP

Primary Line Interface

Use LAN2 Off

ISDN SIP

IP ISDN SIP

Dial

Line I/F

Answer

Multipoint

Audio1

Video2

LAN

LAN

LAN

SIP

Menu buttons
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The Multipoint setup menu is displayed only when the PCSA-MCG106/MCG109 
HD MCU software is installed in the Communication System.

3 Use the V, v, B or b button on the Remote Commander to select the menu 
button you want to set, then press the ENTER or b button.
The selected setup menu appears.

4 Use the V, v, B or b button on the Remote Commander to select the setting 
item, then press the ENTER button.

5 Select the desired item from the drop-down list, or enter the characters in 
the text box.

For individual items, see pages 62 to 90.

6 After the selection or character input is completed, use the V, v, B or b 
button to select “Save”, then press the ENTER button.
The setting is saved, and the Setup menu is restored.

Note

Setup Dial

Telephone Mode

More Options Enable

User Name Input

Prefix

Prefix-A

Prefix-B

Prefix-C

LAN Prefix

LAN Prefix

Dial

Auto

On

On

Prefix-None

Disable

CancelSave

Menu button

Setting items

Setup Dial

Telephone Mode AutoDial

CancelSave

Auto
G.711 µ-law
G.711 A-law
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To cancel the setup
Use the V, v, B or b button on the Remote Commander to select “Cancel”, 
then press the ENTER button. Or press the RETURN button on the Remote 
Commander.

To return to the left column
Press the B button or RETURN button on the Remote Commander.
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The Line Interface setup menu is used to 
select the line interface you use for 
connection with a remote party.

 Line I/F

Line Interface
Allows you to select the line interface from 
among “IP”, “ISDN” and “SIP”. You can 
select multiple interfaces. 

ISDN will be supported in version 2.0.

Primary Line Interface
Allows you to select the line interface you 
use most from among IP, SIP and ISDN.

ISDN will be supported in version 2.0.

Use LAN2 (PCS-XG100S only)
Allows you to select whether to use the 2 
(LAN2) connector on the rear of the 
Communication System.
Off: Select when you do not use the 2 

(LAN2) connector.
On: Select when you use the 2 (LAN2) 

connector.

When “Use LAN2” is set to “On”, some of the 
functions using the 2 connector are 
restricted.

For details, see “Restrictions on the Use of 
LAN2 (PCS-XG100S only)” on page 96.

The Dial setup menu is used to set the 
attributes for dialing.

 Dial

Telephone Mode
Allows you to select the audio compression 
format when conducting a voice meeting.
Auto: Selects an appropriate format 

automatically.
G.711µ-law: Selects the format based on the 

G.711µ-law standard.
G.711A-law: Selects the format based on 

the G.711A-law standard.

More Options Enable
Allows you to select whether to display the 
More Options button in the List Edit menu 
of the Phone Book. You can set the detailed 
items for dialing in the List Edit menu by 
selecting the More Options button.
On: Displays the More Options button.
Off: Does not display the More Options 

button.

User Name Input
Allows you to select whether to register user 
names in the communications log when 
connection is made.
Off: Disables the recording of the user 

names.
On: Select when you want to record user 

names. Each time dialing takes place, 
the user name input menu appears.

Prefix
Select the prefix number (call number 
prefixed to a line number).
Prefix-None: Select when you are not using 

a prefix number.
Prefix-A: Select when you use the prefix set 

in “Prefix-A”.
Prefix-B: Select when you use the prefix set 

in “Prefix-B”.
Prefix-C: Select when you use the prefix set 

in “Prefix-C”.

Prefix-A
When “Prefix” is set to “Prefix-A”, the line 
number prefixed by the prefix (dial number) 
registered in this box is dialed.

Line Interface Setup Menu

Note

Note

Note

Dial Setup Menu

Line I/F

Dial
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Prefix-B
When “Prefix” is set to “Prefix-B”, the line 
number prefixed by the prefix (dial number) 
registered in this box is dialed.

Prefix-C
When “Prefix” is set to “Prefix-C”, the line 
number prefixed by the prefix (dial number) 
registered in this box is dialed.

Enter “9” when this is required to make an 
outgoing call.

Select LAN Prefix
Allows you to select whether to use the LAN 
prefix when dialing via a LAN.
Disable: Disables the LAN prefix.
Enable: Enables the LAN prefix.

LAN Prefix
When dialing using the IP connection, the 
information entered into this box is added to 
the beginning of the IP address. Select 
whether to use the LAN prefix in “Select 
LAN Prefix”. 

The Answer setup menu is used to set up call 
reception.

 Answer

Auto Answer
Allows you to select whether the system 
answers calls automatically.
On: Answers calls automatically. When a 

call comes in, the line is automatically 
connected.

Off: Allows you to answer calls manually. 
When a call comes in, the phone rings. If 
you select “OK” in the “Answer?” 
message, the line is connected.

ISDN MSN
Allows you to select whether you are using 
the Multiple Subscriber Number.
Off: Select when you do not use the 

Multiple Subscriber Number.
On: Select when you use the Multiple 

Subscriber Number.

“ISDN MSN” will be supported in version 2.0.

Mic on Answer
Allows you to select whether to transmit 
audio from your site when you receive a call 
and connect it.
On: Enables transmission of audio when 

answering a call.
Off: Disables transmission of audio when 

answering a call.

Reject Answer (PCS-XG100S only)
Allows you to select whether to connect a 
remote party’s calling during 
communication.
On: Disables the connection of a remote 

party.
Off: Enables the connection of a remote 

party.

For details, see “Turning Off the Sound 
Momentarily – Muting Function” on page 
132.

The Multipoint setup menu is used to set up 
multipoint connection when the local 
system is used as the main terminal.
The menu is displayed only when the 
PCSA-MCG106/MCG109 HD MCU 
software is installed in the Communication 
System.

For the procedure how to install the 
PCSA-MCG106/MCG109 software, see 
page 187.

When the local system is used as the main 
terminal and connected with remote terminals 
other than the PCS-XG80/XG80S/XA80/
XG100S, the maximum bandwidth to be used 
is restricted to 4 Mbps.

Note

Answer Setup Menu

Answer

Note

Multipoint Setup Menu 
(PCS-XG100S only)

Note
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 Multipoint

Multipoint Mode
AUTO: Switches from point-to-point 

connection to multipoint connection 
automatically.

On: Enables you to make a multipoint 
connection at any time.

Broadcast Mode
Allows you to select the broadcast mode.
Split: Displays the picture from the 

connected terminals in split windows.
Voice Activate: Detects the terminal where 

a speaker has the loudest voice, and 
automatically transmits the picture of 
this terminal to all other terminals.

Voice Activate (1080P): Enables 
transmission of pictures with resolution 
of 1080 (1920 × 1080 pixels) in H.264 
Video Mode when “Voice Activate” 
mode is activated.

• The “Voice Activate (1080P)” mode cannot 
be selected when the communication is made 
via an ISDN or SIP connection. Even for an 
IP connection, this mode is not available if 
the remote party does not support H.264 
Video Mode.

• When “Broadcast Mode” is set to “Voice 
Activate (1080P)”, you cannot change 
“Broadcast Mode” during communication. 
Select the Broadcast Mode before starting 
communication.

Split
Allows you to select the type of split display 
used to display local and remote pictures on 
a single monitor during a multipoint 
connection. 
Automatic: The display automatically splits 

into three parts when there are two 
terminals connected, four parts when 
there are three, six parts when there are 
four or five, and nine parts when there 
are six to eight terminals connected.

Six-screen Mosaic: The display is split into 
six parts regardless of the number of 
terminals connected.

Nine-screen Mosaic: The display is split 
into nine parts regardless of the number 
of terminals connected.

When there is only one terminal connected, the 
display switches to full screen regardless of the 
selection of the setting.

The Communication setup menu is used to 
set up communications.

The contents of the Communication menu vary 
with “Line Interface” setting in the Line I/F 
setup menu, or “Individual Settings for 
Transmission/Reception” or “Individual 
Settings for Point-to-Point/Multipoint” setting 
in the Communication setup menu.
The Communication page number after the 
Communication2 page also varies according to 
the number of setting items.

 IP
The menu is used to set up the 
communication mode for the IP connection.

Individual Settings for Transmission/
Reception
Allows you to select whether to configure 
the IP settings for transmission and 
reception individually.
Off: Select to configure the IP settings for 

transmission and reception commonly.
On: Select to configure the IP settings for 

transmission and reception individually.

Individual Settings for Point-to-Point/
Multipoint (PCS-XG100S only)
Allows you to select whether to configure 
the IP settings for a point-to-point 
connection and multipoint connection 
individually.
Off: Select to configure the IP settings for 

both connections commonly.
On: Select to configure the IP settings for a 

point-to-point connection and 
multipoint connection individually.

Notes

Multipoint

Note

Communication Setup Menu

Note

Communication
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The setting items and page numbers in the IP: 
Mode page vary according to the setting of 
“Individual Settings”.

 IP: Mode

Total Bandwidth (PCS-XG100S only)
Allows you to select the total bandwidth to 
be used with this system.
In multipoint connection, the total 
bandwidth of all points is displayed.
You can select from among 128Kbps, 
384Kbps, 512Kbps, 768Kbps, 1Mbps, 
2Mbps, 3Mbps, 4Mbps, 5Mbps, 6Mbps, 
7Mbps, 8Mbps, 9Mbps, 10Mbps, 11Mbps, 
12Mbps, 13Mbps, 14Mbps, 15Mbps, 
16Mbps, and Other.

In multipoint connection, the actual 
Communication Bit Rate for each point is 
automatically adjusted so as not to exceed 
“Total Bandwidth”.

Communication Bit Rate
Allows you to select the communication bit 
rate per point.
When “Individual Settings for 
Transmission/Reception” or “Individual 
Settings for Point-to-Point/Multipoint” on 
the IP page is set to “On”, you can set this 
item for transmission and reception, and 
point-to-point and multipoint connections 
individually.
You can select from among 128Kbps, 
384Kbps, 512Kbps, 768Kbps, 1Mbps, 
2Mbps, 3Mbps, 4Mbps, 5Mbps, 6Mbps, 
7Mbps, 8Mbps, 9Mbps, 10Mbps, 11Mbps, 
12Mbps, 13Mbps, 14Mbps, 15Mbps, 
16Mbps, and Other.

The 5Mbps, 6Mbps, 7Mbps, 8Mbps, 9Mbps, 
10Mbps, 11Mbps, 12Mbps, 13Mbps, 14Mbps, 
15Mbps, and 16Mbps settings are not available 
on the PCS-XG77S.

Audio Mode
Allows you to select the compression format 
of audio to be sent to a remote party. When 

“Individual Settings for Transmission/
Reception” or “Individual Settings for Point-
to-Point/Multipoint” on the IP page is set to 
“On”, you can set this item for transmission 
and reception, and point-to-point and 
multipoint connections individually.
You can select multiple formats from among 
G.711, G.722, G.728 and MPEG4 (MPEG4 
AAC).

When the remote system does not support the 
audio mode selected by the local site, the mode 
automatically becomes “G.711”.

Far End Camera Control
Allows you to select whether to enable the 
control of each other’s cameras from each 
other’s site.
When “Individual Settings for Point-to-
Point/Multipoint” for IP is set to “On”, you 
can set this item individually for point-to-
point and multipoint connections.
On: Enables the control of each other’s 

cameras. Normally, set to “On”.
Off: Disables the control of each other’s 

cameras.

H.239
Use of the presentation mode complying 
with H.239 allows you to transmit the 
presentation data and picture from the 
camera simultaneously.
This item allows you to select whether to use 
the presentation mode based on the H.239 
presentation standard.
On: Enables the presentation mode based on 

the H.239 presentation standard.
Off: Disables the presentation mode based 

on the H.239 presentation standard.

H.239 Ratio
When H.239 presentation transmissions are 
made with the system, the H.239 
presentation data shares bandwidth with 
camera images that are also being sent. This 
setting allows you to select how much of the 
total bandwidth to use for H.239 
presentation data transmissions.
2/3: Use 2/3 of the total bandwidth for H.239 

presentation data transmissions.
1/2: Use 1/2 of the total bandwidth for H.239 

presentation data transmissions.

Note

Note

Note

Communication

Note
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1/3: Use 1/3 of the total bandwidth for H.239 
presentation data transmissions.

Screen Size
Allows you to select the screen size of the 
picture to be transmitted or received.
When “Individual Settings for Transmission/
Reception” or “Individual Settings for Point-
to-Point/Multipoint” on the IP page is set to 
“On”, you can set this item for transmission 
and reception, and point-to-point and 
multipoint connections individually.
You can select from among 1080, 720, 
W4CIF, W432P, WCIF, 4CIF, CIF, QCIF 
and AUTO.

The “1080” setting can only be selected on the 
PCS-XG77S when the PCSA-RXG77 HD 
Upgrade Software is installed. Progressive 
video signals with a resolution of 1920 × 1080 
can only be transmitted and received at a 
maximum of 60 frames per second when 
“Screen Size” is set to “1080”.

Video Mode
Allows you to select the compression format 
of pictures to be transmitted or received. 
When “Individual Settings for Transmission/
Reception” or “Individual Settings for Point-
to-Point/Multipoint” on the IP page is set to 
“On”, you can set this item for transmission 
and reception, and point-to-point and 
multipoint connections individually.
You can select from among H.261, H.263+, 
and H.264.

“H.261” will be supported in version 2.0.

Video Frame
Allows you to select the number of video 
frames during transmission or reception. When 
“Individual Settings for Transmission/
Reception” or “Individual Settings for Point-
to-Point/Multipoint” on the IP page is set to 
“On”, you can set this item for transmission 
and reception, and point-to-point and 
multipoint connections individually.
15fps: Send pictures at a maximum rate of 

15 frames per second.

30fps: Send pictures at a maximum rate of 
30 frames per second.

60fps: Send pictures at a maximum rate of 
60 frames per second.

AUTO: Switch the number of frames 
automatically.

When the PCSA-RXG77 HD Upgrade 
Software is installed on the PCS-XG77S and 
progressive video signals with a resolution of 
1920 × 1080 are being transmitted and 
received, transmission and reception will be at 
a maximum of 60 frames per second.

 ISDN
The menu is used to set up the 
communication mode for an ISDN 
connection. 

ISDN will be supported in version 2.0.

Individual Settings for Point-to-Point/
Multipoint (PCS-XG100S only)
Allows you to select whether to configure 
the ISDN settings for point-to-point and 
multipoint connections individually.
Off: Select to configure the ISDN settings 

for both connections commonly.
On: Select to configure the ISDN settings 

for point-to-point and multipoint 
connections individually.

The setting items and page numbers for 
“ISDN: Mode” varies according to the setting 
of “Individual Settings”.

 ISDN: Mode

ISDN will be supported in version 2.0.

ISDN Bandwidth (Dial)
Allows you to select the number of ISDN 
lines used for dialing.
When “Individual Settings for Point-to-
Point/Multipoint” on the ISDN page is set to 

Note

Note

Note

Note

Note

Note

Communication

Communication
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“On”, you can set this item for point-to-point 
and multipoint connections individually.
You can select from among 1B (64K), 2B 
(128K), 3B (192K), 4B (256K), 5B (320K), 
6B (384K), 8B (512K) and 12B (768K).

ISDN Bandwidth (Answer)
Allows you to select the number of ISDN 
lines used for answering.
You can select from among 1B (64K), 2B 
(128K), 3B (192K), 4B (256K), 5B (320K), 
6B (384K), 8B (512K) and 12B (768K).

Audio Mode
Allows you to select the compression format 
of audio to be sent to a remote party. 
You can select from among G.711, G.722, 
G.728 and MPEG4 (MPEG4 AAC).

When the remote system does not support the 
audio mode selected by the local site, the mode 
automatically becomes “G.711”.

Far End Camera Control
Allows you to select whether to enable the 
control of each other’s cameras from each 
other’s site.
On: Enables the control of each other’s 

cameras. Normally, set to “On”.
Off: Disables the control of each other’s 

cameras.

H.239
Allows you to select whether to use the 
presentation mode based on the H.239 
presentation standard.
On: Enables the presentation mode based on 

the H.239 presentation standard.
Off: Disables the presentation mode based 

on the H.239 presentation standard.

H.239 Ratio
When H.239 presentation transmissions are 
made with the system, the H.239 presentation 
data shares bandwidth with camera images that 
are also being sent. This setting allows you to 
select how much of the total bandwidth to use 
for H.239 presentation data transmissions.
2/3: Use 2/3 of the total bandwidth for H.239 

presentation data transmissions.
1/2: Use 1/2 of the total bandwidth for H.239 

presentation data transmissions.

1/3: Use 1/3 of the total bandwidth for H.239 
presentation data transmissions.

Restrict
Allows you to select the ISDN transmission 
rate.
Auto: Select when connecting a remote 

party via a normal ISDN line.
56K: Select when connecting a remote party 

located in a region or country where the 
ISDN transmission rate is 56 Kbps.

The system is set to connect an ISDN line at the 
transmission rate of 64 Kbps by default. 
However, some countries, such as the USA, 
and some regions may use the ISDN 
transmission rate of 64 Kbps and 56 Kbps. You 
may not communicate with such countries or 
regions at 64 Kbps, so you must therefore set 
“Restrict” to “56K” before dialing.

Screen Size
Allows you to select the screen size of the 
picture to be transmitted or received.
You can select from among 720, W4CIF, 
W432P, WCIF, 4CIF, CIF and AUTO.

Video Mode
Allows you to select the compression format 
of pictures to be transmitted or received.
You can select from among H.261, H.263+, 
and H.264.

“H.261” will be supported in version 2.0.

Video Frame
Allows you to select the number of video 
frames during transmission or reception.
15fps: Send pictures at a maximum rate of 

15 frames per second.
30fps: Send pictures at a maximum rate of 

30 frames per second.
AUTO: Switch the number of frames 

automatically.

 SIP: Mode

Communication Bit Rate
Allows you to select the communication bit 
rate per point

Note

Note

Note

Communication
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You can select from among 128Kbps, 
384Kbps, 512Kbps, 768Kbps, 1Mbps, 
2Mbps, 3Mbps, 4Mbps and Other.

Audio Mode
Allows you to select the compression format 
of audio to be sent to a remote party. 
You can select from among G.728, G.722 
and G.711.

When the remote system does not support the 
audio mode selected by the local site, the mode 
automatically becomes “G.711”.

Far End Camera Control
Allows you to select whether to enable the 
control of each other’s cameras from each 
other’s site.
On: Enables the control of each other’s 

cameras. Normally, set to “On”.
Off: Disables the control of each other’s 

cameras.

Screen Size
Allows you to select the screen size of the 
picture to be transmitted or received.
You can select from among 720, W4CIF, 
W432P, WCIF, 4CIF, CIF, QCIF and 
AUTO.

Video Mode
Allows you to select the compression format 
of pictures to be transmitted or received.
You can select from among H.261, H.263+, 
H.264 and MPEG4.

“H.261” will be supported in version 2.0.

Video Frame
Allows you to select the number of video 
frames during transmission or reception.
MIC (A1)15fps: Send pictures at a 

maximum rate of 15 frames per second.
30fps: Send pictures at a maximum rate of 

30 frames per second.
60fps: Send pictures at a maximum rate of 

60 frames per second.
AUTO: Switch the number of frames 

automatically.

The Audio setup menu is used to set various 
audio items.

 Basic Setup1

Audio Input
Allows you to select the audio input.
MIC: Inputs audio from the microphone.
AUX: Inputs audio from auxiliary external 

equipment.
MIC+AUX: Inputs audio from the 

microphone and auxiliary external 
equipment.

When “Link to Audio Input” is set to “On” in 
the Video setup menu, “Audio Input”, “Input 
Select (MIC)” and “Input Select (AUX)” 
cannot be selected.

Input Select (MIC)/
Input Select (AUX)
Allows you to select the microphone and/or 
external equipment from which an audio 
signal is input.

For the PCS-XG100S
The options that can be selected vary with 
the Audio Input setting.
When you select “MIC” from “Audio 
Input”, you can select one of the following 
three options. When you select “AUX”, you 
can select “AUDIO 1”, or “AUDIO 2”.
When you select “MIC+AUX”, you can 
select two options: one microphone input 
from “MIC (A1)”, “AUDIO 1”, or “AUDIO 
2”, and one auxiliary external input from 
“AUDIO 1”, or “AUDIO 2”.

When “Video Input” is set to “HDMI” in the 
Video setup menu, AUX audio will 
automatically be set to the inputs from the 
HDMI IN connector.
MIC (A1): Select use of the PCS-A1 

microphone (supplied) connected to the 
MIC (A1) jacks on the Communication 
System.

Note

Note

Audio Setup Menu

Note

Note
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AUDIO 1: Select to input the audio of the 
external equipment connected to the 
AUDIO 1 IN jack on the 
Communication System.

AUDIO 2: Select to input the audio of the 
external equipment connected to the 
AUDIO 2 IN jack on the 
Communication System.

For the PCS-XG77S
The options that can be selected vary with 
the Audio Input setting.
When you select “MIC” from “Audio 
Input”, you can select one of the following 
three options. When you select “AUX”, you 
can select “AUDIO 1” or “AUDIO 2”. 
When you select “MIC+AUX”, you can 
select two options: one microphone input 
from “MIC (A1)”, “AUDIO 1” or “AUDIO 
2”, and one auxiliary external input from 
“AUDIO 1” or “AUDIO 2”.
MIC (A1): Select use of the PCS-A1 

microphone (supplied) connected to the 
MIC (A1) jacks on the Communication 
System.

AUDIO 1: Select to input the audio of 
external equipment connected to the 
AUDIO 1 IN jacks on the 
Communication System.

AUDIO 2: Select to input the audio of 
external equipment connected to the 
AUDIO 2 IN jacks on the 
Communication System.

Echo Canceller
Allows you to select whether to use the 
internal echo canceller.
On: Enables the internal echo canceller.
Off: Disables the internal echo canceller.

When “Audio Input” is set to “AUX”, the echo 
canceller will not function.

Audio Output
Allows you to specify the audio output 
destination.
HDMI: Outputs audio from the HDMI-1 

OUT connector.
AUDIO: Outputs audio from the AUDIO 

OUT connector.

If the “Audio Output” setting is configured 
incorrectly, the echo canceller may not 
function properly.

Lip Sync
Allows you to select whether to use the Lip 
Sync function.
Auto: Enables the Lip Sync function.
Off: Disables the Lip Sync function.

• When “Adaptive Rate Control (ARC)”, 
“Packet Resend Request (ARQ)” or 
“Forward Error Correction (FEC)” is set to 
“On” in the QoS setup menu, you cannot set 
“Lip Sync” to “Off”.

• When “Lip Sync” is set to “Off”, you cannot 
change the setting for “Adaptive Rate 
Control (ARC)”, “Packet Resend Request 
(ARQ)” or “Forward Error Correction 
(FEC)” in the QoS setup menu.

Recording Mute
When you connect an audio recording 
device to the AUDIO 1 IN or AUDIO 2 IN 
and REC OUT jacks to record audio, this 
function reduces oscillations in sound that 
occur due to loop-back within audio 
recording device.
Off: Disables the recording mute function.
On: Enables the recording mute function.

• When “Recording Mute” is set to “On”, only 
signals from external equipment are affected. 
Signals from the microphones or remote sites 
are not affected. Therefore, the Recording 
Mute functions only when “Audio Input” is 
set to “AUX” or “MIC+AUX.”

• When connecting an audio recording device 
to the AUDIO 1 IN or AUDIO 2 IN and REC 
OUT jacks, set “Recording Mute” to “On” 
and record the sound only from the audio 
recording device. If you want to record the 
sound on your site as well, also use the 
microphone input.

Input Mode
Allows you to select the input audio mode.
Stereo: Inputs audio to the R/L jacks of the 

audio input as stereo left and right sounds.

Note

Note

Notes
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Monaural: Inputs audio to the R/L jacks of 
the audio input as monaural sound.

Output Mode
Allows you to select the output audio mode.
Stereo: Outputs audio from the AUDIO 

OUT R/L or HDMI OUT jacks as stereo 
left and right sounds.

Monaural: Outputs audio from the AUDIO 
OUT R/L or HDMI OUT jacks as 
monaural sound.

 Basic Setup2

AUX Local Monitor Out
Allows you to select whether the audio input 
from the AUDIO 1 IN or AUDIO 2 IN jacks 
outputs to the audio output jacks on the 
Communication System.
On: Enables output from the audio output.
Off: Disables output from the audio output.

Reversed MIC Inputs
Allows you to select whether to transmit the 
audio input from the microphone with right 
and left reversed. If you select “On”, you can 
match the right and left of the camera image 
and audio.
Off: Transmits the audio with right and left 

not reversed.
On: Transmits the audio with right and left 

reversed.

Audio Input Delay Setting
Allows you to set Audio Input Delay to 
synchronize the audio with the video input.
Default –100ms: Selects the default delay 

minus 100ms.
Default –50ms: Selects the default delay 

minus 50ms.
Default: Selects the default delay.
Default + 50ms: Selects the default delay 

plus 50ms.
Default + 100ms: Selects the default delay 

plus 100ms.
Custom: Uses the Audio Input Delay you 

set.

Audio Input Delay
When you set “Audio Input Delay Setting” 
to “Custom”, you can set the delay time of 

the input audio to match the image and 
audio.

Audio Output Delay Setting
Allows you to set Audio Output Delay to 
synchronize the audio with the video output.
Default –100ms: Selects the default delay 

minus 100ms.
Default –50ms: Selects the default delay 

minus 50ms.
Default: Selects the default delay.
Default + 50ms: Selects the default delay 

plus 50ms.
Default + 100ms: Selects the default delay 

plus 100ms.
Custom: Uses the Audio Output Delay you 

set.

Audio Output Delay
When you set “Audio Output Delay Setting” 
to “Custom”, you can set the delay time of 
the output audio to match the image and 
audio.

REC OUT Mode
Stereo: The mixed sounds of the remote and 

local sites are output from the REC OUT 
R and L jacks in stereo.

Monaural 2ch: The sounds of the remote 
and local sites are output from the REC 
OUT R and L jacks separately.

 Sound Effect

Beep Sound
Allows you to select the volume of the beep 
that sounds each time you press a button on 
the Remote Commander from among 
“Loud”, “Medium” and “Quiet”. You can 
also select “Off” for the beep not to sound.

Sound Effect
Allows you to select the volume of output 
sound when the system starts, or when 
connection starts or is disconnected from 
among “Loud”, “Medium” and “Quiet”. 
You can also select “Off” for the sound not 
to be output.

Dial Tone
Allows you to select the volume of a ring-
back and busy tones when you are dialing 

Audio2

Audio3
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from among “Loud”, “Medium” and 
“Quiet”. You can also select “Off” for the 
ring-back and busy tones not to be output.

Ringer Tone
Allows you to select the volume of a ring 
tone when you receive a call from among 
“Loud”, “Medium” and “Quiet”. You can 
also select “Off” for the ring tone not to be 
output.

The Video setup menu is used to set up video 
input/output.

 Basic Setup

Video Input
Allows you to select the video input.
Camera: Selects the camera picture from 

the camera connected to the CAMERA 
connector.

DVI-I 1: Selects the video signal from the 
external equipment connected to the 
DVI-I 1 IN connector.

DVI-I 2: Selects the video signal from the 
external equipment connected to the 
DVI-I 2 (PC) IN connector.

HDMI: Selects the video signal from the 
external equipment connected to the 
HDMI IN connector.

The “HDMI” setting is not available on the 
PCS-XG77S.

Presentation Screen
Allows you to select the display pattern of 
the presentation screen.
The “Presentation Screen” settings are 
enabled when “H.239” is disabled during the 
communication.
Configure this when conducting 
presentations with terminals that do not 
support H.239.
Full Screen: Sends the computer picture, 

etc. from the external equipment 
connected to the DVI-I 1 IN connector 
in full screen mode.

Monitor Output
Allows you to select the video signal output 
from the Communication System.
HDMI 1: Outputs the video signal to the 

external equipment connected to the 
HDMI-1 OUT connector.

DVI-I OUT: Outputs the video signal to the 
external equipment connected to the 
DVI-I OUT connector.

HDMI 1 + DVI-I OUT: Outputs the video 
signal to the external equipment 
connected to the HDMI-1 OUT and 
DVI-I OUT connectors.

HDMI 1 + HDMI 2: Outputs the video 
signal to the external equipment 
connected to the HDMI-1 OUT and 
HDMI-2 OUT connectors.

Triple monitors: Outputs the video signal 
to the external equipment connected to 
the HDMI-1 OUT and DVI-I OUT 
connectors, and the external equipment 
connected to the HDMI-2 OUT 
connector.

• Connect a monitor that supports the 1080p 
video format to the HDMI-2 OUT connector.

• If “Monitor Output” is set to “HDMI 1 + 
DVI-I OUT”, “HDMI 1 + HDMI 2”, or 
“Triple monitors” when no HDMI monitor is 
connected to the Communication System, 
you cannot view the menus.

• The “HDMI 1 + HDMI 2” and “Triple 
monitors” settings are not available on the 
PCS-XG77S.

• When you change the setting of “Monitor 
Output” to an incorrect setting, no picture is 
displayed on the screen. In this case, select 
the correct setting for “Monitor Output” 
using the 1 (power) switch on the 
Communication System and the buttons on 
the Remote Commander. 
When the 1 (power) switch indicator on the 
Communication System stays lit, perform 
the steps below.
1 Press the 1 (power) switch on the 

Communication System.
2 Within five seconds after you pressed the 

switch, press the buttons on the Remote 
Commander described below depending 
on the desired “Monitor Output”.
HDMI 1: VIDEO INPUT button (once) 
then Number button 3 (three times)

Video Setup Menu

Note

Video1
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DVI-I OUT: VIDEO INPUT button 
(once) then Number button 4 (three 
times)

The setting of “Monitor Output” is changed, 
and the picture will be displayed on the screen.

DVI-I Monitor Output Format
Allows you to select from the XGA, 
WXGA, SXGA, 1080i, and 1080p video 
formats for the DVI-I OUT connector 
output.

When “Monitor Output” is set to “HDMI 1 + 
HDMI 2,” the “DVI-I Monitor Output Format” 
setting determines the video format output for 
the monitor connected to the HDMI-2 OUT 
connector.

Blanking Period
Allows you to select the blackout period that 
occurs temporarily when the input picture is 
switched when the monitor is connected to 
the HDMI OUT connector.
You can select among from Long, Medium 
and Short.

Frequency
Allows you to select the frequency of 50 Hz 
or 60 Hz for video input/output.

• “Frequency” is set to “60 Hz” at the factory. 
Note that video may not be output or the 
menu not displayed on the screen when 
“Frequency” is set to “50 Hz” if the 
connected equipment does not support the 
frequency of 50 Hz.

• You must reboot the system to apply changes 
to the “Frequency” setting. Reboot the system 
manually. If you change it to an incorrect 
setting, no picture is displayed on the screen 
after rebooting. In this case, select the correct 
setting for “Frequency” using the 1 (power) 
switch on the Communication System and the 
buttons on the Remote Commander. 
When the 1 (power) switch indicator on the 
Communication System blinks then stays lit 
after rebooting, perform the steps below.

1 Press the 1 (power) switch on the 
Communication System.

2 Within five seconds after you pressed the 
switch, press the buttons on the Remote 

Commander described below depending 
on the desired Frequency.
60 Hz: VIDEO INPUT button (once) 
then Number button 1 (three times)
50 Hz: VIDEO INPUT button (once) 
then Number button 2 (three times)

The setting of “Frequency” is changed, and the 
system will reboot.

 Custom Input 
Label

Allows you to set the names of the selected 
video inputs using up to 12 characters.

Custom Input Label (Camera)
Selects when “Camera” is selected in 
“Video Input”.

Custom Input Label (DVI-I 1)
Selects when “DVI-I 1” is selected in 
“Video Input”.

Custom Input Label (DVI-I 2)
Selects when “DVI-I 2” is selected in 
“Video Input”.

Custom Input Label (HDMI) 
(PCS-XG100S only)
Selects when “HDMI” is selected in “Video 
Input”.

 Link to Mic
Allows you to select whether to link an 
audio input to the selected video input.

Link to Audio Input
Allows you to switch the audio input in 
conjunction with switching the video input 
by linking each video input and a specific 
microphone or other audio input.
Off: Switches the video input and the 

microphone or other audio input 
separately.

On: Links switching of the video input and 
the microphone or other audio input.

When “Link to Audio Input” is set to “On”, 
“Audio Input”, “Input Select (MIC)” and 

Note

Notes

Note
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“Input Select (AUX)” on the Basic Setup1 
page of Audio setup menu cannot be selected.

Video Input
Allows you to select the video input.
Camera: Selects the camera picture from 

the camera connected to the CAMERA 
connector.

DVI-I 1: Selects the picture from the 
external equipment connected to the 
DVI-I 1 IN connector.

DVI-I 2: Selects the picture from the 
external equipment connected to the 
DVI-I 2 (PC) IN connector.

Audio Input
Allows you to select the audio input which is 
linked to the video input selected in “Video 
Input” when “Link to Audio Input” is set to 
“On”.
MIC: Inputs audio from the microphone.
AUX: Inputs audio from the external 

equipment.
MIC+AUX: Inputs audio both from the 

microphone and external equipment. 

Input Select (MIC)/
Input Select (AUX)
Allows you to select the audio input from the 
microphone and/or external equipment 
when “Link to Audio Input” is set to “On”.

For the PCS-XG100S
The options that can be selected vary with 
the Audio Input setting.
When you select “MIC” from “Audio 
Input”, you can select one of the following 
three options. When you select “AUX”, you 
can select “AUDIO 1” or “AUDIO 2”. 
When you select “MIC+AUX”, you can 
select two options: one microphone input 
from “MIC (A1)”, “AUDIO 1” or “AUDIO 
2”, and one auxiliary external input from 
“AUDIO 1” or “AUDIO 2”.
MIC (A1): Select use of the PCS-A1 

microphone (supplied) connected to the 
MIC (A1) jacks on the Communication 
System.

AUDIO 1: Select to input the audio of 
external equipment connected to the 
AUDIO 1 IN jacks on the 
Communication System.

AUDIO 2: Select to input the audio of 
external equipment connected to the 
AUDIO 2 IN jacks on the 
Communication System.

For the PCS-XG77S
The options that can be selected vary with 
the Audio Input setting.
When you select “MIC” from “Audio 
Input”, you can select one of the following 
three options. When you select “AUX”, you 
can select “AUDIO 1” or “AUDIO 2”. 
When you select “MIC+AUX”, you can 
select two options: one microphone input 
from “MIC (A1)”, “AUDIO 1” or “AUDIO 
2”, and one auxiliary external input from 
“AUDIO 1” or “AUDIO 2”.
MIC (A1): Select use of the PCS-A1 

microphone (supplied) connected to the 
MIC (A1) jacks on the Communication 
System.

AUDIO 1: Select to input the audio of 
external equipment connected to the 
AUDIO 1 IN jacks on the 
Communication System.

AUDIO 2: Select to input the audio of 
external equipment connected to the 
AUDIO 2 IN jacks on the 
Communication System.

The LAN setup menu is used to set up LAN 
connection.

For details about the settings, consult your 
network administrator.

• The contents of the LAN setup menu vary 
with the “Use LAN2” setting in the Line 
Interface setup menu, or “Internet Protocol” 
setting in the Administrator setup menu.
The LAN page number after the LAN2 page 
also varies according to the number of setting 
items.

• The menu displays and references to 
“LAN1” will be simply “LAN” on the 
PCS-XG77S.

LAN Setup Menu

Notes
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 Basic Setup: 
LAN1

Host Name
Enter your host name (up to 30 characters).

DHCP Mode
Allows you to select whether the Dynamic 
Host Configuration Protocol (DHCP) server 
is enabled.
Auto: The IP address, network mask, 

gateway address and DNS address are 
automatically assigned.

Off: Disables the DHCP server. In this case, 
enter an IP address, network mask, 
gateway address and DNS address.

Prefix Length
Configure the prefix length of the IPv6 
address within the range of 0 to 128.

IP Address
Enter the IP address.

Network Mask
Enter the network mask.

Gateway Address
Enter the default gateway address.

Primary DNS
Enter a primary DNS address.

Secondary DNS
Enter a secondary DNS address.

LAN Mode
Allows you to select the interface type and 
the communication mode of the LAN 
connection.
Auto: The interface type and the 

communication mode are detected 
automatically.

1000Mbps: Connects via 1000BASE-T.
100Mbps Full Duplex: Connects via 

100BASE-TX in full duplex mode.
100Mbps Half Duplex: Connects via 

100BASE-TX in half duplex mode.
10Mbps Full Duplex: Connects via 

10BASE-T in full duplex mode.
10Mbps Half Duplex: Connects via 

10BASE-T in half duplex mode.

 Basic Setup: 
LAN1: IPv6

• When “Internet Protocol” is set to “IPv4/
IPv6” in the Administrator setup menu, the 
setup screen for IPv6 appears. In such cases, 
configure the LAN mode in the IPv6 setup 
screen.

• “IPv4/IPv6” for “Internet Protocol” will be 
supported in version 2.0.

DHCP Mode
Allows you to select whether the Dynamic 
Host Configuration Protocol (DHCP) server 
is enabled.
Auto: The IP address, network mask, 

gateway address and DNS address are 
automatically assigned.

Off: Disables the DHCP server. In this case, 
enter an IP address, network mask, 
gateway address and DNS address.

Prefix Length
Configure the prefix length of the IPv6 
address within the range of 0 to 128.

IP Address
Enter the IP address.

Gateway Address
Enter the default gateway address.

Primary DNS
Enter a primary DNS address.

Secondary DNS
Enter a secondary DNS address.

LAN Mode
Allows you to select the interface type and 
the communication mode of the LAN 
connection.
Auto: The interface type and the 

communication mode are detected 
automatically.

1000Mbps: Connects via 1000BASE-T.
100Mbps Full Duplex: Connects via 

100BASE-TX in full duplex mode.
100Mbps Half Duplex: Connects via 

100BASE-TX in half duplex mode.

LAN
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10Mbps Full Duplex: Connects via 
10BASE-T in full duplex mode.

10Mbps Half Duplex: Connects via 
10BASE-T in half duplex mode.

 PPPoE

PPPoE
Allows you to select whether to use PPPoE 
for LAN connection. 
Off: Does not use PPPoE.
LAN1: Uses PPPoE for LAN connection 

using the 1 (LAN1) connector (  
(LAN) connector on the PCS-XG77S).

LAN2: Uses PPPoE for LAN connection 
using the 2 (LAN2) connector.

• The “LAN1” setting is called the “On” 
setting on the PCS-XG77S.

• The “LAN2” setting is not available on the 
PCS-XG77S.

• The PPPoE registration status appears at the 
bottom of the screen for each page.

User Alias
Enter a user name when you use PPPoE for 
LAN connection.

Password
Enter a password when you use PPPoE for 
LAN connection. 

Fixed IP for PPPoE
Select whether to make a PPPoE connection 
using a fixed IP address.
Off: Does not use a fixed IP address for a 

PPPoE connection.
On: Uses a fixed IP address for a PPPoE 

connection.

Fixed IP Address for PPPoE
Enter an IP address when “Fixed IP for 
PPPoE” is set to “On”.

DNS
Allows you to select whether to obtain DNS 
server addresses automatically or to specify 
them manually when connecting to a LAN 
using PPPoE.
Obtain automatically: Assigns DNS server 

addresses automatically.

Specify: Allows you to specify DNS server 
addresses.

Primary DNS
Enter a primary DNS address.

Secondary DNS
Enter a secondary DNS address.

NAT Setup

NAT Mode
Allows you to select whether you connect 
the system to a local network using Network 
Address Translation (NAT), which allows 
one IP address to be shared by several 
computers on the same LAN.
Auto: Enables or disables the NAT mode by 

automatically detecting the use of NAT. 
This option is effective only when you 
use the UPnP router.

On: Enables NAT mode.
Off: Disables NAT mode.

WAN IP Address
Enter the IP address for the Wide Area 
Network (WAN).

 Gatekeeper

• When “Internet Protocol” is set to “IPv4/
IPv6” in the Administrator setup menu, 
configure the settings in the “Gatekeeper: 
IPv6” screen.

• “IPv4/IPv6” for “Internet Protocol” will be 
supported in version 2.0.

Gatekeeper Mode
Allows you to select whether to use the 
gatekeeper to control access to a LAN. 
Using the gatekeeper allows you to dial 
using the user name or user number as well 
as dialing using the IP address.
Auto: Automatically detects the gatekeeper 

and uses it.
On: Enables the gatekeeper.
Off: Disables the gatekeeper.

Notes
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Gatekeeper Address
Enter the address of the gatekeeper used 
when “Gatekeeper Mode” is set to “On”.

User Alias
Enter the user name (H.323 alias) registered 
in the gatekeeper.

User Number
Enter the user number (E.164 number) 
registered in the gatekeeper.

H.460
Allows you to select whether to use H.460 to 
traverse firewalls and connect to the 
terminals on other networks.
On: Enables connection that traverses 

H.460 standard firewalls.
Off: Disables connection that traverses 

firewalls.

 Gatekeeper: IPv6

• This appears when “Internet Protocol” is set 
to “IPv4/IPv6” in the Administrator setup 
menu.

• “IPv4/IPv6” for “Internet Protocol” will be 
supported in version 2.0.

Gatekeeper Mode
Allows you to select whether to use the 
gatekeeper to control access to a LAN. 
Using the gatekeeper allows you to dial 
using the user name or user number as well 
as dialing using the IP address.
Auto: Automatically detects the gatekeeper 

and uses it.
On: Enables the gatekeeper.
Off: Disables the gatekeeper.

Gatekeeper Address
Enter the address of the gatekeeper used 
when “Gatekeeper Mode” is set to “On”.

User Alias
Enter the user name (H.323 alias) registered 
in the gatekeeper.

User Number
Enter the user number (E.164 number) 
registered in the gatekeeper.

 Used Port 
Number, RTP/RTCP Setup

Q.931
Enter the Q.931 port number.

H.245
Enter the H.245 port number.

RTP/RTCP
Enter the RTP/RTCP port number.

MTU Size
Enter the MTU size.

 SNMP

SNMP Mode
Allows you to select whether the Simple 
Network Management Protocol (SNMP) 
agent is enabled.
On: Enables the SNMP agent.
Off: Disables the SNMP agent.

Trap Destination
Enter the address of the trap destination 
SNMP manager.

Community
Enter the community name managed by the 
SNMP manager (up to 24 characters). By 
default, “public” is entered.

Description
Enter the description of this terminal. By 
default, “Videoconference Device” is 
entered and can not be changed.

Location
Enter the location where this terminal is 
installed (up to 30 characters).

Contact
Enter information about the terminal 
administrator (up to 30 characters).

Specifies the functions for providing 
optimum consistent communication.

Notes
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• When “Lip Sync” is set to “Off” in the Audio 
setup menu, you cannot change the setting 
for “Adaptive Rate Control (ARC)”, “Packet 
Resend Request (ARQ)” or “Forward Error 
Correction (FEC)”.

• When “Adaptive Rate Control (ARC)”, 
“Packet Resend Request (ARQ)” or 
“Forward Error Correction (FEC)” is set to 
“On”, you cannot set “Lip Sync” to “Off” in 
the Audio setup menu.

• The QoS function is not available during SIP 
connections.

 Basic Setup

Adaptive Rate Control (ARC)
Allows you to select whether to always 
optimize the LAN bandwidth.
On: Always optimizes the LAN bandwidth.
Off: Does not optimize the LAN bandwidth.

Auto Bandwidth Detection
Allows you to select whether you use the 
Auto Bandwidth Detection feature.
On: Enables the Auto Bandwidth Detection 

feature.
Off: Disables the Auto Bandwidth Detection 

feature.

TCP Port Number
Enter the fixed TCP port number.

UDP Port Number
Enter the fixed UDP port number.

For details on the port numbers used on the 
system, see “List of Port Numbers Used on 
the PCS-XG100S/XG77S” on page 258.

Packet Resend Request (ARQ)
Allows you to select whether to request 
packet to be resent when packet losses occur 
during communication.
On: Requests packets to be resent.
Off: Does not request packets to be resent.

When a multipoint connection is made among 
six points or more with “Packet Resend 
Request (ARQ)” set to “On”, the maximum 
bandwidth to be used will be restricted.

ARQ Buffering Time
Set the buffering time used for “Packet 
Resend Request”.
You can select from among “300ms”, 
“150ms”, “80ms”, “Auto” and “Custom”. 
When “Custom” is selected, you can specify 
any buffering time.

ARQ Buffering Time
Enter the buffering time (50 ms to 999 ms) 
when you select “Custom” in “ARQ 
Buffering Time”.

Forward Error Correction (FEC)
Allows you to select whether received 
packets are identified with an error 
correction mark.
On: Identifies with an error correction mark.
Off: Not identify with an error correction 

mark.

When “Forward Error Correction (FEC)” is set 
to “On”, the maximum bandwidth to be used is 
restricted to 8 Mbps.

FEC Redundancy
Allows you to set redundancy of the packet 
used for the Forward Error Correction 
(FEC).
You can select from among “8”, “4”, “2” and 
“Auto”. When you select “8”, “4” and “2”, 
the communication bit rate may be different 
from the specified value.

Audio Duplex Transmission
Allows you to select whether to 
automatically transmit audio in double when 
audio communication is interrupted 
depending on a network status.
On: Enables the Audio Duplex 

Transmission feature.
Off: Disables the Audio Duplex 

Transmission feature.

 Re-Order/Shaping

Re-Order
Allows you to select whether to correct re-
order that may cause packet loss (invalid 
order of arrival in the packet). Correcting re-
order enables smoother picture and sound.

Notes

Note

QoS1

Note

QoS2
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On: Corrects re-order.
Off: Does not correct re-order.

Re-Order Buffer
Allows you to select re-order buffer.
You can select from among “Auto”, “1”, “2” 
and “Custom”.

Re-Order Buffer Rate
Enter the re-order buffer rate. You can enter 
the value between 1 and 5.

Shaping
Allows you to select whether to use shaping, 
which adjusts the IP packet transfer rate.
On: Uses shaping.
Off: Does not use shaping.

.

TOS

TOS Data Type
Allows you to select the type of data for 
which you configure the TOS (Type of 
Service) field.
Video: Configure the TOS field for video 

data.
Audio: Configure the TOS field for audio 

data.
Data: Configure the TOS field for camera 

control signals, etc.
Presentation: Configure the TOS field for 

the DVI-I presentation data.

TOS
Allows you to select how to define the TOS 
(Type of Service) field of the data selected in 
“TOS Data Type”.
Off: Does not define the TOS field.
IP Precedence: Defines the TOS field as IP 

Precedence.
DSCP: Defines the TOS field as the 

Differentiated Services Code Point 
(DSCP). Enter the value between 0 and 
63.

Precedence
Enter the IP Precedence value between 0 and 
7.

Low Delay
Allows you to select whether to specify the 
Low Delay bit of the TOS field.
On: Specifies the Low Delay bit of the TOS 

field.
Off: Does not specify the Low Delay bit of 

the TOS field.

High Throughput
Allows you to select whether to specify the 
High Throughput bit of the TOS field.
On: Specifies the High Throughput bit of 

the TOS field.
Off: Does not specify the High Throughput 

bit of the TOS field.

High Reliability
Allows you to select whether to specify the 
High Reliability bit of the TOS field.
On: Specifies the High Reliability bit of the 

TOS field.
Off: Does not specify the High Reliability 

bit of the TOS field.

Minimum Cost
Allows you to select whether to specify the 
Minimum Cost bit of the TOS field.
On: Specifies the Minimum Cost bit of the 

TOS field.
Off: Does not specify the Minimum Cost bit 

of the TOS field.

DSCP
Enter the DSCP value. This item only 
appears when “TOS” is set to “DSCP”.

The SIP setup menu is used to connect with 
an IP phone, etc. using the SIP (Session 
Initiation Protocol).

Basic Setup

SIP Server Mode
Allows you to select whether you use a SIP 
server or not.
On: Enables use of the SIP server.
Off: Disables use of the SIP server.

TOS Setup Menu

TOS

SIP Setup Menu

SIP
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Transport Protocol
Allows you to select the protocol to be used 
for SIP.
TCP: Uses TCP (Transmission Control 

Protocol).
UDP: Uses UDP (User Datagram Protocol). 

This is the factory default setting.

Port Number
Enter the port number to be used for SIP.

SIP Domain
Enter the SIP domain name.

Registered User Name
Enter the user name for the terminal to be 
registered to the SIP server (up to 39 
characters).

Password
Set the password for the terminal to be 
registered to the SIP server (up to 39 
characters).

SIP Server Address
Enter the address of the SIP server.

SIP Server Port
Enter the port number used for 
communication with the SIP server.

The ISDN setup menu is used to set up ISDN 
lines.

ISDN will be supported in version 2.0.

Basic Setup

Country/Region
Allows you to select the country or region 
where you are using the Communication 
System.

Protocol
Allows you to select the protocol of the 
ISDN lines to be used. You can select 
National ISDN, Japan (NTT), Euro ISDN, 
Euro ISDN (France), 5ESS (P-P), or DMS-

100, depending on the interface that you are 
using. 

For customers in the USA and Canada, see 
“SPID Settings for Customers in the USA 
and Canada” on page 80.

Telephone 
Number
Enter the area code and local number in the 
text boxes corresponding to the port 
numbers on the ISDN unit.
The text boxes correspond to the port 
numbers on the ISDN unit in the following 
way.
A1: Port 1 on the ISDN unit.
A2: Port 1 on the ISDN unit.
B1: Port 2 on the ISDN unit.
B2: Port 2 on the ISDN unit.
C1: Port 3 on the ISDN unit.
C2: Port 3 on the ISDN unit.

Area Code
Enter the area code of the ISDN line to be 
used. Do not enter the first 0 of the area code.

Local Number
Enter the line number (local number) of the 
ISDN line to be used.

• When you select an empty field and then 
press the ENTER button of the Remote 
Commander, the setting of the previous field 
is copied into the selected field.

• When using the PCSA-B768S ISDN Unit, 
selecting the ISDN3 button displays the D1 
to F2 text boxes. Fill in the D1 to F2 text 
boxes according to the lines that you are 
using.

Sub Address
The A1 to C2 (or A1 to F2) fields appear.

Sub Address
Enter sub-addresses when registering them. 
Sub-addresses can only be composed of 
numbers.

ISDN Setup Menu

Note

ISDN1

Notes

ISDN2

ISDN4
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SPID
The SPID (Service Profile Identifier) pages 
are used only for customers in the USA and 
Canada.

For details, see “SPID Settings for 
Customers in the USA and Canada” on page 
80.

SPID
The A1 to C2 (or A1 to F2) fields appear.
Enter SPID (Service Profile Identifier).

Auto SPID
When you select “Auto SPID”, you can 
automatically set up the Area Code and 
Local Number on the Telephone Number 
page and SPID items.

If you connect to an ISDN switch type, 
configuration of SPID (Service Profile 
Identifier) is required. 
If “Auto SPID” is not available in your area, 
set up SPID manually using the ISDN setup 
menu.

1 Open the Basic Setup page of the 
ISDN setup menu.

2 Enter the country code in the Country/
Region Code text box depending on 
the network switch type you are using.

AT&T 5ESS (National ISDN), NTI 
DMS-100 (National ISDN): Enter “1”.

AT&T 5ESS (Point-to-Point Custom 
ISDN): Enter “1*12”.

NTI DMS-100 (Custom ISDN): Enter 
“1*11”.

3 Open the Telephone Number page to 
enter the LDN (Local Directory 
Number) in the Local Number text 
boxes. 

When you use the AT&T 5ESS 
(Point-to-Point Custom ISDN) 
switch type

Enter the same LDNs in the A1 and 
A2 (B1 and B2, C1 and C2, depending 
on the number of lines you use) text 
boxes.

When you use the NTI DMS-100 
(National ISDN) or NTI DMS-100 
(Custom ISDN) switch type
Enter the different LDNs in the A1 
and A2 (B1 and B2, C1 and C2, 
depending on the number of lines you 
use) text boxes. These switch types are 
given a separate number for each 
channel.

When you use the AT&T 5ESS 
(National ISDN) switch type
You may enter the same or different 
numbers in two channels.

4 Open the SPID page (ID page) to enter 
the SPID.
The SPID is generally comprised of 12 
digits, including a 7 digit LDN (Local 
Directory Number). Be sure to enter the 
different SPID number in each of the 
A1 and A2 (B1 and B2, C1 and C2, 
depending on the number of lines you 
use) text boxes if you have entered the 
separate LDNs in the Local Number 
text boxes for each channel in step 3.

For the AT&T 5ESS (National 
ISDN) switch type
Enter the SPID in the A1 text box 
only.

For the NTI DMS-100 (National 
ISDN), NTI DMS-100 (Custom 
ISDN), AT&T 5ESS (National ISDN) 
switch type
Enter the different SPID numbers in 
the A1 and A2 text boxes.

For the AT&T 5ESS (Point-to-Point 
Custom ISDN) switch type
You do not need to set up the SPID, 
then no entry in the A1 and A2 (B1 

SPID Settings for Customers 
in the USA and Canada

ISDN5
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and B2, C1 and C2, depending on the 
number of lines you use) is required.

5 After the settings are completed, 
select “Save”, then press the ENTER 
button.

The Annotation setup menu is used for the 
annotation function allowing you to write 
letters or graphics on the screen using a pen 
tablet.

 Annotation

Enable
Allows you to select whether the annotation 
function is enabled.
On: Enables the annotation function.
Off: Disables the annotation function.

Color
Allows you to select the color of the letters 
or graphics written on the screen with a pen 
tablet.
You can select from among “Black”, “Red”, 
“Blue”, “Green”, “Yellow”, “Orange”, 
“Purple” and “White”.

Line Density
Allows you to select the density of the line 
written on the screen with a pen tablet.
You can select from among “Thick”, 
“Medium” and “Thin”.

 Camera

Second Camera Input
Allows you to select the input connector on 
the Communication System to which the 
second camera is connected.
DVI-I 1: Connects the second camera to the 

DVI-I 1 IN connector.
DVI-I 2: Connects the second camera to the 

DVI-I 2 (PC) IN jacks.

HDMI: Connects the second camera to the 
HDMI IN connector.

The “HDMI” setting is not available on the 
PCS-XG77S.

 Device Setup

Terminal Name
Input the local terminal name transmitted to 
a remote party (up to 30 characters).

Standby Mode
Allows you to select whether the 
Communication System enters standby 
mode if it is idle for a specified period of 
time.
On: Allows the System to go on standby.
Off: Does not allow the System to go on 

standby.

Standby Time
Specify the time the system must remain idle 
before entering the standby mode. This time 
can be set between 1 and 99 minutes.

For details on the standby mode, see 
“Standby Mode Function” on page 39.

Last Number Registration
Allows you to select whether to register the 
remote party in the Phone Book after the 
communication ends.
Off: The registration of the remote party 

does not take place.
On: If the remote party is not registered in 

the Phone Book, the message “Register 
this participant in the list?” appears on 
the monitor screen when communication 
ends. When you select “OK”, the List 
Edit menu opens.

Control by Far End
When “Far End Camera Control” is set to 
“On” in the Communication setup menu, 
you can temporarily reject the camera 
control command transmitted by the remote 
party.

Annotation Setup Menu

Camera Setup Menu

Annotation

Camera

Note

General Setup Menu

General1
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On: Accepts the camera control command.
Off: Rejects the camera control command.

Language
Allows you to select the menu and display 
language used by the system. You can select 
from the following languages: English, 
French, German, Japanese, Spanish, Italian, 
Simplified Chinese, Portuguese, Traditional 
Chinese, Korean, Dutch, Danish, Swedish, 
Finnish, Polish, Russian, Arabic, Thai, 
Norwegian, Turkish, Welsh, Czech and 
Hungarian.

 Clock Set

NTP
Allows you to select whether to obtain clock 
information from the server with NTP.
On: Obtains clock information from the 

server.
Off: Does not obtain clock information from 

the server.

Primary NTP Server
Enter the address of the primary NTP server 
from which the clock information is 
obtained.

Secondary NTP Server
Enter the address of the secondary NTP 
server from which the clock information is 
obtained.

Time Zone
Allows you to select the country or region 
where you are using the Communication 
System.

Clock Display Pattern
Allows you to select the display pattern of 
the clock. 
You can select from among “Year/Month/
Day”, “Month/Day/Year”, “Day/Month/
Year”, “Year-Month-Day” and 
“Day.Month.Year”.

Date
Enter the current date (year/month/day).

Time
Set the current clock.

Time Update
Selecting “Execute” and pressing the 
ENTER button on the Remote Commander 
updates the clock setting when “NTP” is set 
to “On”.

 Menu Screens
Allows you to select whether to display the 
items of the Tools and Setup menus.

Display Time in Communication
Off: Displays neither the elapsed nor current 

time during communication.
Time Display: Displays the elapsed time 

during communication.
Current Time: Displays the current time 

during communication.

Display Terminal Name
Off: Does not display the connected 

terminal names.
Always show: Always displays the 

connected terminal names.
Show temporarily: Displays the connected 

terminal names for a brief moment.

Guide
On: Displays the instruction that guides the 

operation.
Off: Does not display the instructions.

Display Indicator
On: Displays indicators such as those for a 

USB storage device or tablet.
Off: Does not display the indicators.

Communication Mode Display
On: Displays the communication mode 

when the system is connected to the 
remote site.

Off: Does not display the communication 
mode when the system is connected to 
the remote site.

Display On-Screen Keyboard
On: Displays the on-screen keyboard.
Off: Does not display the on-screen 

keyboard.

For details on the on-screen keyboard, see 
“Entering Characters Using the On-Screen 
Keyboard” on page 56.

General2

General3
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Menu Transparency
Allows you to select the degree of 
transparency of the superimposed menu 
display over the background picture. You 
can select from among “High”, “Medium” 
and “Low”.

 Function Keys in 
Communication
Allows you to switch the picture with one 
press of a button on the Remote 
Commander.
You can set the function to be assigned to 
each of the F1 to F4 (function) buttons.

• You cannot set “Function Keys in 
Communication” during communication. Set 
this item before starting communication.

• The “HDMI” setting is not available on the 
PCS-XG77S.

F1
Allows you to select the video input 
switched by pressing the F1 button on the 
Remote Commander. You can select from 
among “Far/Near”, “Camera”, “HDMI”, 
“DVI-I 1”, “DVI-I 2” and “No Operation”.
This item is preset to “Far/Near” at the 
factory. This setting allows you to switch the 
cameras to be controlled between the local 
and remote sites during communication by 
pressing the F1 button on the Remote 
Commander.

Even if “F1” is set to any option other than 
“Far/Near”, “F1” is fixed to “Far/Near” while 
the Video Input or Layout menu is displayed on 
the screen. In some other cases, the function of 
the F1 to F4 buttons may be fixed regardless of 
the setting for practical convenience, in which 
case the functions of the button are shown in 
the instruction display.

F2
Allows you to select the video input 
switched by pressing the F2 button on the 
Remote Commander. You can select from 
among “Camera”, “HDMI”, “DVI-I 1”, 
“DVI-I 2” and “No Operation”.

F3
Allows you to select the video input 
switched by pressing the F3 button on the 
Remote Commander. You can select from 
among “Camera”, “HDMI”, “DVI-I 1”, 
“DVI-I 2” and “No Operation”.

F4
Allows you to select the video input 
switched by pressing the F4 button on the 
Remote Commander. You can select from 
among “Camera”, “HDMI”, “DVI-I 1”, 
“DVI-I 2” and “No Operation”.

 Home Menu1
Allows you to select the items that show or 
hide in/from the Home menu.

Some items may not be set during 
communication.

Clock Display
On: Allows display of the current time in the 

Home menu.
Off: Does not display the current time.

Local Terminal Name
On: Displays the local terminal name in the 

Home menu.
Off: Does not display the local terminal 

name.

Number Display
Allows you to select the identification of the 
local system, such as the IP address and user 
name, to be displayed in the Home menu.
SIP:User Name: Displays the user name 

registered in the SIP server.
SIP:Address: Displays the SIP address.
GK:User Alias: Displays the user name 

registered in the gatekeeper when you 
use the gatekeeper.

GK:User Number: Displays the user 
number registered in the gatekeeper 
when you use the gatekeeper.

Notes

Note

General4

Home Menu Setup Menu

Note
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NAT:Address: Displays the NAT address 
when you connect the system to a 
network using NAT.

IP: Address: Displays the IP address.
No display: Does not display any 

identification, such as the IP and user 
name, for the system.

Terminal Status
On: Displays the local terminal status in the 

Home menu.
Off: Does not display the local terminal 

status.

Warning Messages
On: Displays a warning message in the 

Home menu when an abnormality 
occurs.

Off: Does not display a warning message.

 Home Menu2
Allows you to select whether to display the 
menu buttons in the Home menu.

Connect Button Display
Select the buttons for connection to be 
displayed in the Home menu.
Simple: Displays “Connect” button only.
Individual: Selects whether to display 

“Phone Book”, “History” or “Detailed 
Dial” depending on the setting of each 
button.

Off: Does not display the buttons for 
connection.

Phone Book Button
On: Displays “Phone Book”.
Off: Does not display “Phone Book”.

History Button
On: Displays “History”.
Off: Does not display “History”.

Detailed Dial Button
On: Displays “Detailed Dial”.
Off: Does not display “Detailed Dial”.

Camera Button
On: Displays “Camera”.
Off: Does not display “Camera”.

Tools Button
Off: Does not display “Tools”.
On: Displays “Tools”.

One-Touch Dial
On: Displays the one-touch dial buttons.
Off: Does not display the one-touch dial 

buttons.

Direct Dial
Off: Does not display “Dial” and the text 

box for direct dialing.
On: Displays “Dial” and the text box for 

direct dialing.

 Home Menu3
Allows you to select whether to display the 
indicators (status information) in the Home 
menu.

Video Input Display
On: Displays the current video input name.
Off: Does not display the current video input 

name.

Audio Input Display
On: Displays the current audio input.
Off: Does not display the current audio 

input.

Audio Level Meter
On: Displays the current audio input level.
Off: Does not display the current audio input 

level.

Volume
On: Displays the volume meter for a certain 

duration when the volume is adjusted.
Off: Does not display the volume meter.

LAN Status
On: Displays the current status of LAN 

connection.
Off: Does not display the current status of 

LAN connection.

ISDN Status
On: Displays the currently used ISDN unit 

port.
Off: Does not display the currently used 

ISDN unit port.

Home Menu2

Home Menu3
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ISDN will be supported in version 2.0.

The Administrator setup menu is used for 
the system administrators. 

 Password
By registering the password in this menu, 
you can restrict user access from the system 
or the Web page to the setup menus and 
Phone Books, and prevent their 
modification.

If a password is not enabled, anyone will be 
able to access the system using the respective 
user name. Be sure to configure all of the 
passwords to prevent unauthorized third parties 
on the network from accessing the system.

For details on when each password is used 
for authorization in the Web page, see 
“Chapter 7: Web Control Function”.

Administrator Password
Use up to 8 alphanumeric characters and 
symbols to register the password used by the 
system administrator.
When you register an Administrator 
Password, a password prompt will appear 
when you access the Administrator setup 
menu. In addition, the Administrator 
Password can be used as the main password 
if multiple passwords are registered. For 
example, if the Phone Book Modification 
Password, Save Settings Password, and 
Administrator Password are registered, the 
Administrator Password can be used to 
modify Phone Books and settings.

• After you enter the Administrator Password 
to modify settings or Phone Books, unless 
you switch to a different screen from the 
setup menu or Phone Book screen, 
modification will be enabled without 
password reentry. In addition, modification 
will be enabled without password reentry for 

about 2 minutes after returning to the Home 
menu from the setup menu or Phone Book. 
The same applies when you access the 
Administrator setup menu.

• Registering only the Administrator Password 
will not enable password protection for 
settings and Phone Book modification. 
Always register the Phone Book 
Modification Password and the Save Settings 
Password in addition to the Administrator 
Password.

• Be aware that registering other passwords 
but leaving the Administrator Password 
blank allows for modification and 
connection from the Web page without 
password input.

• Make sure to write down the Administrator 
Password. If you should forget the 
Administrator Password, consult your Sony 
dealer. In this case, the memory of the 
Communication System is initialized before 
repair, and the data in the Phone Book and 
History lists, as well as various setting data, 
are erased.

Phone Book Modification Password
Use up to 8 alphanumeric characters and 
symbols to register the password used for 
Phone Book modifications.

After you enter the Phone Book Modification 
Password to modify Phone Books, unless you 
switch to a different screen from the Phone 
Book, modification will be enabled without 
password reentry. In addition, modification 
will be enabled without password reentry for 
about 2 minutes after returning to the Home 
menu from the Phone Book.

Save Settings Password
Use up to 8 alphanumeric characters and 
symbols to register the password used for 
saving settings.

After you enter the Save Settings Password to 
modify settings, unless you switch to a 
different screen from the setup menu, 
modification will be enabled without password 
reentry. In addition, modification will be 
enabled without password reentry for about 2 

Note

Administrator Setup Menu

Note

Notes

Administrator1

Note
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minutes after returning to the Home menu from 
the setup menu.

Remote Access Password
Use up to 8 alphanumeric characters and 
symbols to register the password used for 
accessing the Web page.

Streaming Broadcast Password
Use up to 8 alphanumeric characters and 
symbols to register the password used when 
receiving and viewing video and audio 
streams from PCS terminals on the Web 
page.

 Setup Password1
Allows you to select whether to require 
“Save Settings Password” when saving each 
setting.

Line Interface
Enabled: Requires “Save Settings 

Password” when saving the Line 
Interface settings.

Disabled: Does not require the password 
when saving the Line Interface settings. 

Dial
Enabled: Requires “Save Settings 

Password” when saving the Dial setup 
settings.

Disabled: Does not require the password 
when saving the Dial setup settings.

Answer
Enabled: Requires “Save Settings 

Password” when saving the Answer 
setup settings.

Disabled: Does not require the password 
when saving the Answer setup settings.

Multipoint (PCS-XG100S only)
Enabled: Requires “Save Settings 

Password” when saving the Multipoint 
settings.

Disabled: Does not require the password 
when saving the Multipoint settings.

IP Mode
Enabled: Requires “Save Settings 

Password” when saving the IP Mode 
settings.

Disabled: Does not require the password 
when saving the IP Mode settings.

SIP Mode
Enabled: Requires “Save Settings 

Password” when saving the SIP Mode 
settings.

Disabled: Does not require the password 
when saving the SIP Mode settings.

ISDN Mode
Enabled: Requires “Save Settings 

Password” when saving the ISDN Mode 
settings.

Disabled: Does not require the password 
when saving the ISDN Mode settings.

 Setup Password2

Audio
Enabled: Requires “Save Settings 

Password” when saving the Audio setup 
settings.

Disabled: Does not require the password 
when saving the Audio setup settings.

Video
Enabled: Requires “Save Settings 

Password” when saving the Video setup 
settings.

Disabled: Does not require the password 
when saving the Video setup settings.

LAN
Enabled: Requires “Save Settings 

Password” when saving the LAN setup 
settings.

Disabled: Does not require the password 
when saving the LAN setup settings.

QoS
Enabled: Requires “Save Settings 

Password” when saving the QoS setup 
settings.

Disabled: Does not require the password 
when saving the QoS setup settings.

TOS
Enabled: Requires “Save Settings 

Password” when saving the TOS setup 
settings.

Administrator2

Administrator3
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Disabled: Does not require the password 
when saving the TOS setup settings.

SIP
Enabled: Requires “Save Settings 

Password” when saving the SIP setup 
settings.

Disabled: Does not require the password 
when saving the SIP setup settings.

ISDN
Enabled: Requires “Save Settings 

Password” when saving the ISDN setup 
settings.

Disabled: Does not require the password 
when saving the ISDN setup settings.

 Setup Password3

General
Enabled: Requires “Save Settings 

Password” when saving the General 
setup settings.

Disabled: Does not require the password 
when saving the General setup settings.

Home Menu
Enabled: Requires “Save Settings 

Password” when saving the Home Menu 
setup settings.

Disabled: Does not require the password 
when saving the Home Menu setup 
settings.

Administrator
Enabled: Requires “Save Settings 

Password” when saving the 
Administrator setup settings.

Disabled: Does not require the password 
when saving the Administrator setup 
settings.

Annotation
Enabled: Requires “Save Settings 

Password” when saving the Annotation 
setup settings.

Disabled: Does not require the password 
when saving the Annotation setup 
settings.

Camera
Enabled: Requires “Save Settings 

Password” when saving the Camera 
setup settings.

Disabled: Does not require the password 
when saving the Camera setup settings.

Encryption
Enabled: Requires “Save Settings 

Password” when saving the Encryption 
setup settings.

Disabled: Does not require the password 
when saving the Encryption setup 
settings.

Shared Phone Book
Enabled: Requires “Save Settings 

Password” when saving the Shared 
Phone Book settings.

Disabled: Does not require the password 
when saving the Shared Phone Book 
settings.

 Streaming/
Recording

Streaming
Select whether to enable the streaming 
broadcast.
Enabled: Permits the streaming broadcast.
Disabled: Does not permit the streaming 

broadcast of a videoconference.

Recording
Select whether to enable the recording of 
video and audio to a USB storage device.
Enabled: Permits the recording.
Disabled: Does not permit the recording.

Video
Select a bit rate for streaming and recording 
video.
512Kbps: Streams and records video at 

512 Kbps.
1Mbps: Streams and records video at 

1 Mbps.

Multicast Address
Enter the multicast address for streaming 
broadcasts.

Administrator4

Administrator5
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You can enter the unicast address in this menu. 
If you set the unicast address, enter two or more 
different numbers in “Audio Port Number” and 
“Video Port Number” for streaming 
broadcasts.

Audio Port Number
Enter the audio port number for streaming 
broadcasts.

Video Port Number
Enter the video port number for streaming 
broadcasts.

HOP
Enter a number from 0 to 255 as the HOP for 
streaming broadcasts.

 Access Permit

Depending on the operating environment, 
unauthorized third parties on the network may 
be able to access the system. When you set 
“Web Monitor”, “Web Access”, “Telnet 
Access”, or “SSH Access” to “On” or 
“Enabled”, the following confirmation screen 
will appear.

To confirm the change in the setting, select 
“Accept” and configure all of the passwords on 
the Password page (page 85) of the 
Administrator setup menu. The setting will not 
be changed if you select “Cancel”.

Web Monitor
Allows you to permit the monitoring 
communication status through a Web 
browser (automatic update of JPEG images).
On: Permits monitoring with a Web 

browser.
Off: Does not permit monitoring with a Web 

browser.

Web Access
Select whether to permit access to the 
Communication System via a Web browser.
Enabled: Permits access via a Web browser.
Disabled: Prohibits access via a Web 

browser.

Telnet Access
Select whether to permit access to the 
Communication System via Telnet.
Enabled: Permits access via Telnet.
Disabled: Prohibits access via Telnet.

SSH Access
Allows you to select whether to permit 
access to the Communication System via 
SSH (Secure Shell).
Enabled: Permits access via SSH.
Disabled: Prohibits access via SSH

 Other

Use History
Select whether to display the history lists in 
order to use for dialing, etc.
On: Displays the history lists.
Off: Does not display the history lists.

Save Setup
Saves the data for each setting to a USB 
storage device. The data for each setting 
saved on the USB storage device is 
overwritten.

Phone Book and History data are not saved.

Load Setup
Loads the data for each setting from a USB 
storage device. The data for each setting 
saved on the System is overwritten.

When saving and loading settings, make sure 
that the version of the system from which the 
data was originally saved is the same as the 
version of the local system. If the versions 
differ, the data may not be properly recognized.

AMX Device Discovery
Select whether to export AMX Device 
Discovery information onto the network. 

Note

Note

Administrator6

Note

Note

Administrator7
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Off: Disables this function.
On: Enables this function.
When the AMX system is connected to the 
Communication System via serial 
connection, AMX Device Discovery 
information is output via that serial 
connection.
AMX systems are external control devices 
that can be used to control the 
Communication System. When the AMX 
system receives Device Discovery 
information from the Communication 
System, the System automatically falls 
under the control of the AMX system.

HOP
Enter a number from 0 to 255 as the HOP 
Display Terminal Name.

Auto Restore
Allows you to select whether to 
automatically turn on the Communication 
System if an power interruption occurs and 
is then restored.
On: Enables the Auto Restore function.
Off: Disables the Auto Restore function.

Internet Protocol
IPv4: Uses the internet protocol version 4 

(IPv4) that is commonly used.
IPv6: Uses the next-generation internet 

protocol version 6 (IPv6).
IPv4/IPv6: Uses both IPv4 and IPv6.

• The setting of “Internet Protocol” is common 
to both LAN1 and LAN2.

• When “Internet Protocol” is set to “IPv6” or 
“IPv4/IPv6”, some of the functions of this 
system are restricted, and some of the 
Administrator setup menus are not 
displayed.

• “IPv4/IPv6” for “Internet Protocol” will be 
supported in version 2.0.

For details, see “Restrictions on the Use 
of IPv6” on page 97.

 Phone Book

Save Phone Book
Allows you to save the data in the Phone 
Book on a USB storage device. The data 
already stored on the USB storage device is 
overwritten.

Load Phone Book
Allows you to load the data in the Phone 
Book from a USB storage device. The data 
already stored in the Phone Book is 
overwritten.

When loading Phone Book data, make sure that 
the version of the system from which the data 
was originally saved is the same as the version 
of the local system. If the versions differ, the 
data may not be properly recognized.

Clear Phone Book
Allows you to delete a Phone Book on the 
system.

Auto Dialing
Allows you to select whether to 
automatically dial a specified remote party 
in the Private Phone Book created in a USB 
storage device, when the USB storage 
device is inserted.
On: Enables the Auto Dialing function.
Off: Disables the Auto Dialing function.

For details, see “To dial a specified remote 
party in a Private Phone Book 
automatically” on page 129.

Create Private Phone Book
Allows you to create an empty folder and 
file for a Private Phone Book on a USB 
storage device inserted into the system.

For details, see “Creating a Private Phone 
Book” on page 127.

Delete Private Phone Book
Allows you to delete the Private Phone Book 
on a USB storage device inserted into the 
system.

Notes

Note

Administrator8
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Copy to Private Phone Book
Allows you to copy the entire contents of the 
Phone Book to a Private Phone Book on a 
USB storage device inserted into the system.

   Software Option 
Screen
Allows you to enter the key of the optional 
software you want to add in “Software 
Option” input boxes 1 to 8.

For details on how to add optional software, 
see “Adding Optional Software” on page 
187.

The Encryption setup menu is used to 
connect to a remote party using the 
encryption function.
The encryption function allows you to hold 
a strictly confidential connection.

For details on an encrypted connection, see 
Chapter 5. 

When an encrypted connection is made, the 
maximum bandwidth to be used is restricted to 
6 Mbps.

 Encryption

Encryption Mode
Select whether you use the encryption 
feature.
Off: Disables use of the encryption feature.
Connect Priority: Connects with the 

encryption feature to a remote party with 
standard encrypted connection enabled. 
Connects without the encryption feature 
to a remote party with standard 
encrypted connection disabled or with 
the encryption feature set to off.

Encrypt Priority: Connects only to a 
remote party with standard encrypted 
connection enabled.

This menu is used to configure the settings 
when using the Shared Phone Book located 
on the server.

For details on the Shared Phone Book, see 
“Using the Shared Phone Book” on page 
129.

   Shared Phone 
Book

SPB Mode
Selects whether to use the server managing 
the Shared Phone Book.
On: Enables use of the server managing the 

Shared Phone Book.
Off: Disables use of the server managing the 

Shared Phone Book.

SPB Server Address
Enter the IP address for the server managing 
the Shared Phone Book.

SPB Server Password
Enter the password for the server managing 
the Shared Phone Book.

Encryption Setup Menu

Note

Administrator9

Encryption

Shared Phone Book Setup 
Menu

Shared Phone Book
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Displaying the Machine Status
The Machine Status menu allows display of the versions, communication 
mode, line connection quality, etc. of the Communication System and the 
connected equipment.

1 Press the TOOLS button on the Remote Commander or use the V, v, B or 
b button to select “Tools”, then press the ENTER button.
The Tools menu appears,

2 Use the V, v, B or b button on the Remote Commander to select “Machine 
Status”, then press the ENTER button.
The Machine Status menu appears.

Information screens enabled for display by the Machine Status 
menu
Machine Information (see page 93)
Peripheral Status (see page 93)
Communication Mode Status (see page 94)
LAN Line Status (see page 94)
Network Routing Check (see page 95)

Displaying the Machine Status Menu

Machine Status

Setup

Home Presentation

Streaming

Recording

Annotation

[Suspended]

[Suspended]

[Suspended]

[Suspended]

Icon display

Reject Answer

Screen Capture

Tools

On

Off

Execute

Execute

Execute

Execute

Execute

Machine Status

Back to Tools

Home Machine Information

Peripheral Status

Communication Mode Status

LAN Line Status

Network Routing Check
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3 Use the V, v, B or b button on the Remote Commander to select the 
information to be displayed, then press the ENTER button.
The selected display appears.
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The Machine Information menu shows the 
versions of the HD Visual Communication 
System and the connected equipment for 
exclusive use, installed software versions, 
etc.

Host Version
Displays the software version of the HD 
Visual Communication System.

Software Option
Displays the optional software installed.

Option I/F
Displays the optional connected equipment.
None: No optional equipment is connected.
ISDN (B768): The PCSA-B768S ISDN 

Unit is connected.
ISDN (B384): The PCSA-B384S ISDN 

Unit is connected.
Tablet: Pen tablet (Bamboo small CTH-470/

K0, Intuos pen small CTL-480/S0, or 
Intuos pen & touch small CTH-480/S0 
manufactured by Wacom Co., Ltd.) is 
connected.

Host Name
Displays the host name.

IP Address
Displays the IP address for LAN1 (LAN on 
the PCS-XG77S).

• When “Internet Protocol” is set to “IPv4/
IPv6” in the Administrator setup menu, both 
IPv4 and IPv6 IP addresses are displayed.

• “IPv4/IPv6” for “Internet Protocol” will be 
supported in version 2.0.

IP Address (LAN2) (PCS-XG100S 
only)
Displays the IP address for LAN2.

MAC Address
Displays the MAC address for LAN1 (LAN 
on the PCS-XG77S).

MAC Address (LAN2) (PCS-XG100S 
only)
Displays the MAC address for LAN2.

Serial Number
Displays the serial number.

Machine version
Selecting “Next” in the Machine 
Information menu shows the codec version, 
etc.

Video Input
Displays the input video name.

Audio Input (MIC)
Displays microphone input name.

Audio Input (AUX)
Displays the external audio input name.

Video Output
Displays the 50 Hz/60 Hz setting of 
“Frequency”.

Audio Output
Displays the audio output equipped with this 
system.

LAN Mode (LAN1)
Displays the LAN Mode for LAN1 (LAN on 
the PCS-XG77S).

LAN Mode (LAN2) (PCS-XG100S 
only)
Displays the LAN Mode for LAN2.

Gatekeeper
Displays the status of registration to 
gatekeeper with the following messages:
Gatekeeper Requested, Gatekeeper 
Confirmed, Gatekeeper Reject, Registration 
Requested, Registration Confirmed, 
Registration Failed, Registration Rejected, 
Registration Timeout, Unregistration 
Requested and Unregistration Confirmed.

First Camera
Displays the name of the first camera.

Machine Information

Notes

Peripheral Status
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Second Camera
Displays the name of the second camera.

The Communication Mode Status menu 
shows the status of current communication 
when communication is in progress, and the 
status of previous communications when 
communication is not in progress.
The ISDN Line Status, LAN Line Status or 
LAN Connection Status will also be 
displayed depending on the line interface 
used.

Communication Mode Status
The current communication status will be 
displayed. When two or more points are 
connected to the system, selecting “Next” in 
the lower part of the page displays the next 
page.
For the items described with both “(Encode)” 
and “(Decode)”, the descriptions under 
“(Encode)” show the setting status of the local 
system and those under “(Decode)” show the 
status of the receiving.

Far End Terminal Name
Displays the terminal name of a remote 
party.

Remote Address
Displays the address of a remote party.

Audio Mode
Displays the current audio encoding format.

Video Mode
Displays the current video encoding format.
“H.264 HP” appears during H.264 High 
Profile communication, and “H.264” 
appears during H.264 Baseline Profile 
communication.

The audio encoding and video encoding 
formats used for communication with a remote 
party may differ from the settings in this menu, 
depending on the status of the system on the 
remote site.

Frame Rate
Displays the maximum frame rate of motion 
pictures.

Rate
Displays in real time the number of 
connected lines and their transfer rates.

Line I/F
Displays the line interface being used.

Camera Control
Displays whether the unit is ready to operate 
both cameras.

H239
Displays whether the unit is ready to use the 
H.239 presentation mode.

Check Code
Displays the encryption check code.

The LAN line status will be displayed on 
one page for each point connected to the 
system. The connected point is shown at the 
upper left corner of each page. Selecting 
“Next” in the lower part of the page displays 
the next page.

Bit rate - Encode
Displays by category (audio, video and 
H.239 (presentation)) the transfer rates for 
sending data.

Bit rate - Decode
Displays by category (audio, video and 
H.239 (presentation)) the transfer rates for 
receiving data.

Number of lost packets
Displays by category (audio, video and 
H.239 (presentation)) the number of packets 
lost during transfer on the network.

Number of recovered packets
Displays by category (audio, video and 
H.239 (presentation)) the number of lost 
packets that were recovered with the 
system’s QoS function.

Communication Mode Status

Note

LAN Line Status
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Number of received packets
Displays by category (audio, video and 
H.239 (presentation)) the number of packets 
received during communication.

The Network Routing Check menu is used to 
check the network routing, and it shows the 
checking results.
You can start the network routing check by 
selecting “Start Measurement” in the lower 
part of the menu.

For details, see “About the Network Routing 
Check” on page 106.

IP address of remote site
Enter the IP address of the remote terminal 
you want to check.

Line I/F
LAN1: Select to perform the routing check 

for the network connected to the 1 
connector (  connector on the 
PCS-XG77S).

LAN2: Select to perform the routing check 
for the network connected to the 2 
connector.

The “LAN2” setting is not available on the 
PCS-XG77S.

Gateway
Displays the results of check for the default 
gateway.

ping
Displays the results of check for 
reachability, packet loss, RTT (Round-Trip 
Time) and H.323 (H.323 communication 
availability).

traceroute
Displays the results of check for HOP 
(number of routers passed through to reach 
the remote site) and total RTT.

Start Measurement
Select this button to start a network routing 
check.

Previous
Select this button to restore the Machine 
Status menu.

Network Routing Check

Note
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Restrictions on the 
Use of LAN2 
(PCS-XG100S only)

When you use two LAN connections, use 
the 1 (LAN1) connector to connect a 
private network in your company and the 

2 (LAN2) connector to connect to an 
intranet outside your company.
The following functions of the system are 
restricted when using the 2 (LAN2) 
connector. 

• In the event of using the 1 (LAN1) 
connector to connect to an intranet outside 
your company, make sure to set “Web 
Access”, “Telnet Access” and “SSH Access” 
to “Disabled” on the Access Permit page of 
the Administrator setup menu (page 88).

• The 2 (LAN2) connector cannot be used 
on its own.

Items that cannot be set with LAN2
• NAT Mode
• Gatekeeper
• SNMP Mode
• SIP
• NTP 
• Shared Phone Book
• AMX Device Discovery
• H.460
• DNS 
• Streaming
• IPv6
• Web Access, Telnet Access, SSH Access

Item that can be set with either 
LAN1 or LAN2
• PPPoE

Items to be set with LAN1 or LAN2 
individually
• DHCP Mode
• IP Address
• Network Mask
• Gateway Address

• LAN Mode

Items to be set with LAN1 and LAN2 
commonly
• Used Port Number (TCP, UDP) 
• QoS 
• TOS
• Auto Answer
• Reject Answer

Do not set the same subnet for the LAN1 and 
LAN2 connections.

Notes

Note
96 Restrictions on the Use of LAN2 (PCS-XG100S only)



C
hapter 2: R

egistration and S
etup for S

ystem
 A

dm
inistrators
Restrictions on the 
Use of IPv6

The functions of the system are restricted as 
follows when using the IPv6 Internet 
Protocol or both the IPv4/IPv6 Internet 
Protocols.

“IPv4/IPv6” for “Internet Protocol” will be 
supported in version 2.0.

Unusable functions with IPv6
• SNMP Mode*
• NTP
• Shared Phone Book*
• TOS*
• Network Routing Check*
• AMX Device Discovery*
• LAN2
• PPPoE
• Streaming
• NAT
• SIP

* Usable with IPv4 when using both IPv4 and 
IPv6.

Note
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Setting Up the Network Configurations
This section describes how to set up the network configurations for use with 
various networks.

For details on the LAN setup menu, see “LAN Setup Menu” (page 73).

For details on configurations, consult with the system administrator.

Configuration example

Set “DHCP Mode” to “Auto” under the Basic Setup page in the LAN setup 
menu.

The setting has been configured properly if the IP address appears in the Home 
menu.

To connect to a remote party

Select “IP” under “Line I/F”, enter the remote party’s IP address, and dial.

LAN Connection via DHCP (LAN1/LAN2)

LAN (A) LAN (B)

DHCP Server 1

Setup Basic SetupLAN

Host Name

DHCP Mode

IP Address

Network Mask

Gateway Address

Primary DNS

Secondary DNS

LAN Mode

Auto

CancelSave

Auto

LAN1
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Configuration example

Enter a name in “Host Name” under the Basic Setup page in the LAN setup 
menu, and enter the appropriate values for “IP Address”, “Network Mask”, 
and “Gateway Address”.

The setting has been configured properly if the correct IP address appears in 
the Home menu.

To connect to a remote party

Select “IP” under “Line I/F”, enter the remote party’s IP address, and dial.

LAN Connection through a Router (LAN1/LAN2)

LAN (A) LAN (B)

192.100.10.1

Virtual 
Private 
Network 
(VPN) 192.100.20.1

Router

192.100.10.10 192.100.20.20

Router

Setup Basic SetupLAN

Host Name

DHCP Mode

IP Address

Network Mask

Gateway Address

Primary DNS

Secondary DNS

LAN Mode Auto

Off

Sony

192.100. 10. 10

255.255.255.  0

192.100. 10.  1

CancelSave

LAN1
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Configuration example

1 Enter a name in “Host Name” under the Basic Setup page in the LAN setup 
menu, and enter the appropriate values for “IP Address”, “Network Mask”, 
and “Gateway Address”.

2 Set “Gatekeeper Mode” to “On” under the Gatekeeper page of the LAN 
setup menu, and enter the appropriate values for “Gatekeeper Address”, 
“User Alias”, and “User Number”.

The IP address registered is displayed in the Home menu.

LAN Connection through a Gatekeeper (LAN1 Only)

User number: 100

LAN (B)

192.100.10.10

User alias: PCS-A

User number: 200

LAN (A)

192.100.10.1

192.100.20.20

Gatekeeper 
192.100.10.20

192.100.20.1

User alias: PCS-B

Router Router

Setup Basic SetupLAN

Host Name

DHCP Mode

IP Address

Network Mask

Gateway Address

Primary DNS

Secondary DNS

LAN Mode Auto

Off

Sony

192.100. 10. 10

255.255.255.  0

192.100. 10.  1

CancelSave

LAN1

Setup GatekeeperLAN

Gatekeeper Mode

Gatekeeper Address

User Alias

User Number

H.460

192.100. 10. 20

On

CancelSave

PCS-A

100

Off

LAN4
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To connect to a remote party

Select “IP” under “Line I/F”, enter the user name or user number set by the 
remote party, and dial.

Connection using NAT allows one IP address to be shared by several 
computers on the same LAN. This section describes how to set up visual 
communication in NAT and global IP environments. 

Configuration example

1 Enter a name in “Host Name” under the Basic Setup page in the LAN setup 
menu, and enter the appropriate values for “IP Address”, “Network Mask”, 
and “Gateway Address”.

2 Set “NAT Mode” to “On” in the NAT Setup page of the LAN setup menu, 
and enter the appropriate IP address in “WAN IP Address”.

LAN Connection through NAT (LAN1 Only)

Internet

210.10.10.1

210.20.20.2
(Global address)

192.100.10.10

192.100.10.1 210.20.20.1

Router Router

Setup Basic SetupLAN

Host Name

DHCP Mode

IP Address

Network Mask

Gateway Address

Primary DNS

Secondary DNS

LAN Mode Auto

Off

Sony

192.100. 10. 10

255.255.255.  0

192.100. 10.  1

CancelSave

LAN1
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The setting has been configured properly if the correct WAN IP address 
appears in the Home menu.
To display the NAT address in the Home menu, you must set “Number 
Display” to “NAT:Address” in the Home Menu1 page of the Home Menu 
setup menu (page 83).

3 Remote parties must configure the Basic Setup page in the LAN setup 
menu in the same way.

Remote parties do not need to configure the settings in the NAT Setup page of the 
LAN setup menu as they are not in a NAT environment.

To connect to a remote party

Select “IP” under “Line I/F”, enter the remote party’s IP address, and dial.

When using the terminal in the NAT environment, you can connect to a remote party 
(global IP), but for a remote party to connect to you, you must configure your router 
settings. For details on router settings, consult with the system administrator.

You can use H.460 to traverse firewalls and connect with the terminals on 
other networks.

Note

Note

Setup NAT SetupLAN

5/11/2008 13:00IP:192.168.0.11

NAT Mode

WAN IP Address

On

210. 10. 10.  1

Cancel Save

LAN3

LAN Connection with H.460 Firewall Traversal (LAN1 Only)
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Configuration example

1 Enter a name in “Host Name” under the Basic Setup page in the LAN setup 
menu, and enter the appropriate values for “IP Address”, “Network Mask”, 
and “Gateway Address”.

2 Set “H.460” to “On” under the Gatekeeper page of the LAN setup menu. 
Set “Gatekeeper Mode” to “On” and enter the appropriate value for 
“Gatekeeper Address”.

The IP address registered is displayed in the Home menu.

To conduct a video conference

Select “IP” under “Line I/F”, enter the remote party’s IP address, and dial.

210.20.20.10
(Global address)

192.100.10.1

Traversal 
server

Router Router

Internet

192.200.20.1

192.100.10.10
User Alias: PCS-A
User Number: 100

192.200.20.10

Setup Basic SetupLAN

Host Name

DHCP Mode

IP Address

Network Mask

Gateway Address

Primary DNS

Secondary DNS

LAN Mode Auto

Off

Sony

192.100. 10. 10

255.255.255.  0

192.100. 10.  1

CancelSave

LAN1

Setup GatekeeperLAN

Gatekeeper Mode

Gatekeeper Address

User Alias

User Number

H.460

210. 20. 20. 10

On

CancelSave

PCS-A

100

On

LAN 4
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When using PPPoE, you can use your Internet service provider’s services 
without using a router.

Configuration example

1 Set “PPPoE” to “LAN1” or “LAN2” under the PPPoE page in the LAN 
setup menu, and enter the PPPoE user name and PPPoE password given to 
you by the provider.

• The “LAN1” setting is called the “On” setting on the PCS-XG77S.
• The “LAN2” setting is not available on the PCS-XG77S.

2 If you have a fixed IP from the provider, set “Fixed IP for PPPoE” to “On”, 
and enter your fixed IP address for PPPoE in “Fixed IP Address for 
PPPoE” under the PPPoE page in the LAN setup menu.

The setting has been configured properly if the correct IP address appears 
in the Home menu.

If the fixed DNS server address is specified by the provider, set “DNS” to 
“Specify”, and enter the specific addresses in “Primary DNS” and “Secondary 
DNS”.

3 Remote parties must configure in the same way.

LAN Connection Using PPPoE (LAN1/LAN2)

Notes

Note

ONU

211.10.10.10

Internet 
service

Internet 
service

ONU

210.10.10.10

Local IP 
network

Internet

Setup PPPoELAN

PPPoE

User Alias

Password

Fixed IP for PPPoE

Fixed IP Address for PPPoE

DNS

Primary DNS

Secondary DNS

Sony@aaa.ne.jp

LAN1

CancelSave

Obtain automatically

abcdefg

On

210. 10. 10. 10

LAN2
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To connect to a remote party

Select “IP” under “Line I/F”, enter the remote party’s IP address, and dial.

ISDN will be supported in version 2.0.

1 Enter the appropriate numbers for “Area Code” and “Local Number” in the 
Telephone Number page of the ISDN setup menu.

Do not enter the first 0 of the area code.

For details on the ISDN setup menu, see “ISDN Setup Menu” (page 79).

For details on configurations, consult with the system administrator.

The setting has been configured properly if the correct line number appears 
in the Home menu.

2 Remote parties must configure in the same way.

When connecting to the ISDN unit, use the ports in ascending order.
Yes: 1, 2, 3…
No: 1, 6, 5…

To connect to a remote party

Select “ISDN” under “Line I/F”, enter the remote party’s line number, and 
dial.

For details on how to start a visual communication, see “Starting a 
Connection by Calling a Remote Party” (page 107).

ISDN Connections

Note

Note

Note

ISDN2

A1

A2

B3

B2

C1

C2

Auto SPID

CancelSave

Execute

Area Code Local Number

Setup NumberISDN 
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About the Network Routing Check
Before connecting a remote system, you can check the network routing to 
assure smooth connection with the system.

For the network routing check, knowledge of network is required. Consult your 
network administrator or Sony dealer.

If you have any questions about the checked result, consult your network 
administrator or Sony dealer.

To start the network routing check

Open the Network Routing Check menu of the Machine Status menu on the 
local system that performs the routing check, then set the necessary items on 
the menu.
Select “Start Measurement” to start the network routing check.

For the procedure how to open the Network Routing Check menu, see 
“Displaying the Machine Status” on page 91.

While the network routing check is being performed, you cannot use any other functions 
including communication. When the routing check is complete, the checked results are 
displayed on the Network Routing Check menu. 

Note

Network Routing Check

Machine Status > Network Routing Check

LAN1

XXX.XXX.XXX.XXX

EndStart Measurement

IP Address of Remote Site

Line I/F

Gateway
ping

traceroute

Result
Result
Packet Loss (%)
RTT
H.323 Communication
HOP
Total RTT
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This chapter describes how to connect to a remote party after the administrator 
has completed various registrations and settings for the system.
The chapter explains a point-to-point communication via a LAN connection, 
ISDN connection using the optional PCSA-B384S or PCSA-B768S ISDN 
Unit or SIP.

ISDN will be supported in version 2.0.

For use of optional equipment, see Chapter 4. 

To conduct an encrypted communication, see Chapter 5. 

To conduct a multipoint communication, see Chapter 6.

Starting a Connection by Calling a 
Remote Party

You can start a communication with a remote party by dialing. Once you have 
made a connection to the remote party, you can begin talking just as with a 
normal phone call and start communication.
You can call a remote party using the various methods described below. Use 
any one depending on the settings in the Home menu or connecting status.
• To call a remote party by using the Connect menu (page 108)
• To call a remote party by entering their address or number directly (Direct 

Dial) (page 109)
• To call a remote party by using the one-touch dial buttons (page 111)
• To call a remote party by using the history list (page 112)
• To call a remote party registered in the Phone Book (page 113)
• To call a remote party not registered in the Phone Book by setting the 

necessary items in the Detailed Dial menu (page 115)

 

1 Turn on the TV monitor.

2 Turn on other equipment you are using for the communication.

3 Press the 1 (power) switch on the Communication System to turn it on.

Chapter 3: Basic 
Connection

Note

Turning On the Power
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The 1 (power) switch indicator on the System starts flashing, then lights 
in green when the power is on.
The Home menu appears on the monitor screen and the picture shot by the 
local camera also appears.

After the power is turned on, the camera moves automatically for trial operation. Be 
careful not to catch your finger.

This method is available when the Connect button is displayed in the Home 
menu.

1 Use the V, v, B or b button on the Remote Commander to select “Connect” 
in the Home menu, then press the ENTER button.
The Connect menu appears.

Note

Calling a Remote Party by Using the Connect Menu

1 (power) switch

Connect

Camera

5/11/2008 13:00IP:XXX.XXX.XXX.XXX

Home

AAA Ready

Connect button
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2 Use the V, v, B or b button on the Remote Commander to select how to 
call a remote party, then press the ENTER button.
The menu screen will change according to the item you select.

Enter Number/Address: The Detailed Dial menu appears on the screen.

For the procedure to be followed, see “Calling a Remote Party Not 
Registered in the Phone Book” on page 115.

Select from Phone Book: The Phone Book appears on the screen.

For the procedure to be followed, see “Calling a Remote Party Registered 
in the Phone Book” on page 113.

Select from History: The history list appears on the screen.

For the procedure to be followed, see “Calling a Remote Party by 
Selecting Them in the History List” on page 112.

.

When “Direct Dial” is set to “On” in the Home Menu setup menu, the number 
input box, Dial button, etc. are displayed in the Home menu, allowing you to 
use the direct dial function.

Calling a Remote Party by Entering Their Address or Number 
Directly (Direct Dial)

Select from History

Previous

Enter Number/Address

Select from Phone Book

Connect

IP:192.168.0.11 5/11/2008 13:00

DialIP

5/11/2008 13:00IP:XXX.XXX.XXX.XXX

Home

AAA Ready

Line interface
Number input box

Dial
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1 Use the V, v, B or b button on the Remote Commander to select “Line I/
F” in the Home menu, then press the ENTER button.

2 Use the V, v, B or b button on the Remote Commander to select the line 
interface to be used, then press the ENTER button.
IP: Connects to the system on the remote site via a LAN connected to the 

1 (LAN1) connector (  (LAN) connector on the PCS-XG77S).
ISDN: Connects to the system on the remote site via an ISDN line.
TEL: Connects to a phone on the remote site via an ISDN line for a voice 

meeting.

• When a checkmark is put to “SIP” under “Line Interface” of the Line Interface 
setup menu, you can select “SIP” from the line interface select box.

• When “Use LAN2” is set to “On”, you can select “IP(2)” from the line interface 
select box.

3 Use the V, v, B or b button on the Remote Commander to select the 
number input box, then press the ENTER button.

4 Enter the remote party’s IP address or line number with the number buttons 
on the Remote Commander, then press the ENTER button.

The format of the address for a SIP connection is the following:
• 4000 (number assigned by the SIP server)
• 4000@sip.com
• 192.168.1.1 (when the IP address and SIP server are not used)

5 Press the CONNECT ( ) button on the Remote Commander. Or use the 
V, v, B or b button on the Remote Commander to select “Dial”, then press 
the ENTER button. 
The system begins dialing the IP address or telephone number entered in 
step 4. “Dialing” appears on the monitor screen.
When the system connects to the remote system, the message “Session 
Connected.” appears on the screen and the picture on the remote site is 
displayed. Now you can start communication with the remote party.

Notes

Note

Picture on the local site

Picture on the remote site
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To cancel dialing before connecting with the remote party
While “Dialing” is displayed on the monitor screen, press the DISCONNECT 
( ) button or the ENTER button on the Remote Commander.

When “One-Touch Dial” is set to “On” in the Home Menu setup menu, the 
one-touch dial buttons are displayed in the Home menu, allowing you to use 
the one-touch dial function.

For registration of the one-touch dial buttons, see “Registering a Remote 
Party – Phone Book” on page 121.

1 Open the Home menu.

2 Select the one-touch dial button for which the remote party you want to call 
is registered with one of the F1 to F4 buttons on the Remote Commander.
Or select the one-touch dial button you want to call in the Home menu by 
pressing the V, v, B or b button on the Remote Commander, then press the 
ENTER button. Select “Connect” from the displayed submenu with the V, 
v, B or b button, and press the ENTER button.

The system begins dialing the selected remote party. “Dialing” appears on 
the monitor screen. When the system connects to the remote system, 
“Session Connected.” appears on the screen and the picture on the remote 
site is displayed. Now you can start communication with the remote party.

To cancel dialing before connecting with the remote party
While “Dialing” is displayed on the monitor screen, press the DISCONNECT 
( ) button or the ENTER button on the Remote Commander.

Calling a Remote Party Using the One-Touch Dial Buttons

Detailed Dial

Camera

Tools

History

Phone Book

DialIP

Office EOffice ARoom 201

F2

Room 101

F1 F3 F4

5/11/2008 13:00IP:XXX.XXX.XXX.XXXAAA Ready

Home

One-touch dial buttons
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1 Use the V, v, B or b button on the Remote Commander to select “History” 
in the Home menu, then press the ENTER button. Or select “Connect” in 
the Home menu with the V, v, B or b button and the ENTER button to 
display the Connect menu, then select “Select from History”.
The History menu appears.

You can display the History menu by selecting “History” from the Phone Book or 
Detailed Dial menu.

2 Use the V, v, B or b button on the Remote Commander to select “Dial 
(outgoing call history)”, “Answer (incoming call history)” or “Missed Call 
(incoming call history in absence)”, then press the ENTER button or b 
button.
The selected history list appears.

3 Use the V, v, B or b button on the Remote Commander to select the remote 
party you want to call.

4 Press the CONNECT ( ) button on the Remote Commander. Or press 
the ENTER button to display the submenu, select “Connect” with the V, v, 
B or b button, and press the ENTER button.
The system begins dialing the selected party. “Dialing” appears on the 
monitor screen. When the system connects to the remote system, “Session 

Calling a Remote Party by Selecting Them in the History List

Note

Detailed Dial

History

Phone Book

IP:192.168.0.11

Home

5/11/2008 13:00

Missed Call

Answer

Dial Dial History1
 111.111.111.112 2008/05/01 00:00 (12:34:56)

Dial History2
 555-555-555 2008/05/26 00:00 (03:25:45)

Dial History3
 17.17.17.17 2008/05/26 00:00 (01:00:17)

Dial History4
 18.18.18.18 2008/05/26 00:00 (01:00:18)

Dial History5
 19.19.19.19 2008/05/26 00:00 (01:00:19)

Dial History6
 20.20.20.20 2008/05/26 00:00 (01:00:20)

Dial History7
 66.66.66.66 2008/05/26 00:08 (00:00:00)

Dial History8
 88.88.88.88 2008/05/26 00:08 (01:00:06)

Detailed Dial

History

Phone Book

IP:192.168.0.11

Home

5/11/2008 13:00

Missed Call

Answer

Dial Dial History1
 111.111.111.112 2008/05/01 00:00 (12:34:56)

Dial History2
 555-555-555 2008/05/26 00:00 (03:25:45)

Dial History3
 17.17.17.17 2008/05/26 00:00 (01:00:17)

Dial History4
 18.18.18.18 2008/05/26 00:00 (01:00:18)

Dial History5
 19.19.19.19 2008/05/26 00:00 (01:00:19)

Dial History6
 20.20.20.20 2008/05/26 00:00 (01:00:20)

Dial History7
 66.66.66.66 2008/05/26 00:08 (00:00:00)

Dial History8
 88.88.88.88 2008/05/26 00:08 (01:00:06)
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Connected.” appears on the screen and the picture on the remote site is 
displayed. Now you can start communication with the remote party.

To cancel dialing before connecting with the remote party
While “Dialing” is displayed on the monitor screen, press the DISCONNECT 
( ) button or the ENTER button on the Remote Commander.

You can select the items below from the submenu:
“Cancel”: Cancels selection from the history list.
“Edit”: Displays the List Edit menu for registration in the Phone Book.
“Delete”: Deletes the selected call from the history list.

For the registration in the Phone Book, see “Registering a Remote Party – 
Phone Book” on page 121.

1 Use the V, v, B or b button on the Remote Commander to select “Phone 
Book” in the Home menu, then press the ENTER button. Or select 
“Connect” in the Home menu with the V, v, B or b button and the ENTER 
button to display the Connect menu, then select “Select from Phone Book”.
The Phone Book appears on the monitor screen.

2 Use the V, v, B or b button on the Remote Commander to select the Group 
in which the remote party you want to call is registered, then press the 
ENTER button.

3 Use the V, v, B or b button on the Remote Commander to select the remote 
party you want to call.

4 Press the CONNECT ( ) button on the Remote Commander. Or press 
the ENTER button to display the submenu, select “Connect” with the V, v, 
B or b button, and press the ENTER button.

Note

Calling a Remote Party Registered in the Phone Book

Office ARoom 102Room 101

Office ERoom 202Room 201

ISDN 98-7654-3210IP 255.255.255.255ISDN 01-2345-6789

ISDN 01-2345-6789IP 123.456.789.012IP 0.0.0.0

Detailed Dial

History

New Entry

Group Edit

Phone Book

Group1

Default Group

Group2

Group3

Group4

Group5

Group6

Group7

Group8

Group9

Home
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The system begins dialing the selected party. “Dialing” appears on the 
monitor screen. When the system connects to the system on the remote site, 
the message “Session Connected.” appears on the screen, and the picture 
on the remote site is displayed.
Now you can start communication with the remote party.

To cancel dialing before connecting
While “Dialing” is displayed on the monitor screen, press the DISCONNECT 
( ) button or the ENTER button on the Remote Commander.

To switch the display in the Phone Book between the list and the 
thumbnails
Each time the F1 button on the Remote Commander is pressed, the display 
changes between the list and the thumbnails.

To change the order of display
Each time the F2 button on the Remote Commander is pressed, the display 
changes between the list of remote parties’ names in ascending alphabetical 
order and that list in descending alphabetical order.

To display the Phone Book during communication
Press the  button on the Remote Commander during communication.

To call a remote party registered in the Private Phone Book

1 Insert the USB storage device that contains the Private Phone Book into a 
USB port on the Communication System.
The Phone Book changes to the Private Phone Book.

2 Select “Private Phone Book” in the Home menu, and press the ENTER 
button.

3 Use the V, v, B or b button on the Remote Commander to select a remote 
party you want to call from the Private Phone Book.

4 Press the CONNECT ( ) button on the Remote Commander. Or press 
the ENTER button to display the submenu, select “Connect” with the V, v, 
B or b button, and press the ENTER button.

Room 101
ISDN 01-2345-6789

Detailed Dial

History

New Entry

Group Edit

Phone Book

Default GroupHome

Cancel

Edit

Copy

Delete

Connect
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If the auto dialing feature of the Private Phone Book is activated, the system begins 
dialing when the USB storage device is inserted.

1 Use the V, v, B or b button on the Remote Commander to select “Detailed 
Dial” in the Home menu, then press the ENTER button. Or select 
“Connect” in the Home menu with the V, v, B or b button and the ENTER 
button to display the Connect menu, then select “Enter Number/Address”.
The Detailed Dial menu appears on the screen.

2 Select the line interface to be used for connection.
Use the V, v, B or b button to select “Line I/F”, then press the ENTER 
button. The setting items appear. Press the V, v, B or b button to select the 
line interface to be used to connect to the remote party, then press the 
ENTER button.
IP: Connects to a remote party via a LAN connected to the 1 (LAN1) 

connector (  (LAN) connector on the PCS-XG77S).
ISDN: Connects to a remote party via an ISDN.
ISDN (2B): Connects to the H.221-format system via 2B channels of the 

ISDN connection.
TEL: Connects to the phone of a remote party to conduct a voice meeting 

via the ISDN connection.

• When a checkmark is put to “SIP” under “Line Interface” of the Line Interface 
setup menu, you can select “SIP” from “Line I/F”.

• When “Use LAN2” is set to “On”, you can select “IP(2)” from “Line I/F”.

3 Configure the LAN or ISDN line to be used for connection.
When using the LAN
1 Enter the IP address of a remote party to connect in the IP text box. 

Use the V, v, B or b button on the Remote Commander to select the IP 
text box, then press the ENTER button. Next, enter the IP address with 
the number buttons on the Remote Commander or the on-screen 
keyboard, and press the ENTER button.

Note

Calling a Remote Party Not Registered in the Phone Book

Notes

History

Detailed Dial

1Mbps

IP

Phone Book

Dial to:

Line I/F

Communication 
Bit Rate

1B (64K)Number of Lines

Home

SaveConnect Cancel
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Enter the host name and domain name (ex. host.domain) when using 
the DNS server, or enter the party’s user name and user number 
registered in the LAN setup menu on the remote party’s system when 
using the gatekeeper, then press the ENTER button.

• When “Internet Protocol” is set to “IPv4” in the Administrator setup menu, 
you can enter a dot (.) with the b or DOT button.

• When “Internet Protocol” is set to “IPv6” or “IPv4/IPv6” in the 
Administrator setup menu, you can enter a colon (:) with the b or DOT 
button.
When “IPv4/IPv6” is specified, only colons can be entered with the b button. 
When “IPv4/IPv6” is specified and you are calling using IPv4, press the DOT 
button twice to enter a dot.

• To delete the last entered character, use the BACK SPACE button on the 
Remote Commander or “Back Space” on the on-screen keyboard.

• To delete the entered IP address, use the RETURN button on the Remote 
Commander or “Cancel” on the on-screen keyboard.

• “IPv4/IPv6” for “Internet Protocol” will be supported in version 2.0.

2 Select the communication bit rate.
Use the V, v, B or b button to select “Communication Bit Rate”, then 
press the ENTER button. Press the V, v, B or b button to select the 
communication bit rate from the displayed submenu, then press the 
ENTER button.

When using the ISDN
1 Enter the telephone number of a remote party to connect in the A text 

box.
Use the V, v, B or b button on the Remote Commander to select the A 
text box, then press the ENTER button. Next, enter the telephone 
number with the number buttons on the Remote Commander or on-
screen keyboard, and press the ENTER button.

• Do not enter the prefix number in the telephone number text box, when the prefix 
setting is on. For details on prefix settings, see “Dial Setup Menu” on page 62.

• Even when you connect multiple ISDN lines (2B (128K) or more number of 
lines), entering one telephone number of the remote party enables you to connect 
all the lines used automatically.

• When you select ISDN (2B (128K)), the A1 and A2 text boxes appear. You can 
enter a separate ISDN line number in each text box. Pressing the ENTER button 
on the Remote Commander while the A2 text box is selected copies the number 
entered in the A1 text box to the A2 text box.

• To delete the last entered character, use the BACK SPACE button on the Remote 
Commander or “Back Space” on the on-screen keyboard.

• To delete the entered ISDN telephone number, use the RETURN button on the 
Remote Commander or “Cancel” on the on-screen keyboard.

Notes

Notes
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2 Select the number of ISDN lines to use during the call.
Use the V, v, B or b button on the Remote Commander to select 
“Number of Lines”, then press the ENTER button. Press the V, v, B or 
b button to select the number of channels to be used when calling a 
remote party from the displayed items, then press the ENTER button.

To connect to the remote party by entering all the telephone numbers for the 
ISDN lines used
If the system of the remote party is not equipped with the bonding function, entering 
one remote party’s telephone number does not allow automatic connection of 
multiple ISDN lines used to connect to the remote party. To connect to the remote 
party by entering all the telephone numbers, register the remote party’s telephone 
numbers for the ISDN lines to be used referring to “Registering a Remote Party – 
Phone Book”(page 121), then connect to the remote party according to the 
procedure described in “Calling a Remote Party Registered in the Phone Book” 
(page 113).

4 Press the CONNECT ( ) button on the Remote Commander, or use the 
V, v, B or b button to select “Connect” in the lower part of the menu, then 
press the ENTER button on the Remote Commander.
The system begins dialing the IP address or ISDN telephone number 
entered in step 3. “Dialing” appears on the monitor screen.
When the system connects to the remote system, the message “Session 
Connected.” appears on the screen, and the picture on the remote site is 
displayed. Now you can start communication with the remote party.

To cancel dialing before connecting
While “Dialing” is displayed on the monitor screen, press the DISCONNECT 
( ) button or the ENTER button on the Remote Commander.

To save the entered IP address or ISDN telephone number in the 
Phone Book
When you enter the IP address or ISDN telephone number, the Save button 
appears at the lower part of the menu.
Select “Save” with the V, v, B or b button, then press the ENTER button on 
the Remote Commander. The List Edit menu is displayed. Save the address or 
number you entered into the Phone Book.

For details on the List Edit menu, see “Registering a Remote Party – Phone 
Book” on page 121.

Redial function
Once you have input the IP address or ISDN telephone number using the 
Detailed Dial menu, it will be entered in the text box of the Detailed Dial menu 
the next time you open the menu.

The redial function is not available: 
• Once you have turned off the power of the system or set it to standby mode.
• When you cancel dialing the entered IP address or ISDN telephone number.

Note

Note
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Receiving a Call from a Remote Party
Operations for answering a call differ depending on the setting of the answer 
mode.

The unit is set to manual answer mode under factory default settings.

Manual answer mode
When there is an incoming call, the Communication System rings. You need 
to connect the call manually. 
You can start connecting when you are ready.

Auto answer mode
The system automatically receives a call from a remote party and you can start 
connecting. Although no operation is necessary to start, the picture on the local 
site will be displayed on the remote site screen even if you are not ready to 
begin.

• You cannot answer the call unless the power switch on the Communication System is 
on.

• Make sure that the TV monitor is turned on.

For setting of the answer mode, see “Auto Answer” in the Answer setup menu 
on page 63.

To receive a call in manual answer mode

When you receive a call, the Communication System rings and the message 
“Incoming call. Answer?” appears on the monitor screen. 

Press V, v, B or b to select “OK”, then press the ENTER button. The system 
is then connected. Once the connection is made, the picture of the remote party 
is displayed on the local monitor screen and the sound is heard. The picture and 
sound on the local site will be enabled on the remote site at the same time.
The message “Session Connected.” appears on the monitor screen.
You are now ready to start a communication.

See pages 132 to 142 to adjust the sound and picture during communication.

Note

Answering Calls (Manual/Auto Answer Mode)

Notes

Answering a Call from a Remote Party

Note
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When you do not want to answer the call
Press V, v, B or b to select “Cancel”, then press the ENTER button. Ringing 
stops, and the connection is canceled.

To answer a call in auto answer mode

When you receive a call, the Communication System rings and the message 
“Answering...” appears on the monitor screen. The system is automatically 
connected and the picture of the remote party is displayed on the local monitor 
screen and the sound is heard. The picture and sound on the local site will be 
enabled on the remote site at the same time.
The message “Session Connected.” appears on the monitor screen.
You are now ready to start communication.

See pages 132 to 142 to adjust the sound and picture during communication.

When the system fails to make an ISDN connection

If the system fails to connect to the remote party, the message “Cannot 
complete connection. (an ISDN cause code and a message are displayed here)” 
appears on the monitor screen.

For details on ISDN cause codes and messages, see “On-Screen Messages” 
on page 243.

Note

Picture on the remote site

Picture on the local site
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Ending the Connection
1 Press the DISCONNECT ( ) button on the Remote Commander.

The message “Disconnect?” appears on the monitor screen.

2 Press the DISCONNECT ( ) button on the Remote Commander again, 
or press the V, v, B or b button on the Remote Commander to select “OK”, 
then press the ENTER button.
The system is disconnected.

The power of the Communication System remains on even if the system is 
disconnected.

To cancel disconnection of the system
Select “Cancel” with the V, v, B or b button on the Remote Commander, then 
press the ENTER button.

To register the connected remote party in the Phone Book

You can easily register the remote party who has just disconnected.
If you set “Last Number Registration” to “On” on the Device Setup page of the 
General setup menu, the message “Register this participant in the list?” 
appears after a communication with an unregistered remote party is finished. 
When you select “OK”, the List Edit menu appears.

If the “Last Number Registration” is set to “Off”, the message does not appear.

For “Last Number Registration” setting, see “General Setup Menu” on page 
81.

Note

Note
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Registering a Remote Party – Phone 
Book

You can register the telephone number or IP address of a remote party in the 
Phone Book, allowing you to dial the party very easily.
Up to 1000 remote parties can be registered in the Phone Book. You can also 
store a still image such as a participant’s portrait in the index list.
You can also create a Private Phone Book on a USB storage device separately 
from the Phone Book in the Communication System.

1 Use the V, v, B or b button on the Remote Commander to select “Phone 
Book” in the Home menu, then press the ENTER button. Or select 
“Connect” in the Home menu with the V, v, B or b button and the ENTER 
button to display the Connect menu, then select “Select from Phone Book”.
The Phone Book opens.

The Phone Book can be displayed by selecting “Phone Book” in the History or 
Detailed Dial menu.

2 Use the V, v, B or b button on the Remote Commander to select “New 
Entry”, then press the ENTER button.
The List Edit menu appears.

Registering a New Remote Party

Note

Shared Phone Book

Find Name by First Initial

Detailed Dial

History

New Entry

Group Edit

Phone Book > Default Group

5/11/2008 13:00IP:192.168.0.11

Home Default Group
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3 Set the items in the List Edit menu.
Use the V, v, B or b button and the ENTER button on the Remote 
Commander to select the setup item.
To enter the characters, use the number buttons on the Remote Commander 
or the displayed on-screen keyboard, and press the ENTER button. To 
select the item, use the V, v, B or b button and press the ENTER button.

Index
Enter the name of a remote party in the Index text box. You can use up to 
39 letter and number characters.

Group Select
Select the group set in the Phone Book.

Dial to:
Enter the IP address or line number of a remote party depending on the line 
interface you select.
When you select “IP” from “Line I/F”: Enter the remote party’s IP 

address. Enter the host name and domain name (ex. host.domain) when 
using the DNS server, or enter the party’s user name and user number 
when using the gatekeeper (page 75).

When you select “ISDN” from “Line I/F”: Enter the remote party’s line 
number. If you register the sub-address in the Phone Book, enter an 
asterisk between the line number and sub-address. The sub-address can 
only be composed of numbers.
When “More Options Enable” is set to “On” in the Dial setup menu 
(page 62), six line input text boxes, A1, A2, B1, B2, C1 and C2, are 
displayed. Be sure to enter the remote party’s number to the A1 text 
box.

When you select “TEL” from “Line I/F”: Enter the telephone number of 
a remote party. (ex. 0390123456)

When you select “SIP” from “Line I/F”: Enter the address of a remote 
party or the number assigned by the SIP server.
The format of the address is the following:
• 4000 (number assigned by the SIP server)
• 4000@sip.com
• 192.168.1.1 (when the IP address and SIP server are not used)

Phone Book

IP

Group Select

One-Touch Dial 
Specified

Line I/F

Communication 
Bit Rate

Dial to:

Index

None Specified

None Specified

IP

1Mbps

Number of Lines 2B (128K)

CancelSaveMore Options
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Icon/Image
Select the icon or a still image stored on a USB storage device to be 
displayed on the Phone Book.

You cannot select a still image unless a USB storage device on which still images 
are stored is inserted.

One-Touch Dial Specified
Select whether to display the one-touch dial buttons in the Home menu. 
Assign the F1, F2, F3 or F4 function button on the Remote Commander to 
each one-touch dial button.

Line I/F
Select the line interface you are using to connect to a remote party. Select 
from among IP, ISDN, TEL and SIP. Selecting any interface switches the 
setting items in the List Edit menu.

• When a checkmark is put to “SIP” under “Line Interface” of the Line Interface 
setup menu, you can select “SIP” from “Line I/F”.

• When “Use LAN2” is set to “On”, you can select “IP(2)” from “Line I/F”.

Communication Bit Rate
Select the communication bit rate when you select “IP” or “SIP” with 
“Line I/F”.

Number of Lines
Select the number of ISDN channels to be used when you select “ISDN” 
with “Line I/F”.

Auto Dial
Set this item only for the Private Phone Book (page 127). Setting “Auto 
Dial” to “On” allows you to automatically dial one of the lists in the Private 
Phone Book simply by inserting the USB storage device on which the 
Private Phone Book is registered.

4 Use the V, v, B or b on the Remote Commander to select “Save”, then 
press the ENTER button.
The settings are registered in the Phone Book.

When a connection with a remote party not registered in the Phone Book is terminated, 
you can register this remote party to the Phone Book. In this case, the IP address or line 
number is shown in “Index” as the name of the remote party. Modify it if necessary.

Note

Notes

Note
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To connect to the remote party without using bonding

If the system of the remote party is not equipped with the bonding function, 
entering one telephone number does not allow you to connect all the line 
numbers used to connect to the remote party. To connect to the remote party 
by entering all the ISDN line numbers used, you can set the connection without 
using the bonding function of this system. 
When you set “More Options Enable” to “On” in the Dial setup menu (page 
62), the A1, A2, B1, B2, C1 and C2 text boxes appear in the List Edit menu. 
Enter all the telephone numbers for the ISDN lines selected by “Number of 
Lines”.
 

When you set “Number of Lines” to “2B”, you can connect to the remote party by 
selecting “ISDN (2B)” from “Line I/F” in the Detailed Dial menu.

To set up more detailed options

When “More Options Enable” is set to “On” in the Dial setup menu, the More 
Options button is shown at the lower part of the List Edit menu.
Select the More Options button with the V, v, B or b button on the Remote 
Commander and press the ENTER button to open a menu for more detailed 
dial settings. You can change the settings of the desired items.

The contents set with the More Options button have priority over those set in the Dial 
setup menu.

You can edit the telephone number, IP address, name or setting registered in 
the Phone Book.

1 Open the Phone Book.

2 Use the V, v, B or b button on the Remote Commander to select the remote 
party to be modified, then press the ENTER button.
The submenu appears.

3 Press the V, v, B or b button on the Remote Commander to select “Edit”, 
then press the ENTER button.
The List Edit menu appears.

Note

Note

Editing the Contents of the Phone Book

Cancel

Delete

Copy

Edit

Connect
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4 Modify the telephone number, IP address, name or setting.

5 Use the V, v, B or b button on the Remote Commander to select “Save”, 
then press the ENTER button.
The modification is completed.

1 Open the Phone Book.

2 Use the V, v, B or b button on the Remote Commander to select the remote 
party to be copied, then press the ENTER button.
The submenu appears.

3 Press the V, v, B or b button on the Remote Commander to select “Copy”, 
then press the ENTER button.
The items for the selected party are copied, and the name is followed by “–
2”. You can use the setting after modifying the necessary items.

1 Open the Phone Book.

2 Use the V, v, B or b button on the Remote Commander to select the remote 
party to be deleted from the Phone Book, then press the ENTER button.
The submenu appears.

3 Press the V, v, B or b button on the Remote Commander to select 
“Delete”, then press the ENTER button.
The message “Delete Entry?” appears.

4 Use the V, v, B or b button on the Remote Commander to select “OK”, 
then press the ENTER button.
The selected party is deleted.

To cancel deleting
Select “Cancel” in step 4, then press the ENTER button.

You can create groups into which the registered remote parties are grouped. 

To register a new group

1 Open the Phone Book.

Copying a Registered Party in the Phone Book

Deleting the Registered Remote Party

Creating a Group in the Phone Book (Group Edit)
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2 Use the V, v, B or b button on the Remote Commander to select “Group 
Edit”, then press the ENTER button.
The Phone Book > Group Edit menu appears.

3 Use the V, v, B or b button on the Remote Commander to select “New 
Entry”, then press the ENTER button.
The group name input menu appears.

4 Enter the group name using the number buttons on the Remote 
Commander and the on-screen keyboard, then press the ENTER buttons.
You can use the alphabetical letters, numbers and symbols.

5 Use the V, v, B or b button on the Remote Commander to select “Save”, 
then press the ENTER button.
The registered group button is displayed.

Phone Book > Group Edit

New Entry

Previous

Phone Book > Group Edit

New Entry

Previous

Group Edit

Cancel

Phone Book > Group Edit

Previous

New Entry

TOKYO TOKYO
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6 Use the V, v, B or b button on the Remote Commander to select 
“Previous”, then press the ENTER button.
The Phone Book is restored.

To modify the group name

1 Open the Phone Book > Group Edit menu, select the group button you 
want to modify using the V, v, B or b button on the Remote Commander, 
and press the ENTER button.
The submenu appears.

2 Use the V, v, B or b button on the Remote Commander to select “Edit”, 
then press the ENTER button.
The group name input menu appears.

3 Modify the group name using the number buttons on the Remote 
Commander and the on-screen keyboard, then press the ENTER buttons.

4 Use the V, v, B or b button on the Remote Commander to select “Save”, 
then press the ENTER button.
The modified group button is displayed in the Phone Book > Group Edit 
menu.

• You can operate the following with a submenu in the Group Edit menu.
“Cancel”: Cancels selection of the group button.
“Delete”: Deletes a group in which no party is registered.

• You cannot delete a group button for which any remote parties are registered.

You can create your own Phone Book (Private Phone Book) on a USB storage 
device. Once the Private Phone Book is registered, inserting the USB storage 
device into the Communication System changes the Phone Book to the Private 
Phone Book. You can also activate the Auto Dial feature, allowing you to 
automatically start dialing one of the remote parties registered in the Private 

Notes

Phone Book > Group Edit

Previous

New Entry

TOKYO Cancel

Edit

Delete

Creating a Private Phone Book
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Phone Book simply by inserting the USB storage device.

To register a new remote party in a Private Phone Book

1 Insert the USB storage device on which you want to register a remote party 
into the USB port on the Communication System.
Insert the USB storage device in the direction of the arrow with the mark 
facing upward.

2 Open the Phone Book page in the Administrator setup menu.

For how to open the menu, see “Registering Local Information” on page 
58.

3 Select “Create Private Phone Book”.
An empty folder and file for a Private Phone Book are created on the USB 
storage device.

4 Register a new remote party.
The procedure is the same as that for registering in the Phone Book. 
Proceed with steps 2 to 4 in “Registering a New Remote Party” on page 
121. 

The procedures for how to edit the contents of the Private Phone Book, 
how to delete the registered remote party, or how to copy one of the 
registered parties in the Private Phone Book are the same as those for the 
Phone Book. Open the Private Phone Book and proceed with the steps 
described on pages 124 to 125.

Setup Phone BookAdministrator

Load Phone Book

Clear Phone Book

Save Phone Book

Auto Dialing

Create Private Phone Book

Delete Private Phone Book

Copy to Private Phone Book

Execute

Cancel

Execute

Execute

On

Execute

Execute

Execute

Administrator8
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To copy all the contents of the Phone Book to the Private Phone Book

Insert the USB storage device on which you want to store the Private Phone 
Book into the USB port on the Communication System, then select “Copy to 
Private Phone Book” in the Administrator setup menu. All the data registered 
in the Phone Book is copied to the inserted USB storage device.

To delete the Private Phone Book from the USB storage device

Insert the USB storage device from which you want to delete the registered 
Private Phone Book into the USB port on the Communication System, then 
select “Delete Private Phone Book” on the Phone Book page in the 
Administrator setup menu. All the data is deleted from the inserted USB 
storage device.

To dial a specified remote party in a Private Phone Book automatically

If you set “Auto Dialing” in the Administrator setup menu to “On”, you can 
automatically dial one of the registered remote parties in the Private Phone 
Book simply by inserting the USB storage device on which the Private Phone 
Book is registered.

1 Open the Private Phone Book.

2 Use the V, v, B or b button on the Remote Commander to select the remote 
party to dial automatically, then press the ENTER button.

3 Press the V, v, B or b button on the Remote Commander to select “Edit”, 
then press the ENTER button.
The List Edit menu appears.

4 Use the V, v, B or b button on the Remote Commander to select “Auto 
Dialing”, then press the ENTER button.
The setting is registered and “AUTO” appears in the Private Phone Book.

Using the Shared Phone Book function enables multiple Sony Visual 
Communication Systems to access to a Phone Book located on a server.

For detailed configuration, consult your network administrator.

• You can dial a remote party registered in the Shared Phone Book in the same manner 
as with the Phone Book. However, you cannot dial a remote party registered in a 
multipoint connection list.

• You cannot register a new party, delete a registered party, attach an image, or edit the 
Shared Phone Book. In addition, you cannot copy the remote parties registered in the 

Using the Shared Phone Book

Notes
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Shared Phone Book to the Private Phone Book.

System configuration example

In this system configuration, sharing of a Phone Book using H.350 is enabled.

Using the Shared Phone Book

Check that “SPB Mode” is set to “On” in the Shared Phone Book setup menu, 
and enter appropriate values for “SPB Server Address” and “SPB Server 
Password”.

When “SPB Mode” is set to “On”, the Shared Phone Book menu button 
appears on the screen.

Directory server

H.350/LDAP

Shared Phone 
Book server

Setup Shared Phone Book

SPB Mode

SPB Server Address

SPB Server Password

On

CancelSave

Shared Phone Book
130 Registering a Remote Party – Phone Book



C
hapter 3: B

asic C
onnection
To display the Shared Phone Book
Select “Shared Phone Book” in the Phone Book, and press the ENTER button. 
The display switches to the Shared Phone Book.

To restore the Phone Book, select “Phone Book” in the menu, and press the 
ENTER button.
The procedure for dialing the registered remote party in the Shared Phone 
Book is the same as that for the Phone Book. 

For details on dialing, see “Calling a Remote Party Registered in the Phone 
Book” on page 113.

Room 102Room 101
IP 255.255.255.255ISDN 01-2345-6789

Detailed Dial

History

New Entry

Group Edit

Phone Book

Phone Book

Home Default Group
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Adjusting the Sound

You can adjust the volume of the sound to be received from a remote party.
Press the VOLUME + button on the Remote Commander to increase the 
volume, VOLUME – button to decrease it. The volume level indicator appears 
on the monitor screen. The indicator will automatically disappear if you do not 
operate the buttons for a certain time.

• You need to set the volume of the TV monitor to an appropriate level first.
• If feedback or distortion caused by increasing the volume occurs, decrease the 

volume.

You can momentarily turn off the sound to be sent to the remote party during 
communication.
Press the MIC ON/OFF button on the Remote Commander. 
The sound of the local party is not heard by the remote party. The  
indicator appears on the monitor screen of the local site.
The  indicator appears on the monitor screen of the remote site, 
indicating that the sound of the local party is not transmitted.

To restore the sound
Press the MIC ON/OFF button again.
The  indicator on the local site and the  indicator on the remote 
site disappear and the sound is heard by the remote party.

Adjusting the Volume of the Received Sound

Notes

Turning Off the Sound Momentarily – Muting Function

11

NEAR

NEAR
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You can turn off the sound to be sent to a remote party when you have 
answered a call from the remote party.
If you set “Mic on Answer” to “Off” in the Answer setup menu, only the 
picture on the local party will be sent to the remote party when answering a 
call. The  indicator appears on the monitor screen.

For the setting, see “Mic on Answer” in the Answer setup menu on page 63.

To send the sound to the remote party
Press the MIC ON/OFF button on the Remote Commander.
The  indicator disappears and the sound is heard by the remote party.

During the communication a time lag may occur between the sound and 
picture to be sent to the remote party, which prevents smooth communication.
Using the Lip Sync function adjusts to synchronize audio and video. However, 
this may delay transmission of audio synchronized with video.
The Lip Sync function is enabled if you set “Lip Sync” to “Auto” on the Basic 
Setup1 page in the Audio setup menu.

For the setting, see “Lip Sync”in the Audio setup menu on page 69.

To enable the Lip Sync function of the remote party, you have to ask them to do so.

The Communication System is equipped with the echo canceller function, 
allowing the echo that occurs during audio transmission to be reduced.
Setting “Echo Canceller” to “On” on the Basic Setup1 page in the Audio setup 
menu activates the built-in echo canceller.
When using an external echo canceller, set “Echo Canceller” to “Off”.

For details on the setting, see “Echo Canceller” in the Audio setup menu on 
page 69.

Turning Off the Sound on Answering – Mic on Answer Function

Synchronizing Audio and Video – Lip Sync Function

Note

Reducing Echo – Echo Canceller

NEAR

NEAR
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Connection example for using an external echo canceller

For details on connecting the external echo canceller, refer to the operating 
instructions for the echo canceller you are using.

to AUDIO 1 IN

External echo canceller

External microphone mixer
PCS-A1 Microphone
(not supplied)

Speaker

to AUDIO OUT

LINE
IN

LINE 
OUT

HD Camera Unit PCSA-CXG100 
(not supplied)
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Adjusting the Camera
You can adjust the image shot by the local camera that is sent to the remote 
party to obtain the desired angle and size.
During communication you can also control the camera on the remote site to 
adjust the image shot by the remote camera.

Determine the angle of view and the size of the picture to be displayed on the 
monitor screen by adjusting the angle and zoom.

1 Press the CAMERA button on the Remote Commander, or press the V, v, 
B or b button to select “Camera” in the Home menu and press the ENTER 
button.
The Camera menu appears.

2 Select the camera to be adjusted.
During communication pressing the F1 button on the Remote Commander 
switches between the camera on the local site and that on the remote site.
When two cameras are connected, pressing the F2 button on the Remote 
Commander switches between the first and second cameras.
The selected camera is shown at the top of the Camera menu.

3 Use the V, v, B or b button on the Remote Commander to select 
“Adjustments”, then press the ENTER button.
The Adjustments menu appears.

Adjusting the Camera Angle and Zoom

Details

Previous

Adjustments

Brightness

Preset

Camera

5/11/2008 13:00
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4 Adjust the camera angle so that the desired angle of view is obtained with 
the V, v, B or b button on the Remote Commander.
The selected camera pans and tilts, then the adjusted picture will be 
displayed in the small window or in full screen.

5 Use the ZOOM button on the Remote Commander to zoom in or out.
Press the T (Telephoto) button to zoom in and the W (Wide angle) button 
to zoom out.

For details on digital zoom, see “To use the digital zoom function” on page 
141.

To control the remote camera
• To control the remote camera, set “Far End Camera Control” (page 67) to 

“On” in the Communication setup menu for both the local and remote sites. 
If this setting is not configured properly, you will not be able to control the 
remote camera.

• You cannot control the remote camera during a session if the remote control 
format of the remote camera is not H.281. If you cannot control the remote 
camera, ask the remote party about the remote control format of his camera.

• If the local and remote parties try to control the same camera at the same 
time, the camera may not operate correctly.

Normally, the brightness is automatically adjusted to obtain optimum levels. 
You can also adjust it manually.
It is recommended that the brightness be adjusted automatically to obtain 
optimum brightness.

To adjust the brightness manually

1 Press the CAMERA button on the Remote Commander, or press the V, v, 
B or b button to select “Camera” in the Home menu and press the ENTER 
button.

Adjusting the Brightness

Adjustments > Camera Angle

Local Camera : First Camera
T

W

Zoom indicatorPan/tilt indicator
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The Camera menu appears.

2 Select the camera to be adjusted.
During communication pressing the F1 button on the Remote Commander 
switches between the camera on the local site and that on the remote site.
When two cameras are connected, pressing the F2 button on the Remote 
Commander switches between the first and second cameras.
The selected camera is shown at the top of the Camera menu.

3 Use the V, v, B or b button on the Remote Commander to select 
“Brightness”, then press the ENTER button.
The Brightness adjustment menu appears.

4 Press the ENTER button on the Remote Commander.

5 Use the V, v, B or b button on the Remote Commander to select “Manual 
Adjustment”, then press the ENTER button.
The brightness adjustment bar is selected.

Details

Previous

Adjustments

Brightness

Preset

Camera

5/11/2008 13:00

Adjustments > Brightness

Auto Adjustment

Previous

5/11/2008 13:00
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6 Use the V, v, B or b button on the Remote Commander to adjust the 
brightness of the screen.
Pressing the b button increases the brightness, and pressing the B button 
decreases it.

The settings for local or remote camera angle and zoom can be registered in 
the preset memory. Once you have stored the settings, you can easily recall 
them to move the camera.
Up to 100 settings can be registered for the local camera and up to 6 settings 
for the remote camera.

To register the preset setting

1 Press the CAMERA button on the Remote Commander, or press the V, v, 
B or b button to select “Camera” in the Home menu and press the ENTER 
button.
The Camera menu appears.

2 Select the camera whose angle and zoom setting you want to preset.
During communication pressing the F1 button on the Remote Commander 
switches between the camera on the local site and that on the remote site.

Using the Preset Function

Adjustments > Brightness

Manual Adjustment

Previous

5/11/2008 13:00

Brightness adjustment bar

Details

Previous

Adjustments

Brightness

Preset

Camera

5/11/2008 13:00
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When two cameras are connected, pressing the F2 button on the Remote 
Commander switches between the first and second cameras.
The selected camera is shown at the top of the Camera menu.

3 Use the V, v, B or b button on the Remote Commander to select “Preset”, 
then press the ENTER button.
The Preset Setting List appears.

4 Use the V, v, B or b on the Remote Commander to select “New Entry”, 
then press the ENTER button.
The Preset Save menu appears.

5 Use the V, v, B or b button on the Remote Commander to select “Preset 
Number”, then select the number to which the setting is stored.
Only the numbers that have not been used for presetting are selectable.

6 Use the V, v, B or b button on the Remote Commander to select 
“Adjustments” under “Camera Angle”, then press the ENTER button, if 
you want to adjust the camera zoom and angle.
The Adjustments menu is displayed and you can adjust the zoom and 
angle.

For the adjustment procedures, see “Adjusting the Camera Angle and 
Zoom” on page 135.

7 After the adjustment is finished, press the RETURN button or the ENTER 
button on the Remote Commander.
The Preset Save menu is restored.

New Entry

Back to Home

Adjustments > Preset Setting List

Local Camera : First Camera

1 2 3

4 5 6

Save

Adjustments

1

Cancel

Preset Number

Camera Angle

Thumbnails Register in Thumbnail/List

Adjustments > Preset Save
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8 When you want to register a thumbnail, use the V, v, B or b button on the 
Remote Commander to select “Thumbnails” and press the ENTER button 
to check the checkmark for “Register in Thumbnail/List”. 

9 Use the V, v, B or b button on the Remote Commander to select “Save”, 
then press the ENTER button.
The angle and zoom settings are stored in the selected number, and the 
preset number is listed in the Preset Setting List.

To move the camera to the preset position

1 Press the CAMERA button on the Remote Commander, or press the V, v, 
B or b button to select “Camera” in the Home menu and press the ENTER 
button.
The Camera menu appears.

2 Use the V, v, B or b button on the Remote Commander to select “Preset” 
in the Camera menu, then press the ENTER button.
The Preset Setting List appears.

3 Use the V, v, B or b button on the Remote Commander to select the preset 
number you want to recall, then press the ENTER button.
You can also recall the preset numbers 1 to 6 by pressing the number 
buttons 1 to 6 on the Remote Commander.
The submenu appears.

4 Press the V, v, B or b button on the Remote Commander to select “Load”, 
then press the ENTER button.
The camera moves to the selected preset position.

You can select the items below from the submenu:
“Cancel”: Cancels selection of the preset position.
“Edit”: Changes the selected preset position.
“Delete”: Deletes the selected preset position.

Note

New Entry

Back to Home

1 2 3

4 5 6

Adjustments > Preset Setting List

Local Camera : First Camera
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When you select “Details” in the Camera menu, the more detailed setup menu 
opens. You can adjust various items for camera adjustment.

The “WIDE D” setting can only be configured when an SRG-120DH Camera Unit is 
connected. It is not available when other camera unit models are connected.

To use the digital zoom function 

Set “Digital Zoom” to “On”.

To use backlight compensation function

When the subject is shot with a bright background, set “Backlight” to “On”. 
The backlight compensation is activated and you can obtain a bright picture.

To adjust the white balance

Set the white balance depending on the shooting location.
Auto: Adjusts the white balance automatically.
Indoor: Select when shooting the subject indoors.
Outdoor: Select when shooting the subject outdoors.
ONE PUSH: Select when adjusting the white balance by shooting a white 

object in the center of the screen. 

To adjust the focus automatically

Select “Auto” in the Focus drop-down list and press the ENTER button. The 
focus is automatically adjusted.

To adjust the focus manually

1 Select “Manual” in the Focus drop-down list.

2 Select “Focus Adjustment” and press the ENTER button.

Adjusting the Camera in the Detailed Setup Menu

Note

Digital Zoom

Backlight

White Balance

Focus

Focus Adjustment

On

On

OK

Auto

Auto

WIDE D Off

Shutter Speed Auto
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3 Adjust the focus using the V, v, B or b button on the Remote Commander.
To focus on a distant subject, press the b button.
To focus on a near subject, press the B button.

To use wide dynamic range mode

Wide dynamic range mode differentiates between the dark and light areas 
within a single captured scene, and brightens the dark areas while reducing 
flared highlights in the light areas.
When using wide dynamic range mode, set “WIDE D” to “Low”, “Mid”, or 
“High” based on the shooting environment. To disable wide dynamic range 
mode, set “WIDE D” to “Off”.

• The “WIDE D” setting can only be configured when an SRG-120DH Camera Unit is 
connected.

• To set “WIDE D” to “Low”, “Mid”, or “High”, you must set “Brightness” to “Auto 
Adjustment” and “Shutter Speed” to “Auto”.

To set the shutter speed

To adjust the shutter speed automatically, set “Shutter Speed” to “Auto”. To 
fix the shutter speed, set “Shutter Speed” to “1/100”.

Notes
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Selecting the Input Picture and Sound
You can switch the picture displayed on the monitor screen, and switch 
between the input picture and audio.

When the displayed picture on the monitor can be switched during 
communication, pressing the LAYOUT button on the Remote Commander 
displays the indication “F1: Switches the monitored picture between the 
remote and local sites.” at the bottom of the monitor.
Each press of the F1 button on the Remote Commander switches the displayed 
picture between those on the local and remote sites.

1 Press the VIDEO INPUT button on the Remote Commander.
The Video Input > Near menu appears.

2 Use the V, v, B or b button on the Remote Commander to select the video 
input on the local site, then press the ENTER button.
The picture input from the selected equipment is displayed on the monitor 
screen.

CAMERA: Selects the picture from the camera connected to the 
CAMERA connector.

HDMI: Selects the picture from the equipment (second camera, etc.) 
connected to the HDMI IN connector.

DVI-I 1: Selects the picture from the equipment connected to the DVI-I 1 
IN connector.

DVI-I 2: Selects the picture from the equipment connected to the DVI-I 2 
(PC) IN jacks. 

The “HDMI” setting is not available on the PCS-XG77S.

Switching the Displayed Picture between the Local and Remote 
Pictures

Selecting the Input Picture

Note

Save Cancel

DVI-I 2DVI-I 1HDMICAMERA

Video Input > Near
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3 To store the selected input in the memory of the system, use the V, v, B or 
b button on the Remote Commander to select “Save”, then press the 
ENTER button.
The Video Input menu disappears.
The stored video input is not deleted even after the system is turned off, and 
is selected when the power is turned on again.

To change the video input name displayed in the Video Input menu

You can label the desired name for each video input on the Custom Input Label 
page in the Video setup menu. When you switch the video input in step 2 
above, the name you set is displayed in the Video Input menu.
For example, you can label: Camera1, Camera2, None, etc.

For details, see“Custom Input Label” in the Video setup menu on page 72.

If you assign the video input (Camera, HDMI, DVI-I 1 or DVI-I 2) to any of 
the F1 to F4 buttons on the Remote Commander in “Function Keys in 
Communication” of the General setup menu, you can quickly switch the video 
input only by pressing one of the F1 to F4 buttons.

The “HDMI” setting is not available on the PCS-XG77S.

For details, see “Function Keys in Communication” in the General setup 
menu on page 83.

You can switch the sound sent to the remote party between the sound from the 
microphone and that from the connected equipment. Use “Audio Input” in the 
Audio setup menu.

For details, see “Audio Input” in the Audio setup menu on page 68.

Set “Link to Audio Input” to “On” on the Link to Mic page of the Video setup 
menu. When you switch the video input, the audio input automatically 
switches to the one which has been set to link to the switched video input.

For details, see“Link to Audio Input” in the Video setup menu on page 72.

Selecting the Video Input Using the F1 to F4 (Function) Buttons on 
the Remote Commander

Note

Switching the Sound to Be Sent to the Remote Party

Switching Video and Audio at the Same Time
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You can switch the picture output from the remote system during 
communication.
Press the VIDEO INPUT button, then F1 button on the Remote Commander. 
The Video Input > Far menu appears.

Use the V, v, B or b button on the Remote Commander to select the picture 
output from the equipment connected to the remote system, then press the 
ENTER button. The selected picture is input to the local system and is 
displayed on the monitor screen.

You can only select the picture that can be output from the remote system. 

Switching the Picture from the Remote System

Note

Save Cancel

Sub Document CameraDocument CameraSub Camera

CAMERA

Video Input > Far

DVI-I 2DVI-I 1HDMI
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Switching the Picture Displayed on the 
Monitor Screen

You can display the pictures on the local and remote sites on the monitor 
screen at the same time. This enables you to check how your own party is 
monitored on the remote site.

1 Press the LAYOUT button on the Remote Commander.
The Layout menu appears.

2 Use the V, v, B or b button on the Remote Commander to select one of the 
screen display patterns, then press the ENTER button.
You can select from among the following eight patterns:
Full: Displays the remote picture in full screen.
PandP: Displays the remote picture on the left of the screen in large size 

and the local picture on the right in small size. (If a computer is 
connected to the system, the computer screen will appear at the bottom 
right.)

Side by Side: Displays the remote and local pictures side by side.
PinP: Displays the local window picture in the remote full picture.

You can select the location of the window picture from among five 
patterns.

3 To store the selected screen display pattern in the memory of the system, 
use the V, v, B or b button on the Remote Commander to select “Save”, 
then press the ENTER button.
The Layout menu disappears.

0
Terminal

PandPFull

Layout

Screen Display Patterns

Side by Side

Save Cancel

PinP

PinPPinPPinPPinP

Split
Broadcast Mode
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To swap the location of the remote and local pictures

When the displayed picture can be switched during communication, pressing 
the LAYOUT button on the Remote Commander displays the indication “F1: 
Switches the monitored picture between the remote and local sites.” at the 
bottom of the monitor.
Each press of the F1 button on the Remote Commander swaps the location of 
both pictures.

To switch the display to the remote picture while receiving DVI pictures

When receiving a DVI computer picture from a remote party, pressing the 
LAYOUT button on the Remote Commander displays the indication “F2: 
Restores the previous monitor screen.” at the bottom of the monitor. Press the 
F2 button on the Remote Commander to switch to the remote picture. To return 
to the DVI picture, press the F2 button again.

When you connect two monitors and set “Monitor Output” to “HDMI 1+DVI-I OUT” 
in the Video setup menu, you cannot switch to DVI picture by pressing the F2 button.

Note
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Capturing the Screen
You can capture the image displayed on the screen by using “Screen Capture” 
in the Tools menu and display the captured image on the Phone Book. The 
captured image is stored on the USB storage device.

To capture the local image

1 Insert a USB storage device on which you want to save the captured image 
into the USB port on the Communication System.

2 Display the image you want to capture on the monitor screen.

For details on adjusting the camera, see “Adjusting the Camera” on page 
135.

3 Press the TOOLS button on the Remote Commander, or press the V, v, B 
or b button to select “Tools” in the Home menu and press the ENTER 
button.
The Tools menu appears.

4 Press the b button on the Remote Commander, and select “Execute” for 
“Screen Capture” with the V, v, B or b button then press the ENTER 
button.

The image displayed on the monitor is captured and stored on the USB 
storage device.

For the procedure how to display the captured image on the Phone Book, 
see “Registering a New Remote Party” on page 121.

To capture the remote image

1 Display the image of the remote site you want to capture on the monitor 
screen during communication.

 For details on adjusting the remote camera, see “Adjusting the Camera” 
on page 135.

Memory Stick
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Off
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Execute
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2 Press the TOOLS button on the Remote Commander to display the Tools 
menu.

3 Use the V, v, B or b button on the Remote Commander to select “Execute” 
for “Screen Capture”, then press the ENTER button.
The remote picture is captured and stored on the USB storage device.
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This chapter describes the various connections using the optional equipment in 
addition to the components contained in the PCS-XG100S/XG77S HD Visual 
Communication System.

To make a multipoint connection, see Chapter 6.

Using a Tools Menu
Pressing the TOOLS button on the Remote Commander opens the Tools menu 
on the monitor screen.
The Tools menu allows you to perform operations often used simply by 
selecting the item in the menu.

Pressing the b button on the Remote Commander, selecting each item with the 
V, v, B or b button and pressing the ENTER button enable the following 
operations:

“Reject Answer” is available only when the PCSA-MCG106/MCG109 HD MCU 
software (not supplied) is installed in the Communication System.

Chapter 4: 
Connection with 
Optional 
Equipment

Note

Machine Status

Setup

Home Presentation

Streaming

Recording

Annotation

[Suspended]

[Suspended]

[Suspended]

[Suspended]

Icon display

Reject Answer

Screen Capture

Tools

On

Off

Execute

Execute

Execute

Execute

Execute
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Presentation
Pressing the ENTER button on the Remote Commander allows you to transmit 
a DVI-I 2 picture input from a connected computer to a remote party. During 
transmission, the message “Executing” appears and the selectable item 
changes to “Stop”. To stop transmitting the DVI-I 2 picture, select “Stop” and 
press the ENTER button.

For details on presentation, see “Using the Computer Picture for 
Presentation” on page 153.

Streaming
Pressing the ENTER button on the Remote Commander allows you to 
broadcast live stream of the visual communication, and people who do not 
participate in the communication can watch it over the Web. During 
broadcasting, the message “Executing” appears and the selectable menu item 
changes “Stop”. To stop broadcasting a live stream, select “Stop” and press the 
ENTER button.

For details, see “Streaming a Communication” on page 155.

Recording
Pressing the ENTER button on the Remote Commander allows you to save the 
video and audio of the visual communication in progress to a USB storage 
device. While the recording is being saved, the message “Executing” appears 
and the selectable menu item changes to “Stop”. Selecting “Stop” and pressing 
the ENTER button stops recording.

For details on recording, see “Recording a Visual Communication” on page 
157.

Annotation
Pressing the ENTER button displays the Annotation Start menu. You can 
transmit the picture with letters and graphics overwritten with a commercially 
available pen tablet or display a pointer on the screen (Annotation function). 
While the annotation function is being executed, the message “Executing” 
appears and the selectable menu item changes to “Stop”. Selecting “Stop” and 
pressing the ENTER button ends annotation.

For details on annotation, see “Using the Annotation Function” on page 159.

Icon Display
Pressing the ENTER button on the Remote Commander and selecting “On” 
with the V, v, B or b button display the indicators on the screen. Selecting 
“Off” hides the indicators.

Reject Answer (PCS-XG100S only)
Pressing the ENTER button and selecting “On” with the V, v, B or b button 
enables you to reject incoming calls from other terminals during 
communication. Selecting “Off” results in accepting the incoming calls.
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The “Reject Answer” function is only available when the PCSA-MCG106/MCG109 
HD MCU Software (not supplied) is installed.

Screen Capture
Pressing the ENTER button on the Remote Commander allows you to save the 
picture displayed on the screen to a USB storage device as a still image.

For details on screen capture, see “Capturing the Screen” on page 148.

Note
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Using the Computer Picture for 
Presentation

You can transmit a DVI-I 2 picture input from a computer, etc. with the local 
picture simultaneously to a remote party.

To configure the presentation mode

When you transmit a DVI-I 2 picture from a computer, etc. and a camera 
picture simultaneously to a remote party, the remote party can view both 
pictures simultaneously. This function is called “to make a presentation using 
the presentation mode complying with H.239”. Using this function allows 
smooth reproduction of both camera and computer pictures. To make a 
presentation using the presentation mode complying with H.239, it is 
necessary to turn on the presentation mode on both the local and remote 
systems. If the presentation mode on either of the systems is turned off, a 
presentation complying with H.239 cannot be made.

Connecting a Computer

Making a Presentation

DVI cable (not supplied)

to DVI-I 2 (PC) IN

Computer

to DVI-I OUT
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To configure the presentation mode, set “H.239” to “On” on the IP: Mode page 
(page 65) or on the ISDN: Mode page (page 66) of the Communication setup 
menu.

To start a presentation

1 Press the TOOLS button on the Remote Commander to open the Tools 
menu.

2 Press the b button on the Remote Commander and press the V, v, B or b 
button to select “Execute” for “Presentation”.
The RGB picture from the computer is transmitted to the remote party.
While presentation is being executed, the message “Executing” appears on 
the screen.

You can also transmit the computer picture to the remote party by pressing the 
PRESENTATION button on the Remote Commander instead of performing steps 
1 and 2 above.

To stop the presentation

Select “Stop” for “Presentation” in the Tools menu and press the ENTER 
button on the Remote Commander. Transmission of the computer picture 
stops.
You can also stop the presentation by pressing the PRESENTATION button 
on the Remote Commander.

Note

Presentation

Streaming

Recording
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Streaming a Communication
By broadcasting a stream of a visual communication, people who cannot 
attend the communication can watch the proceedings over the Web using a 
computer.
Before broadcasting a live stream, be sure to configure the live stream 
permission setting.

For details on viewing a streamed communication, see Chapter 7.

For details on the streaming settings, see “Streaming” on the Streaming/
Recording page of the Administrator setup menu on page 87.

Starting a streaming broadcast

1 Press the TOOLS button on the Remote Commander to open the Tools 
menu. 

2 Press the b button on the Remote Commander and press the V, v, B or b 
button to select “Execute” for “Streaming”, then press the ENTER button.
The streaming broadcast starts, and the communication in progress can be 
watched from a computer over the Web.
While the streaming broadcast is running, the message “Streaming 
[Executing]” is displayed in the Tools menu and the menu item changes to 
“Stop”.

• If you start streaming before a communication begins, the broadcast will continue 
streaming after the communication begins.

• Depending on Web access limitations, about 10 terminals can view a streaming 
broadcast simultaneously. The actual number of terminals that can view the broadcast 
simultaneously depends on your system’s operating environment.

Notes

Tools
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Home Presentation
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Recording
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To stop a streaming broadcast

Selecting “Stop” for “Streaming” in the Tools menu and pressing the ENTER 
button stop the streaming broadcast. 

Even if the Communication System is turned off while the streaming broadcast is being 
executed, the streaming broadcast continues.

Note
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Recording a Visual Communication
The video and audio of a visual communication can be saved to a USB storage 
device in MPEG4 format. The saved data can then be viewed on a computer.

For details on the recording settings, see “Recording” on the “Streaming/
Recording” page of the Administrator setup menu on page 87.

To start recording

1 Insert a USB storage device into the USB port.

2 Press the TOOLS button on the Remote Commander to open the Tools 
menu. 

3 Press the b button on the Remote Commander and press the V, v, B or b 
button to select “Execute” for “Recording”, then press the ENTER button.
The message “Start recording?” appears.

4 Use the V, v, B or b button on the Remote Commander to select “OK”, 
then press the ENTER button.
Recording to the USB storage device starts.
During recording, the message “Recording [Executing]” is displayed in the 
Tools menu and the menu item changes to “Stop”.

Presentation

Streaming

Recording

Annotation

[Suspended]

[Suspended]

[Executing]

[Suspended]

Icon display

Reject Answer

Screen Capture

Tools

Machine Status
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Execute
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Execute
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To stop recording

1 Select “Stop” for “Recording” in the Tools menu, then press the ENTER 
button on the Remote Commander.
The message “Stop recording?” appears.

2 Use the V, v, B or b button on the Remote Commander to select “OK”, 
then press the ENTER button.
Recording to the USB storage device stops.

• If the remaining capacity of the USB storage device is no longer enough for 
storage during recording, the recording stops automatically and a notification 
message appears.

• You can store up to 2 GB or 12 hours of video for a single recording.
• Although the recorded MPEG4 files have the same file names as the MPEG4 files 

that can be played on other devices that support the USB storage video format, 
you cannot play the files on these devices even after the files are recognized and 
moved to the file directories of these devices.

Notes
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Using the Annotation Function
During communication you can transmit or receive letters and graphics written 
on the screen with a pen tablet as they are written. You can also point the 
camera picture or computer picture with a pointer. This function is called 
“Annotation”.
The annotation function supports the Bamboo small CTH-470/K0* pen tablet 
from Wacom Co., Ltd. Version 1.2 and later also supports the Intuos pen small 
CTL-480/S0 and Intuos pen & touch small CTH-480/S0 from Wacom Co., 
Ltd.

* Wacom, the Wacom logo and Intuos are registered trademarks of Wacom Co., Ltd.
Bamboo is a trademark.

For details on the Bamboo small CTH-470/K0, Intuos pen small CTL-480/S0, 
and Intuos pen & touch small CTH-480/S0, consult with a Sony dealer.

• The communication using a pen tablet is only available for communication between 
the PCS-XG80/XG80S/XG55/XG55S/XA80/XA55/XL55/G60/G60D/G60DP/
XG100S/XG77S Communication Systems. A pen tablet cannot be used for 
communication with other Sony communication systems.

• Graphics written using the annotation function will not appear in recorded or 
streamed video.

1 Turn off the Communication System.

2 Connect the pen tablet to the USB port on the front panel of the 
Communication System.

3 Press the 1 (power) switch on the System to turn it on.

Notes

Connecting a Pen Tablet

to  (USB) port

Pen tablet
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To start annotation

1 Start communication.

2 Press the TOOLS button on the Remote Commander to open the Tools 
menu. 

3 Press the b button on the Remote Commander and press the V, v, B or b 
button to select “Execute” for “Annotation”, then press the ENTER button.

The Annotation Start menu appears.

4 Use the V, v, B or b button on the Remote Commander to select 
“Background Screen” for executing the annotation function and press the 
ENTER button.

Remote Picture: Selects the picture on the remote site as the background
Local Picture: Selects the picture on the local site as the background
Received Computer Picture: Selects the computer picture received from 

the remote site as the background
Transmitting Computer Picture: Selects the computer picture on the 

local site as the background

• “Received Computer Picture” can be selected only when the computer picture is 
being received from the remote site.

Using the Annotation Function while in Communication

Notes
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• “Transmitting Computer Picture” can be selected only when the computer picture 

is being transmitted from the local site.

5 Use the V, v, B or b button on the Remote Commander to select 
“Annotation Mode” and press the ENTER button.
Drawing: Allows you to write letters or graphics on the screen.
Pointing: Allows display of a pointer on the screen.

6 Use the V, v, B or b button on the Remote Commander to select “Start” 
and press the ENTER button.
The  indicator indicating that the local party uses annotation 
appears.
When the Drawing mode is selected,  (pen) indicator appears on the 
monitor screen and  (pointer) appears when the Pointing mode is 
selected.

7 Write letters or graphics on the screen with a pen supplied with the pen 
tablet, or move the pointer on the screen.
The written data is displayed on the screen in live.

For details on how to use the pen tablet, refer to the instruction manual 
supplied with the pen tablet.

Operations during pointing

You can point to any desired portion on the monitor screen with a pointer. You 
cannot write letters and graphics in pointing mode.

Monitor screen
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Operations during drawing

Operate using the function keys on the tablet and the buttons on the pen.

To start drawing
Press the topmost key on the tablet.

To stop drawing
Press the second key from the top on the tablet.

To change the color
Press the lower pen button. Each press changes the color. You can select from 
among black, red, blue, green, yellow, orange, purple and white.
To perform this using touch operations, place one finger on the tablet screen, 
and tap to the right of that position with a second finger.

To change the line density
Press the upper pen button. Each press changes the line density. You can select 
from three different line densities.
To perform this using touch operations, place one finger on the tablet screen, 
and tap to the left of that position with a second finger.

To erase with the eraser
Touch the tail switch (eraser) of the pen onto the tablet and move it on the 
letters or graphics you want to erase.
To perform this using touch operations, touch the tablet screen with two 
fingers, and perform the operation using the balls of your fingers.

To erase all written letters and graphics 
Press the bottommost key on the tablet.

To obtain the drawing rights
Normally, the drawing rights belong to the party who starts annotation. In the 
case that the remote party starts annotation, the Obtain Drawing Rights button 
appears and the  indicator (Drawing executed by the remote party) on 
the monitor screen on the local site.

Start

Stop

Drawing Rights

Erase All

Eraser

Select Line Density

Select Color
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If you want to obtain the drawing rights, press the second key from the bottom 
on the tablet. The  indicator (Drawing executed by the local party) 
appears on the monitor screen, and you are allowed to write letters and 
graphics on the screen.

To save the drawings written using annotation

1 Insert a USB storage device on which you want to save the drawings using 
annotation into the Communication System.

2 Press the TOOLS button on the Remote Commander to open the Tools 
menu.

3 Select “Execute” for “Screen Capture” in the Tools menu.
The drawing using annotation on the screen is saved to the USB storage 
device as a still image.

To end the annotation mode

1 Press the TOOLS button on the Remote Commander to open the Tools 
menu.

2 Use the V, v, B or b button on the Remote Commander to select “Stop” 
for “Annotation”, then press the ENTER button.
The annotation mode ends.
The letters and graphics written using the annotation function are deleted 
when the communication ends.
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Using Multiple Microphones
You can input the stereo sound from two PCS-A1 (two are supplied with the 
PCS-XG100S and one is supplied with the PCS-XG77S) microphones to the 
system.

To connect the microphones

Connect the optional microphones to the MIC (A1) 1 (R) and 4 (L) jacks on 
the Communication System. Power is supplied to the microphones from the 
System.

When using two or more microphones, connect them as follows.
• For two microphones: 1 (R) and 4 (L) connectors of the MIC (A1) connectors
• For four microphones: 1 (R), 2 (R), 4 (L), and 5 (L) connectors of the MIC (A1) 

connectors
• For six microphones: 1 (R), 2 (R), 3 (R), 4 (L), 5 (L), and 6 (L) connectors of the MIC 

(A1) connectors

To use the connected microphones

Set “Audio Input” to “MIC” on the Basic Setup1 page of the Audio setup 
menu, and set “Input Select (MIC)” to “MIC (A1)” (page 68).

Note

to MIC (A1) 1 (R)

PCS-A1 (supplied)

Microphone (Left)

Microphone (Right)

to MIC (A1) 4 (L)
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To input the stereo sound from two microphones, set “Input Mode” to “Stereo” 
(page 69). Set it to “Monaural” to input monaural sound from two 
microphones.

Notes on installation of the microphones
• Install microphone about 50 cm (1.6 ft) away from the participants.
• Place the microphone in a quiet, echo-free location.
• Install the speakers so that the participants do not come between it and the 

microphones.
• Install microphones away from equipment that may cause noise.
• Avoid covering the microphones, with paper for example, or carrying the 

microphones and moving them. If you do either, extreme noise and echo may 
be heard temporarily by the remote party. In this case, wait until the echo 
disappears.

• When stereo sound is input, locate the microphone connected to the MIC 
(A1) 1 (R) jack on the right of the camera and the microphone connected to 
the MIC (A1) 4 (L) jack on the left.

Microphone layout examples

PCS-A1

PCS-XG100S/XG77S

PCS-A1 microphones
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Using a Second Camera
You can connect the second camera through the camera unit.

Connection example for a second camera

Connect the video output connector of the second camera to the HDMI IN, 
DVI-I 1 IN, or DVI-I 2 (PC) IN connector at the rear of the Communication 
System.

The HDMI IN connector is not available on the PCS-XG77S.

Select “DVI-I 1”, “DVI-I 2” or “HDMI” in “Second Camera Input” of the 
Camera setup menu depending on the connector to which the camera is 
connected.

The “HDMI” setting is not available on the PCS-XG77S.

To switch the picture shot by two cameras

When you open the Camera menu, the instruction “F2: Switches to the first 
camera.” or “F2: Switches to the second camera.” is displayed at the bottom of 
the monitor screen. Each press of the F2 button on the Remote Commander 
changes the picture shot by each camera.

For the procedure how to open the Camera menu, see “Adjusting the Camera” 
on page 135.

Note

Note

VISCA cable 
(not supplied)

to VISCA OUT to VISCA IN

Second camera

to Video 
output (DVI)

DVI cable (not supplied)

to DVI-I 1
IN

First camera
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Recording during a Communication
You can record the voices of participants on both the remote and local sites 
during a communication if you connect an audio recorder to the REC OUT 
jack on the Communication System.
This is convenient for taking minutes of the communication.

To connect an audio recorder

When recording with an audio recorder

When an audio recorder is connected to both the AUDIO IN and REC OUT 
jacks, set “Recording Mute” to “On” on the Basic Setup1 page of the Audio 
setup menu, since the echo may cause and is transmitted to a remote party 
(page 68).
To record the sound output from the REC OUT L/R jacks in 2-channel 
monaural, set “REC OUT Mode” to “Monaural 2ch” on the Basic Setup2 page 
of the Audio setup menu.

to audio
inputs

Audio recording device

Audio cable (not supplied)

to REC OUT L/R
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Sending Audio/Video from the External 
Equipment to a Remote Party

The Communication System allows you to send the picture and sound output 
from the connected equipment such as a VCR to a remote party.

To connect the video equipment for input 
The Communication System is equipped with two video inputs.

To input audio/video from external equipment

To input video

Press the VIDEO INPUT button on the Remote Commander to open the Video 
Input >Near menu, then select the video you want to input.

to DVI-I 
1 IN

to HDMI output

HD player, etc.

to AUDIO 2 IN

to HDMI 
IN*

HDMI cable (not supplied)

VCR, etc.

DVI cable (not supplied)

Audio cable (not 
supplied)

to video output (DVI)

to audio output

* The HDMI IN connector is not available on the PCS-XG77S. 
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Use the V, v, B or b button on the Remote Commander to select the external 
equipment connected to each video input on the Communication System, then 
press the ENTER button.
The picture from the selected equipment is displayed.
CAMERA: Video shot by the camera unit connected to the CAMERA 

connector.
HDMI: Video of the camera or video equipment connected to the HDMI IN 

connector.
DVI-I 1: Video of the camera or video equipment connected to the DVI-I 1 IN 

connector.
DVI-I 2: Video of a computer, etc. connected to the DVI-I 2 (PC) IN 

connector.

The “HDMI” setting is not available on the PCS-XG77S.

To save the selected input, press the V, v, B or b button on the Remote 
Commander to select “Save”, then press the ENTER button.

To input audio
Set “Audio Input” to “AUX” or “MIC+AUX” on the Basic Setup1 page of the 
Audio setup menu (page 68).
When set to “AUX”, the sound from the external equipment is input and the 
sound from a microphone is deactivated. When set to “MIC+AUX”, both 
sounds are input.
To switch to the sound from the external equipment connected to the AUDIO 
1 IN or AUDIO 2 IN jacks, set “Input Select (AUX)” to “AUDIO1” or 
“AUDIO2” on the Basic Setup1 page of the Audio setup menu (page 68).

To switch the input video and audio at the same time
Set “Link to Audio Input” to “On” on the Link to Mic page of the Video setup 
menu (page 72) so as to link the audio you want to switch at the same time with 
the video input.
When the video input is switched, the audio input is simultaneously switched 
to the one linked to the video input.

Note

Save Cancel

CAMERA

Video Input > Near

DVI-I 2DVI-I 1HDMI
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Viewing the Picture from the System on 
a Monitor or Projector

When the monitor or projector is connected to the Communication System, 
you can view the picture from the system.

To connect a monitor or projector

To use the connected display equipment

When outputting the picture both to the monitor connected to the HDMI-1 
OUT connector and the display equipment connected to the DVI-I OUT 
connector, set “Monitor Output” to “HDMI 1 + DVI-I OUT” on the Basic 
Setup page of the Video setup menu (page 71).
You can select the format of the video signal output with the “DVI-I Monitor 
Output Format” setting. (page 72)

• The HDMI output is available only when the output signal is of 1080P video format.
• If “Monitor Output” is set to “HDMI 1 + DVI-I OUT”, “HDMI 1 + HDMI 2”, or 

“Triple monitors” when no HDMI monitor is connected to the Communication 
System, you cannot view the menus. Before making this setting, be sure to connect an 
HDMI monitor.

Notes

to DVI-I OUT

to HDMI-1 OUT

DVI cable (not supplied)

Monitor, projector, 
etc.

Monitor

to HDMI IN

HDMI cable 
(supplied)

to DVI IN
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Pictures displayed on the two monitors

During communication, the following images are displayed on the two 
monitors.

Picture displayed on the first monitor
The local or remote picture shot by the camera (moving picture) is monitored 
on the first monitor connected to the HDMI-1 OUT connector.
To switch between the local and remote pictures, press the LAYOUT button, 
then F1 button on the Remote Commander.

Picture displayed on the second monitor
The picture shot by the local camera or the DVI picture transmitted from the 
remote party can be displayed on the second monitor connected to the DVI-I 
OUT connector.

Local camera picture

Remote camera picture

Local camera picture

F1 button

Remote camera picture
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Communicating without the Picture – 
Voice Meeting

The Visual Communication System enables a voice only communication using 
telephones via an ISDN line. (Voice Meeting)
Basic connecting procedures are the same as those for normal communication 
with audio/video.

ISDN will be supported in version 2.0.

Conducting a voice meeting with a remote party not registered in the phone 
book

Set “Line I/F” to “TEL” in the Detailed Dial menu.
During the Voice Meeting, the “Voice Only” indicator is displayed.

For “Line I/F” setting, see “Calling a Remote Party Not Registered in the 
Phone Book” on page 115.

To register a remote party for a Voice Meeting

Set “Line I/F” to “TEL” in the List Edit menu displayed from the Phone Book.

For registration, see “Registering a Remote Party – Phone Book” on page 
121.

To set the audio compression format

Select the audio compression format by setting “Telephone Mode” of the Dial 
setup menu.
When you initiate the voice meeting, set “Telephone Mode” to “Auto” (page 
62). When set to “Auto”, the G.711 µ-law format is automatically selected.
You need not set the audio compression format when receiving a call for a 
Voice Meeting from the remote party.

Note
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Controlling the Remote System with the 
Tone Signal – DTMF Transmission

The Visual Communication System enables you to control the remote system 
connected by transmitting the tone signal (DTMF: Dual Tone Multi 
Frequency) assigned to the numbers for dialing (0-9, , ).

1 Press the TONE ( ) button on the Remote Commander during 
communication.
The DTMF menu appears on the monitor screen.

2 Press one of the number buttons (0-9, , ) on the Remote Commander 
corresponding to the tone signal you want to transmit to the remote party.
The tone signal will be transmitted when the button is pressed.

3 To stop transmitting the tone signal, press the ENTER button on the 
Remote Commander.
The DTMF menu disappears.

The microphone is automatically turned off while the DTMF menu is displayed.

Note
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Accessing the Communication System
The following controls are available to access the Communication System. For 
details on each control, consult your Sony dealer.

Depending on the operating environment, unauthorized third parties on the network 
may be able to access the system. When allowing external access, be sure to configure 
all of the passwords on the Password page (page 85) of the Administrator setup menu.

You can control or set up the Communication System by accessing it from a 
Web browser.
To access the Communication System from a Web browser, set “Web Access” 
to “Enabled” on the Access Permit page of the Administrator setup menu 
(page 88).

For details on Web operation, see Chapter 7, “Web Control Function”.

You can control or set up the Communication System by accessing it with 
Telnet.
To access the Communication System from Telnet, set “Telnet Access” to 
“Enabled” on the Access Permit page of the Administrator setup menu (page 
88). 

You can control or set up the Communication System by accessing it with 
SSH.
To access the Communication System from SSH, set “SSH Access” to 
“Enabled” on the Access Permit page of the Administrator setup menu (page 
88).

Note

Using a Web Browser

Using Telnet

Using SSH
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When a strictly confidential communication is required, the communication 
system enables a connection with encrypted video and audio. A connection 
conducted using this feature is known as an encrypted connection.
This chapter describes how to conduct an encrypted connection.
The Communication System is equipped with standard encryption, which 
complies with the H.233, H.234 and H.235 standardized by the ITU-T.

• The encryption function is not available in some countries and regions.
• The maximum bandwidth for encrypted connections is 6 Mbps.

Chapter 5: 
Encrypted 
Connection

Notes
175



Preparing for an Encrypted Connection 
via LAN

To start an encrypted connection, “Encryption Mode” must be set in the 
Encryption setup menu.

Set “Encryption Mode” to “Connect Priority” or “Encrypt Priority” in the 
Encryption setup menu.

Connect Priority
Connects with encryption to a remote party with standard encrypted connection 
enabled. Connects without encryption to parties unable to connect with 
standard encryption or parties with encryption set to off.

Setup Encryption

5/11/2008 13:00IP:192.168.0.11

Encryption Mode Connect Priority

CancelSave

Encryption

Connect with encryption

Local system:
Standard encrypted connection available

Remote system:
Standard encrypted connection available

Local system:
Standard encrypted connection available

Remote system:
Standard encrypted connection unavailable

Connect without encryption
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Encrypt Priority
Connects only to remote parties with standard encrypted connection enabled.

Do not connect

Connect with encryption

Local system:
Standard encrypted connection available

Remote system:
Standard encrypted connection available

Local system:
Standard encrypted connection available

Remote system:
Standard encrypted connection unavailable
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Starting an Encrypted Connection
You can start an encrypted connection by calling a remote party in the same 
manner as a daily connection.
During an encrypted connection, the encryption icon, , is displayed.

If there is no icon displayed, transmitted and received data are not encrypted. Confirm 
if an icon is displayed before starting a connection.

When the encrypted connection is disabled
If the following message appears when you call a remote party, an encrypted 
connection is not available.

Note

Error Messages Causes

The far-end system is not 
compatible with the encryption 
feature.

The remote system is not equipped with an 
encryption feature.

The encryption feature on a far-
end system is disabled.

The encryption feature on a remote system is 
turned off or the signal encryption method setting 
on the remote system is different from that on the 
local system.

The encryption feature on a far-
end system is enabled.

The encryption feature on a remote system is 
turned on.

The conference could not start 
because the encryption feature at 
the near-end side was disabled.

“Encryption Mode” is set to “Off” on the local 
system.

The conference could not start 
because the encryption feature at 
the far-end side was disabled.

The encryption feature on the remote system is 
disabled.

The conference could not start 
because the signal encryption 
method at the near-end side 
differed from that of the far-end 
side.

The encryption method setting on the remote 
system is not the same as that on the local 
system.

H
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The standard encryption 
videoconference with SIP 
connection is not available.

You are connected to the remote system via SIP 
connection.

Error Messages Causes
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This chapter describes how to connect your system to multiple points.
For multipoint connection, installation of the optional PCSA-MCG106/
MCG109 HD MCU software is required.
When connecting via a LAN, multipoint connection among up to 16 points 
including your site is available. When connecting via an ISDN, multipoint 
connection among up to six points including your site is available, and a phone 
can be used at up to five points among six.
A multipoint connection using LAN and ISDN mixed is also available.

ISDN will be supported in version 2.0.

Restrictions on the use of the MCU software
• When a multipoint connection is made via LAN, you can set up the total 

communication bit rate for all the connecting points with “Total Bandwidth” 
in the Communication setup menu. As the communication bit rate for each 
point is automatically adjusted so as not to exceed the value selected in 
“Total Bandwidth”, actual bit rate per point may differ from that selected for 
that point.

• When a multipoint connection is made via an ISDN, the same number of 
channels should be used on all the points and the total channels must not 
exceed 12B.

• The H.264, H.263+ and H.261 video modes are supported.
• The G.711, G.722, G.728 and MPEG4 AAC audio modes are supported.
• A multipoint connection including a SIP connection is not available.
• Only the PCS-XG100S is enabled for use as a main terminal for the cascade 

connection.
• When the local system is used as the main terminal and connected with 

remote terminals other than the PCS-XG80/XG80S/XG55/XG55S/XA80/
XA55/XL55/XG100S/XG77S, the maximum bandwidth to be used is 
restricted to 4 Mbps.

• The HD MCU software cannot be installed on the PCS-XG77S.

Chapter 6: 
Multipoint 
Connection

Note
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Connection Examples of a Multipoint 
Connection

A license key must be purchased and installed to use the HD MCU software. For details 
on purchasing license keys, consult your Sony dealer.

For details on installing license keys, see “Adding Optional Software” on 
page 187.

Installing the optional PCSA-MCG106 HD MCU software on an HD Visual 
Communication System allows you to connect to up to six points, while 
installing the optional PCSA-MCG109 HD MCU software allows you to 
connect to up to nine points.
If you have already made a point-to-point connection when a third point calls, 
the system automatically starts multipoint connection.

Note

Using the LAN Connection (Up to Nine Points)

to LAN

Main terminal

to 1 or 2 
(100BASE-TX/
10BASE-T)

UTP cable (category 6, straight) 
(not supplied)

The illustration shows an example of when PCSA-MCG109 is installed.
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• For a multipoint connection, only the Communication System with the 
PCSA-MCG106/MCG109 HD MCU software installed can be used as main terminal. 
If you want to use multiple Communication Systems as main terminals depending on 
the type of connection, the same number of HD MCU software as that of main 
terminals is required to install.

• When a system is constructed using only PCS-XG100S terminals and PCS-XG77S 
terminals on which the PCSA-RXG77 HD Upgrade Software is installed, 1080p60 
(Full HD) progressive video signals with a resolution of 1920 × 1080 can be sent from 
the main terminal to the other terminals.

Installing the optional PCSA-MCG106/MCG109 HD MCU software on two 
HD Visual Communication Systems enables cascade connection with two 
main terminals. The PCSA-MCG106 software allows you to connect to up to 
10 points by connecting four points to each main terminal. The 
PCSA-MCG109 software allows you to connect to up to 16 points by 
connecting seven points to each main terminal.

• Even if the PCSA-MCG106/MCG109 HD MCU software is installed in three or more 
Communication Systems, cascade connection is not available. 

• For cascade connection, “Broadcast Mode” can be set to “Voice Activate” mode only 
during communication. The “Split” and “Split (fixed)” modes are not available.

• Only the PCS-XG100S is enabled for use as a main terminal on the remote site.

Notes

Using the Cascade Connection via LAN (Up to 16 Points)

Notes

Main terminalMain terminal

The illustration shows an example of when PCSA-MCG109 is installed.
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ISDN will be supported in version 2.0.

Installing the optional PCSA-MCG106/MCG109 HD MCU software in an HD 
Visual Communication System allows you to connect to multiple systems up 
to six by using the optional PCSA-B768S, or up to four by using the optional 
PCSA-B384S ISDN Unit.

Notes on the number of ISDN lines used and number of remote 
parties for a multipoint connection
You can select the number of ISDN channels to be used for the remote point 
connected first using “ISDN Bandwidth” on the ISDN: Mode page of the 
Communication setup menu (page 66).
However, if the number of remote points connected increases as a result of 
dialing from the main terminal, some of the channels used for the first point 
will be cut off and used for newly connected points instead. For example, if 
you use six ISDN lines (up to 12B channels available), 12B channels will be 
used for the first remote point only when no other points are connected. When
the system connects to a second point, the number of channels for the first 
point decreases, and 6B channels will be used for both the first and second 
points.

Using the ISDN Connection

Note

The illustration shows an example using the 
PCSA-B768S ISDN Unit.

Main terminal

PCSA-B384S or
 PCSA-B768S ISDN Unit

 to ISDN1 to 6

to ISDN lines ISDN modular cables 
(not supplied)
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Even if one of the remote points in a multipoint connection is disconnected, the 
number of channels used for the remaining points will not increase.

When you are called from a remote party and the remote party has set up a lower number 
of ISDN channels than that in your terminal, the setting on the remote party’s terminal 
has priority.

To connect with a normal phone
When you are using an ISDN connection, a normal phone can be connected at
up to five points.
Only the 1B (64K) connection is available for a normal phone.

• When using the ISDN connection, installing the PCSA-MCG106/MCG109 HD MCU 
software in two or more Communication Systems does not allow cascade connection.

• For multipoint connection, only the Communication System with the PCSA-
MCG106/MCG109 HD MCU software installed can be used as main terminal. If you 
want to use two or more Communication Systems as main terminals depending on the 
type of connection, the same number of HD MCU software installations as that of 
main terminals is required.

Note

Notes
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ISDN will be supported in version 2.0.

Installing the PCSA-MCG106/MCG109 HD MCU software in one HD Visual 
Communication System enables a multipoint connection with the terminals 
connected via a LAN and ISDN.

A connection that includes both LAN and ISDN connections allows connection of up to 
6 sites.

Using Both LAN and ISDN

Note

Note

The illustration shows an example 
using the PCSA-B768S ISDN Unit.

to 1 or 
2 

(1000BASE-T/
100BASE-TX/
10BASE-T)

PCSA-B384S or 
PCSA-B768S ISDN 
Unit

to ISDN1 to 6
ISDN modular cables 
(not supplied)

to ISDN lines

UTP cable (category 6, 
straight) (not supplied)

to LAN

The illustration shows an example of when PCSA-MCG109 is installed.

Main terminal
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ISDN will be supported in version 2.0.

Installing the PCSA-MCG106/MCG109 HD MCU software in two HD Visual 
Communication System enables cascade connection including two main 
terminals. Connecting four terminals to one main terminal allows you to make 
a multipoint connection via a LAN and ISDN with up to ten points.

• Be sure to use LAN connection between two Communication Systems connected with 
cascade. Cascade connection via an ISDN is not available.

• For cascade connection, “Broadcast Mode” can be set to “Voice Activate” mode only 
during communication. The “Split” and “Split (fixed)” modes are not available. 

• Only the PCS-XG100S is enabled for use as a main terminal on the remote site.

Using the LAN Cascade and ISDN Connection

Note

Notes

Main terminal

LAN

Main terminal
186 Connection Examples of a Multipoint Connection



C
hapter 6: M

ultipoint C
onnection
Adding Optional Software
Optional software can be added in the Administrator setup menu or the Web 
page.

Adding Optional Software in the Administrator Setup Menu

1 Display the Software Option Screen 1 (Administrator 9) page of the 
Administrator setup menu.

2 Enter the key of the optional software you want to add.
If a valid key is entered, the system will recognize the key and display the 
name of the optional software below the input box. In addition, the entered 
optional software key will be displayed as asterisks (*) when it is 
recognized.

For details optional software keys, consult your Sony dealer.

• You can register up to eight optional software.
• Optional software keys cannot be deleted after they are recognized by the system.
• Optional software installation will be retained, even after updating the system 

software version.

Adding Optional Software in the Web Page

1 Access the system from a Web browser on your computer.

For details on accessing this system, see “Chapter 7: Web Control 
Function”.

2 Click “Setup” at the top of the Web page.

3 Click “Software Option” that appears on the left side of the screen.
The “Software Option” screen appears.

4 Enter the key of the optional software you want to add.

Notes

Setup Software Option Screen 1Administrator

Multipoint

Software Option 1

Software Option 2
None

Software Option 3
None

Software Option 4
None

Software Option 5
None

Software Option 6
None

Software Option 7
None

None

Software Option 8

**********

EndSave

Administrator9
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If a valid key is entered, the system will recognize the key and display the 
name of the optional software below the input box. In addition, the entered 
optional software key will be displayed as asterisks (*) when it is 
recognized.

For details optional software keys, consult your Sony dealer.

• You can register up to eight optional software.
• Optional software keys cannot be deleted after they are recognized by the 

system.
• Optional software keys will not appear in system logs or configuration files.
• Optional software installation will be retained, even after updating the 

system software version.

The installed software is indicated in “Software Option” under the Machine 
Information page of the Machine Status menu.

For details, see “Machine Information” on page 93.

Notes

Confirming that the Installation of the Optional Software is 
Complete

Machine Information

CancelPrevious Save

Host Version 2.00

Machine Status > Machine Information

Software Option

Option I/F

Host Name

IP Address

IP Address(LAN2)

Multipoint

None

pcshost

0:0:0:0:0:0:0:0

0:0:0:0:0:0:0:0

MAC Address 00-1A-80-78-6F-C8

MAC Address(LAN2) 00-1A-80-78-6F-C9

Serial Number 4294967295
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Configuring Multipoint

1 Open the Multipoint setup menu, set “Multipoint Mode” to “AUTO”, and 
make the necessary settings.

For details on “Broadcast Mode” and “Split”, see “Using the Display 
Control” on page 198.

2 Open the Communication setup menu and make the necessary settings.

For details, see “Communication Setup Menu” on page 64.

You can register a multipoint connection list that includes all remote parties for 
a multipoint connection in the Phone Book. It allows you to dial all the parties 
simultaneously.
You can enter new remote parties to register in the multipoint connection list 
or add the parties registered in the Phone Book to the multipoint connection 
list.

Setting Up Multipoint

Registering the Remote Parties in the Multipoint Connection List

Setup Multipoint

Multipoint Mode

Broadcast Mode

Split

Split

AUTO

Automatic

CancelSave

Multipoint 

Setup Communication IP

Individual Settings for Transmission/Reception

Individual Settings for Point-to-Point/Multipoint Off

Off

CancelSave

Communication1
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To register a multipoint connection list in the Phone Book

The basic procedure for registration is the same as when registering a remote 
party for a point-to-point connection. For details on the procedure, see 
“Registering a New Remote Party” on page 121.

1 Select “New Entry” in the Phone Book to display the List Edit menu, then 
enter the name of the multipoint connection list in the Index text box.

2 Select “Number of Connected Sites” and select the number of sites to 
which you want to connect.
The “Dial to:” text boxes that correspond to the selected numbers of sites 
are displayed.

3 Select the line interface icon or a still image to be displayed in the Phone 
Book.
You can select “ ” as an icon for a multipoint connection list.

4 Set up the line interface of the remote parties you want to register in a 
multipoint connection list in the “Dial to:” text boxes.
Select the line interface from the drop-down list on the left, and enter the 
number of a remote party in the text box.
For LAN connection: Select “IP” from the drop-down list (when using the 

1 connector), and enter the IP address.
For ISDN connection: Select “ISDN” from the drop-down list, and enter 

the line number.
For ISDN (Telephone) connection: Select “TEL” from the drop-down 

list, and enter the telephone number. (ex. : 0390123456).

Phone Book

Group Select

One-Touch Dial Specified

Number of Connected Sites

Line I/F

Communication Bit Rate

Number of Lines

Dial to:

Index

IP

None Specified

None Specified

1

IP

1Mbps

28(128K)

CancelSave

MULTI LIST

Phone Book

Group Select

One-Touch Dial Specified

Number of Connected Sites

Line I/F

Communication Bit Rate

Number of Lines

Dial to:

Index

IP

Dial to: IP

Dial to: IP

None Specified

None Specified

3

IP

1Mbps

28(128K)

CancelSave

MULTI LIST
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Enter all the parties to which you want to make a multipoint connection.

5 Set up other items.

For details on the setup, see step 3 in “Registering a New Remote Party” 
on page 122.

6 Select “Save”, then press the ENTER button on the Remote Commander.
Registration of the multipoint connection list is completed.

To specify a remote party registered in the Phone Book to the multipoint 
connection list

1 Use the V, v, B or b button on the Remote Commander to select the name
you want to register in the multipoint connection list.

2 Press the  button on the Remote Commander. Or press the ENTER 
button on the Remote Commander to display the submenu, press the V, v, 
B or b button to select “  On”, then press the ENTER button.

The  (multipoint) mark is added to the lower right of the selected list, 
and the remote party is registered in the multipoint connection list.

You can add the  marks to up to eight parties using the same procedure 
as above. The  marks that correspond to the number of the parties you 
have registered appear as dark marks on the upper right of the Phone Book.

Phone Book

Group Select

One-Touch Dial Specified

Number of Connected Sites

Line I/F

Communication Bit Rate

Number of Lines

Dial to:

Index

IP

Dial to: IP

Dial to: IP

None Specified

None Specified

3

IP

1024Kbps

28(128K)

CancelSave

MULTI LIST

123.123.123.1

123.123.123.2

123.123.123.3

Multipoint

Default Group

Phone Book

Room 101
ISDN 01-2345-6789

Cancel

Connect

Edit

Copy

Delete

On
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To delete the  mark from the name list, press the  button on the Remote 
Commander again, or press the ENTER button on the Remote Commander to 
display the submenu, press the V, v, B or b button to select “  Off”, then press 
the ENTER button.

3 Select one of the remote parties with the  mark, then press the ENTER 
button.

4 Press the V, v, B or b button to select “Edit” from the submenu, then press 
the ENTER button.
The List Edit menu appears. All the IP addresses or telephone numbers of 
the parties marked with  are entered in the number text boxes.

5 Enter the name of the multipoint connection list in the Index text box.

6 Select “Save”, then press the ENTER button.
The registration of the multipoint connection list is completed.

Note

Default Group

Phone Book

Office ARoom 102Room 101
ISDN 98-7654-3210IP 255.255.255.255ISDN 01-2345-6789

Number of specified points

Multipoint mark

Phone Book

One-Touch Dial Specified

Number of Connected Sites

Line I/F

Communication Bit Rate

Number of Lines

Index

None Specified

3

IP

2Mbps

28(128K)

CancelSave

MULTI LIST

Group Select

ISDN

IP

ISDN

None Specified

01-2345-6789

255.255.255.255

IP 255.255.255.XXX

IP 255.255.255.YYY

IP 255.255.255.ZZZ

IP 255.255.255.AAA

IP 255.255.255.BBB

98-7654-3210

Dial to:

Dial to:

Dial to:

Dial to:

Dial to:

Dial to:

Dial to:

Dial to:
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Starting a Multipoint Connection

To call remote parties registered in the multipoint connection lists

1 Select the multipoint connection list registered in the Phone Book.

2 Press the CONNECT ( ) button on the Remote Commander, or press the 
ENTER button on the Remote Commander to display the submenu, press 
the V, v, B or b button to select “Connect”, then press the ENTER button.

The system begins dialing the remote parties registered in the multipoint 
connection list. “Dialing” appears on the monitor screen. When the system 
connects to all the remote points, the message “Session Connected.” 
appears on the screen, and the pictures of the remote parties are displayed 
on the screen.

To call remote parties by selecting from the Phone Book

1 Select a remote party to which you want to connect for a multipoint 
connection from the Phone Book.

2 Press the  button on the Remote Commander, or press the ENTER button 
on the Remote Commander to display the submenu, press the V, v, B or b 
button to select “  On”, then press the ENTER button.

Calling Remote Parties

Default Group

Phone Book

Room 101
ISDN 01-2345-6789

Multipoint

Cancel

Edit

Copy

Delete

On

Connect
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The  (multipoint) mark is added to the lower right of the selected name 
in the Phone Book list and the remote party is specified to the party for the 
multipoint connection.
You can add the  marks to up to eight parties using the same procedure 
as above. The  marks that correspond to the number of the parties you 
have selected appear as dark marks on the upper right of the Phone Book.

To delete the  mark from the name list, press the  button on the Remote 
Commander again, or press the ENTER button to display the submenu, press the V, 
v, B or b button to select “  Off”, then press the ENTER button.

3 Select one of the remote parties with the  mark.

4 Press the CONNECT ( ) button on the Remote Commander, or press the 
ENTER button on the Remote Commander to display the submenu, press 
the V, v, B or b button to select “Connect”, then press the ENTER button.
The system begins dialing the remote parties with the  marks. “Dialing” 
appears on the monitor screen.
When the system connects to all the remote points, the message “Session 
Connected.” appears on the screen, and the pictures of the remote parties 
are displayed on the screen.

Note

Default Group

Phone Book

Room 101
ISDN 01-2345-6789

Cancel

Connect

Edit

Copy

Delete

On

Default Group

Phone Book

Office ARoom 102Room 101
ISDN 98-7654-3210IP 255.255.255.255ISDN 01-2345-6789

Number of specified points

Multipoint mark
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To call remote parties not registered in the Phone Book

Basic operations are the same as those for a point-to-point connection.

For details, see “Calling a Remote Party Not Registered in the Phone Book” 
on page 115.

1 Select “Detailed Dial” in the Home menu or press the CONNECT ( ) 
button on the Remote Commander to open the Detailed Dial menu.

2 Select “Number of Connected Sites” and select the number of the points to 
which you want to connect.
The “Dial to:” text boxes that correspond to the selected number of points 
appear.

3 Set up the line interface of the remote parties in the “Dial to:” text boxes.
Select the line interface from the drop-down list on the left, and enter the 
number of a remote party in the text box.
For LAN connection: Select “IP” from the drop-down list (when using the 

1 connector), and enter the IP address.
For ISDN connection: Select “ISDN” from the drop-down list, and enter 

the line number.
For ISDN (Telephone) connection: Select “TEL” from the drop-down 

list, and enter the telephone number (ex. : 0390123456).

Enter all the parties with which you want to make a multipoint connection.

For details on the setup, see “Calling a Remote Party Not Registered in the 
Phone Book” on page 115.

Dial to: IP

Dial to: IP

Dial to: IP

Detailed Dial

Phone Book

Home

CancelHistory

2Mbps

IPLine I/F

Communication Bit Rate

3Number of Connected Sites

1B(64K)Number of Lines

Dial to: IP

Dial to: IP

Dial to: IP

123.123.123.1

123.123.123.2

123.123.123.3

Detailed Dial

Phone Book

Home

CancelHistory

2Mbps

IPLine I/F

Communication Bit Rate

3Number of Connected Sites

1B(64K)Number of Lines
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4 Select “Connect”, and press the ENTER button on the Remote 
Commander, or press the CONNECT ( ) button on the Remote 
Commander.
The system begins dialing the remote parties selected in step 3. “Dialing” 
appears on the monitor screen.
When the system connects to all the remote points, the message “Session 
Connected.” appears on the screen, and the pictures of the remote parties 
are displayed on the screen.

To call additional remote parties

After starting communication with the first party, press the CONNECT ( ) 
button on the Remote Commander to display the menu.

Call the second remote party by using one of the procedures described in 
“Starting a Connection by Calling a Remote Party” on page 107 depending on 
the registration status of the party. When you press the CONNECT ( ) button 
on the Remote Commander after the communication starts with the second 
remote party, the above menu opens again and you can call the next party.

• When “Direct Dial” or “One-Touch Dial” is set to “On” in the Home Menu setup 
menu, selecting “Previous” from the above menu displays the necessary items for 
direct dialing or the one-touch dial buttons on the monitor screen.

• The Phone Book opens when you press the  button during communication. It is 
convenient for calling a remote party registered in the Phone Book.

If some points are not connected

The following dialog appears. Only the connected points are shown as dark 
circles. Select the desired item.

Notes

Select from History

Previous

Enter Number/Address

Select from Phone Book
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Start Meeting: Starts communication with remote parties connected.
Disconnect All: Cancels all the connections and restores the Home menu.
Redial: Redials the numbers of the points that you failed to connect.

Note on multipoint videoconferences using ISDN

If the number of remote points connected increases as a result of dialing from 
the main terminal while making a multipoint connection using ISDN, some of 
the channels that have been used for connection will be cut off and used for the 
newly connected points instead. For example, if you use six ISDN lines (up to 
12B channels available), 12B channels will be used for the first remote point 
only when no other points are connected. When the system connects to a 
second point, the number of channels for the first point decreases, and 6B 
channels will be used for both the first and second points.
Even if one of the remote points in a multipoint connection is disconnected, the 
number of channels used for the remaining points will not increase.

Operations are the same as those for a point-to-point connection.

For details, see “Receiving a Call from a Remote Party” on page 118.

Receiving a Call from a Remote Party

Disconnect All

Start Meeting

Redial

Some positions were not connected.
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Using the Display Control
During a multipoint connection you can control the following operations.

There are four broadcast modes, “Split” and “Voice Activate”, and “Split 
(fixed)” and the broadcast select mode.
You can set up “Split” and “Voice Activate” modes in “Broadcast Mode” of 
the Multipoint setup menu.
You can select “Split (fixed)” and broadcast select modes in the Layout menu 
during communication.

Split mode
This mode allows display of the pictures of the connected remote terminals and 
the picture of the local terminal by splitting the monitor screen.
In “Split” of the Multipoint setup menu, you can select “Six-screen Mosaic” or 
“Nine-screen Mosaic” to split the display into six or nine parts regardless of 
the number of terminals. If you select “Automatic”, the display automatically 
splits into three parts when there are two terminals connected, four parts when 
there are three, six parts when there are four or five, or nine parts when there 
are six to eight terminals connected.
The split windows A to H display the pictures of the remote terminals in the 
connected sequence.

Broadcast Mode
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• When the six-split window is displayed, the system detects the terminal including the 

loudest voice among all the terminals and displays the picture of that terminal in the 
lower right window. The picture on the local terminal is then displayed in the window 
where the picture of the detected terminal was displayed.

• If you switch the broadcast mode from “Split” to “Voice Activate” in which the 
picture of a specified terminal is displayed in full screen during communication, the 
location of Pictures A to E will be changed when “Split” mode is restored.

Notes

Three-split window

Six-split window

Picture A Picture B

Picture on the local terminal

Picture A Picture B Picture C

Picture D

Picture E

Picture on the local terminal

Four-split window

Picture A Picture B

Picture on the local 
terminal

Picture C

Nine-split window

Picture A Picture B Picture C

Picture D

Picture E

Picture on the local terminal

Picture F

Picture G

Picture H
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• When there is one terminal, the picture is displayed in full screen regardless of the 
setting.

• When the six-split window with a terminal specified is displayed, the picture from the 
specified terminal is always displayed in the lower-right window.

• When “Split” mode is selected, you cannot control the camera on any connected 
remote terminals.

Voice Activate mode
This mode allows you to detect the terminal with the loudest voice among the 
connected terminals and to display the picture of that terminal in full screen on 
all other terminals. The “ ” indicator appears when “Voice Activate” 
mode is activated. The indicator with an alphabetic letter (ex. : ) indicating 
the terminal of the displayed picture also appears. The  indicator is 
displayed on the monitor screen while the local picture is broadcast.

To transmit pictures with resolution of 1080P (1920 × 1080 pixels) in H.264 Video 
Mode when “Voice Activate” is activated, select “Voice Activate (1080P)” in 
“Broadcast Mode” of the Multipoint setup menu. However, the “Voice Activate 
(1080P)” mode cannot be selected when the communication is made via an ISDN or SIP 
connection. Even for an IP connection, this mode is not available if the remote party 
does not support H.264 Video Mode.

Fixed split mode
The pictures from the connected remote terminals and the picture of the local 
terminal are displayed in split windows on the monitor screen as the same 
manner as those in “Split” mode.
You can specify a picture among the split windows to fix it in the lower right 
window for the six-split mode. Pictures other than the specified one are 
displayed in the split windows in the connected sequence.

Broadcast select mode
You can specify a terminal to display the picture of that terminal in full screen 
on all other terminals. The indicator with an alphabetic letter (ex. ) 
indicating the terminal of the displayed picture also appears. The  indicator 
is displayed on the monitor screen while the local picture is broadcast.

Note

The picture of the specified terminal is 
always displayed in this window.

Six-split window
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The chart described below shows the window displayed on the monitor screen 
when you select one of the broadcast modes. According to the connection 
status of your system, some modes cannot be selected. You cannot select the 
broadcast mode if your connection status corresponds to that with no display 
window in the chart below.

Broadcast Modes and Displayed Windows

Connection status Non-cascade connection Cascade connection 

LAN connection 
(page 181)
ISDN connection 
(page 183)
LAN & ISDN connection 
(page 185)

LAN cascade connection
(page 182)
LAN cascade & ISDN 
connection 
(page 186)

Connecting points (max.) 9 16

Automatic 2 terminals 
connected

Three-split window –

3 terminals 
connected

Four-split window –

4 or 5 
terminals 
connected

Six-split window –

6 to 8 
terminals 
connected

Nine-split window –
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Only the “Voice Activate” mode is supported during cascade connections.

Six-screen Mosaic Six-screen mosaic –

Nine-screen Mosaic Nine-screen Mosaic –

Split 
(fixed)

2 or 3 
terminals 
connected

– –

4 or 5 
terminals 
connected

Six-split window –

Voice Activate Full screen Full screen

Broadcast Select Full screen –

Note

Connection status Non-cascade connection Cascade connection 
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At the beginning of the connection, the broadcast mode set in “Broadcast 
Mode” and “Split” of the Multipoint setup menu is applied. You can change 
the mode during communication using the Layout menu.

If “Broadcast Mode” of the Multipoint setup menu is set to “Voice Activate (1080P)”, 
you cannot switch “Broadcast Mode” during communication as the “Broadcast Mode” 
does not appear in the Layout menu. Set “Broadcast Mode” before starting 
communication.

1 Press the LAYOUT button on the Remote Commander.
The Layout menu appears.

2 Use the V, v, B or b button on the Remote Commander to select the mode 
to which you want to switch from “Broadcast Mode”, then press the 
ENTER button.

Split: Selects the Split mode.
Split (A fixed): Fixes the picture of the terminal connected first in the 

specified window of the fixed split mode.
Split (B fixed): Fixes the picture of the terminal connected second in the 

specified window of the fixed split mode.
Split (C fixed): Fixes the picture of the terminal connected third in the 

specified window of the fixed split mode.
Split (D fixed): Fixes the picture of the terminal connected fourth in the 

specified window of the fixed split mode.

Switching the Broadcast Mode

Note

0
Terminal

PandPFull

Layout

Screen Display Patterns

Side by Side

Save Cancel

PinP

PinPPinPPinPPinP

Split
Broadcast Mode
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Split (E fixed): Fixes the picture of the terminal connected fifth in the 
specified window of the fixed split mode.

Split (F fixed): Fixes the picture of the terminal connected sixth in the 
specified window of the fixed split mode.

Split (G fixed): Fixes the picture of the terminal connected seventh in the 
specified window of the fixed split mode.

Split (H fixed): Fixes the picture of the terminal connected eighth in the 
specified window of the fixed split mode.

Split (Near End Fixed): Fixes the local picture in the specified window of the 
fixed split mode.

Voice Activate: Selects “Voice Activate” mode.
Self Broadcast: Broadcasts the local picture in broadcast select mode.
A Broadcast: Broadcasts the picture of the terminal connected first in 

broadcast select mode.
B Broadcast: Broadcasts the picture of the terminal connected second in 

broadcast select mode.
C Broadcast: Broadcasts the picture of the terminal connected third in 

broadcast select mode.
D Broadcast: Broadcasts the picture of the terminal connected fourth in 

broadcast select mode.
E Broadcast: Broadcasts the picture of the terminal connected fifth in 

broadcast select mode 
F Broadcast: Broadcasts the picture of the terminal connected sixth in 

broadcast select mode.
G Broadcast: Broadcasts the picture of the terminal connected seventh in 

broadcast select mode.
H Broadcast: Broadcasts the picture of the terminal connected eighth in 

broadcast select mode.

To display the local picture in “Voice Activate” mode

You can display the local picture only on your monitor screen even if “Voice 
Activate” mode is activated. All other terminals remain in “Voice Activate” 
mode.

1 Press the LAYOUT button on the Remote Commander to display the 
Layout menu.
The instruction “F1: Switches the monitored picture between the remote 
and local sites.” appears in the lower part of the screen. 

2 Press the F1 button on the Remote Commander.
The local picture appears on your monitor screen.

To restore “Voice Activate” mode on the local site
Press the F1 button on the Remote Commander again.
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When you receive the “Self Broadcast” command from one of the terminals 
connected, the picture of that terminal is broadcast in full screen.
When you receive the “Stop Broadcast” command from one of the terminals 
connected, the system returns to the previous mode.

If you have received the “Self Broadcast” command from another terminal, the 
operation above will not be carried out.

Receiving the Broadcast Requested From Another Terminal

Note
205Using the Display Control



Ending the Multipoint Connection
1 Press the DISCONNECT ( ) button on the Remote Commander.

The following menu appears:

The alphabetic letters A to H (or A to C, A to E) indicate the connected 
sequence of terminals.
The terminal names are displayed in the menu if you set “Display Terminal 
Name” to “Show temporarily” or “Always show” on the Menu Screens 
page in the General setup menu.

2 Use the V, v, B or b button on the Remote Commander to select the 
terminal to be disconnected, then press the ENTER button.
Disconnect A: Disconnects the terminal connected first.
Disconnect B: Disconnects the terminal connected second.
Disconnect C: Disconnects the terminal connected third.
Disconnect D: Disconnects the terminal connected fourth.
Disconnect E: Disconnects the terminal connected fifth.
Disconnect F: Disconnects the terminal connected sixth.
Disconnect G: Disconnects the terminal connected seventh.
Disconnect H: Disconnects the terminal connected eighth.
Disconnect All: Disconnects all the terminals.

The selected terminal is disconnected.
You can also disconnect all the terminals by pressing the DISCONNECT 
( ) button on the Remote Commander.

To cancel the disconnection
Select “Cancel” in step 2, then press the ENTER button on the Remote 
Commander.

Cancel

Disconnect A Disconnect B Disconnect C

Disconnect E Disconnect F

Disconnect H

Disconnect D

Disconnect G

Disconnect All
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Notes on Secondary 
Terminals

If there is a terminal that is not adequate for 
the settings set by this system, that terminal 
is called a secondary terminal.
Communication capabilities between 
secondary terminal and this system are 
shown below.
• Transmitting/receiving audio
• Receiving video from a secondary 

terminal
• Disables transmission of video to a 

secondary terminal

For details on secondary terminals, see 
“Glossary” on page 260.

When a normal phone is connected
The audio mode of the Visual 
Communication Systems is not affected if a 
normal phone is connected or disconnected 
at any time.

When a 56K network is mixed among 
the terminals if the connection is 
made via a 64K network
The connection automatically changes to 
that via the 56 K network. Terminals that 
cannot change to that network are regarded 
as secondary terminals, and the transmission 
of video is not available, although 
transmission/reception of audio and 
reception of video are available.

When a terminal with different audio 
mode is connected and its video bit 
rate is different
The connection is made in the audio mode of 
the terminal with the lowest video bit rate. 
Any terminal that cannot conform to the 
audio mode is regarded as a secondary 
terminal, and the transmission of video is not 
available, although transmission/reception 
of audio and reception of video are 
available.
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Multipoint Attributes

Number Attribute Value (H.320 MCU) Value (H.323 MCU)

1 Maximum number of terminals 
that can be connected to a single 
MCU

5 (6 when including the 
local terminal)

8 (9 when including the 
local terminal)

2 Maximum number of 
concurrent (independent) 
connections that can be 
supported in a single MCU

1 1

3 Maximum number of ports that 
can be connected to other 
MCUs 

0 1

4.1 Network interfaces at each port BRI LAN

4.2 Restricted network capability Restrict_Required –

5 Transmission rates available at 
each port

1B, 2B, 4B, 6B (BRI) Restricted on maximum 
value of total bit rate of 
all points

6 Audio Processor Equipped Equipped

6.1 Mixed/switched 
Noise/echo suppression on 
“silent” ports

Mixed
No

Mixed
No

6.2 Audio algorithm at each port G.711, G.728, G.722, 
MPEG4 AAC (monaural 
only)

G.711, G.728, G.722, 
MPEG4 AAC (monaural 
only)

7 Video Processor (motion 
pictures)

Equipped Equipped

7.1 Switched/mixed Voice activated/three-
split/four-split/six-split/
nine-split/user control

Voice activated/three-
split/four-split/six-split/
nine-split/user control

7.2 Video algorithm at each port H.261, H.263, H.264 H.261, H.263, H.264

8 Data Processor Equipped Equipped

8.1 Data broadcast facility, LSD
Data broadcast facility, HSD

Equipped
No

–
–

8.2 MLP Processor Equipped –

9 Encryption Support Support
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10 Method of choosing Selected 
Communication Mode - SCM

Custom:
Number of lines (1B/
2B/4B/6B)
Audio algorithm 
(G.711, G.728, G.722, 
MPEG4 AAC)

Auto:
Video frame rate (7.5/
10/15/30fps)
Video encoding mode 
(CIF/QCIF)

Fixed or switched 
automatically:

Video algorithm 
(H.261 fixed, H.261, 
H.263 or H.264 
switched 
automatically)
Restrict (56K fixed/
Auto)

Custom: 
LAN bandwidth 
(Restricted on maximum 
value of total bit rate of 
all points)

Audio algorithm 
(G.711, G.728, G.722, 
MPEG4 AAC)

Auto:
Video frame rate (7.5/
10/15/30fps)
Video encoding mode 
(CIF/QCIF)

Fixed or switched 
automatically:

Video algorithm 
(H.261 fixed, H.261, 
H.263 or H.264 
switched 
automatically)

11 Capability of secondary 
terminals

Capable of audio 
transmitting/receiving 
and video receiving only.
Capable of audio 
transmitting/receiving 
only via a normal phone.

Capable of audio 
transmitting/receiving 
and video receiving only.
Capable of audio 
transmitting/receiving 
only via a normal phone.

12 Call setup provision(s) No call/receive 
reservation

No call/receive 
reservation

13 Control capabilities – –

13.1 Numbering of terminals
Simple chair control using BAS

No
No

Equipped
No

13.2 MLP facilities (T.120) No No

13.3 H.224 (simplex data) Equipped Equipped

14 Cascading No Equipped

14.1 Fixed rates (“simple”) No No

14.2 Master/Slave No Equipped

15 Terminal identification No Equipped

16 MBE capability No –

Number Attribute Value (H.320 MCU) Value (H.323 MCU)
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This chapter describes the Web Control Functions used when operating the 
PCS-XG100S/XG77S. 
The Web Control Function helps you control the PCS-XG100S/XG77S, or 
change its setup configuration, using a Web browser installed on your PC, such 
as Internet Explorer.

Internet Explorer is a product of the Microsoft Corporation. Please use Version 
7.0, or above.

Chapter 7: 
Web Control 
Function
210
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Opening the Web Page
Enter the IP address assigned to the PCS-XG100S/XG77S in the address line 
of your browser.
Example: For IPv4 addresses

http://xxx.xxx.xxx.xxx/
(“xxx.xxx.xxx.xxx” represents the IPv4 address.)

Example: For IPv6 addresses
http://[xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx]/
(“xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx” represents the IPv6 
address.)

When a proxy server in an external network segment has been set, the Gateway address 
in the PCS-XG100S/XG77S LAN setup must also be set. Or set your Web browser 
proxy setting to “No Proxy” for the PCS-XG100S/XG77S.

Note
211Opening the Web Page



Identifying a User
Once you reach the Web page, the following window will be displayed asking 
you to identify yourself as the user.

Enter one of the following user names (see below) into the “User Name” box 
and the corresponding password into the “Password” box, then click the [OK] 
button.
Each character of a password is shown as “*” on the screen. 
When the user name and password are correct, the “Home” menu will come 
up. 
If an incorrect user name or password is entered, you are asked to enter it again. 
When the incorrect entries are made three times, an error message appears on 
the screen.

You can select a user name from the following and enter the password for the 
selected user name.

[remote]
Enter the Remote Access Password set in the Administrator setup menu. You 
can access and check the “Phonebook” and “Setup” pages.

[address]
Enter the Phone Book Modification Password set in the Administrator setup 
menu. You can access the “Phonebook” page, change the setting of the page, 
and register a new entry onto the page. And you can check the “Setup” pages.

[sonypcs]
Enter the Administrator Password set in the Administrator setup menu. You 
can access the “Phonebook” page, change the setting of the page, and register 
a new entry onto the page. And you can check and modify the “Setup” pages.
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[streaming]
Enter the Streaming Broadcast Password of the terminal transmitting via 
streaming broadcast. You can receive and view the contents of the transmitted 
communication.

[setting]
Enter the Save Settings Password set in the Administrator setup menu. You can 
check and modify the settings in the “Phonebook” page or register new entries. 
You can also check the settings in the “Setup” page and modify settings other 
than administrator settings.

• If passwords have not been registered, leave the “Password” box blank and click the 
[OK] button.

• The Administrator Password, Phone Book Modification Password, Save Settings 
Password, Remote Access Password, and Streaming Broadcast Password are 
registered in the Password page of the Administrator setup menu.

• When you enter a password to access the Web page, the password authorization will 
be valid until you quit the Web browser. If you simply close the Web browser without 
quitting, the access authorization will still be valid when you open the Web browser 
again.

• Depending on the operating environment, unauthorized third parties on the network 
may be able to access the system. We strongly recommend configuring all of the 
passwords for security purposes. Configure all the passwords on the Password page 
(page 85) of the Administrator setup menu.

Notes
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Selecting a Menu
By clicking a menu name on the left part of the page, you can display the 
corresponding menu page. 

[Home]
Displays the “Home” menu to select the line I/F to connect to a remote party, 
enter the address of the remote party and dial. The information icons for this 
system are also displayed.

[Download]
Displays the “Download” menu to download logs.

[Control Pad]
Displays the control panel to control the system.

[Remote Commander]
Displays the image of the Remote Commander (PCS-RFZ1) supplied with the 
system. It allows you to perform the same operations as those on the Remote 
Commander.

Menu items
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How to Use [Home] Menu
When you click [Home] on the left part of the page, the Home menu appears. 
You can also display the Home menu by entering the correct password on the 
name entry screen.

To dial by entering a number

1 Select the line interface (IP, ISDN or SIP).
2 Enter the telephone number or address of a remote party into the text box.
3 Click the [Connect] button.
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How to Use [Download] Menu
When you click [Download] on the left part of the page, the Download menu 
appears.
Various log files can be shown.

Select the log file you want to display, and click the [Download] button. You 
can check the log files in a separate window.
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How to Use [Remote Commander] Menu
When you click [Remote Commander] on the left part of the screen, the 
Remote Commander image appears.

By clicking the various buttons on the Remote Commander image, you can 
control the system in the same way you can when using a real Remote 
Commander (PCS-RFZ1), operating the camera, and dialing phone numbers.
217How to Use [Remote Commander] Menu



Selecting a Tool
By clicking the tools button on the top part of the page, you can jump to the 
corresponding tools page.

[Connect/Disconnect]
Calls a remote party using direct dialing and ends a communication.

[Phonebook]
Displays the dial list of the Phonebook.
Connects from the Phonebook.
Registers, confirms, or edits the dial list.

For a private phone book, the “Phonebook” button changes to the “Private 
Phonebook” button.

[Shared Phonebook]
You can use the Shared Phone Book.

[History]
Displays the Dial, Answer and Missed Call history lists.
Dials from the history.
Deletes an unnecessary history record.

[Setup]
Confirms or modifies the setup.

[Information]
Confirms the machine information, peripheral status and communication 
mode.
You can also check the network routing, and can display the recorded files on 
a USB storage device.

[Monitor]
You can monitor the picture on the Communication System.

When “Web Monitor” is set to “Off” on the Access Permit page of the Administrator 
setup menu, you cannot use the [Monitor] page.

[Streaming]
You can watch the live stream of a communication.

• QuickTime version 6.0 or above is needed to view a communication.
• When “Streaming” is “Disabled” on the Streaming/Recording page of the 

Administrator setup menu, the communication cannot be watched. 

Note

Notes
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You can select the background of the Home menu and the logo that is 
displayed while the system is running.

• The KIOSK Mode setting can only be configured when the Web Control Function is 
accessed using the Administrator Password.

• For detailed information on the KIOSK Mode setting, consult your Sony dealer.

1 Click [Setup] at the top of the screen.
2 Click [Admin:Etc] that appears on the left side of the screen.

The “Admin:Etc” screen appears.
(You can only configure this setting when “sonypcs” has been entered as 
the user name.)

3 Set “KIOSK Mode” to “On”.
4 Click the [Save] button.

After saving is complete, the page display is refreshed.

To turn the power off during KIOSK Mode, press the 1 (power) switch on the 
Communication System twice.

How To Configure KIOSK Mode

Notes

Note
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How to Use [Version Up] Page
When you click [Setup] on the top part of the page, [Version Up] appears on 
the lower left of the page. 
Clicking [Version Up] displays the [Version Up] page.

Click [Reference] and select the software you want to upgrade, then click the 
[Upload] button.
When upload is complete, a message appears and the version upgrade begins. 
After the upgrade is complete, the system reboots. Do not turn off the power 
until rebooting is complete.
You can also upload Phone Books and configuration files by selecting them 
with [Reference].

Version Up
220 How to Use [Version Up] Page
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How to Use [Streaming] Page
1 On the user name entry screen, enter “streaming” in the [User Name] box 

and the Streaming Password of the terminal transmitting via streaming 
broadcast in the [Password] box.

2 Click the [Streaming] button to start QuickTime and start watching a 
communication.

• QuickTime version 6.0 or above is required to view a communication. If QuickTime 
is not installed on your computer, download it for free from the following Web site:
http://www.apple.com/quicktime/download/

• When “Streaming” is “Disabled” on the Streaming/Recording page of the 
Administrator setup menu, the communication cannot be watched. 

• Depending on Web access limitations, about 10 terminals can view a streaming 
broadcast simultaneously. The actual number of terminals that can view the broadcast 
simultaneously depends on your system’s operating environment.

Notes
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How to Use [Monitor] Page

When you click [Monitor] of the tools buttons, the [Monitor] page opens. You 
can monitor the picture on the Communication System.

When “Web Monitor” is set to “Off” on the Access Permit page of the Administrator 
setup menu, or while the encrypted connection is made, you cannot use the [Monitor] 
page.

Note
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Camera units are not supplied with the PCS-XG100S/XG77S.
We recommend using the PCSA-CXG100, EVI-H100V, EVI-HD7V, and 
EVI-HD3V HD camera units with this system.

For details on operations and settings, refer to the operating instructions for 
the camera unit.

The system configuration examples and other illustrations in this manual depict the 
PCSA-CXG100 camera unit as an example.

Chapter 8: 
Camera Units

Note
223



HD Camera Unit Features

• The 1/2.8 type Exmor CMOS camera (utilising approximately 2 million 
valid pixels) allows for high-definition shooting with superior picture 
quality.

• Adopts 20 times optical magnification, F1.6 high power and luminous zoom 
lens.

• The camera has a variety of HD video format choices and digital and 
analogue interface connectors. The camera has a DVI-I (VIDEO OUT) 
connector supporting both digital and analogue output.

• The 1/2.8 type Exmor CMOS camera (utilising approximately 2 million 
valid pixels) allows for high-definition shooting with superior picture 
quality.

• Adopts 20 times optical magnification, F1.6 high power and luminous zoom 
lens.

• By adopting its wide and dynamic range functions, you can see the optimised 
shooting image which incorporates bright and dark subjects at the same time.

• The camera has a variety of HD video format choices and digital and 
analogue interface connectors. The camera has a DVI-I (VIDEO OUT) 
connector supporting both digital and analogue output.

• Adopts the industry standard RS-232C interface of VISCA camera protocol 
in external communication. It is possible to operate from long distances by 
using both RS-232C and RS-422.

• You can install the camera on ceilings due to the functions of high-speed and 
wide range pan/tilt action and vertical image flip.

• You can use the infrared remote commander to set the camera and also to 
select panning, tilting and zooming from the setting menu.

• You can store up to 6 kinds of camera direction and camera status into the 
camera.

CMOS camera with high image quality
The CMOS image sensor allows high-definition shooting with superior picture 
quality.

PCSA-CXG100

EVI-H100V

EVI-HD7V/HD3V
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Silent, high-speed pan and tilt action 
By adopting the DD motor mechanism, in addition to high-speed pan/tilt 
action, improvement of the noise reduction mechanism lets you use the camera 
for a variety of purposes.

Video format compatible with 60/50 Hz progressive scan
The EVI-HD7V camera allows you to shoot moving objects in Full HD 
progressive scan for high-resolution image output. The EVI-HD7V also allows 
output in the interlaced format used in HDTV broadcasts.
Including 59.94 Hz and 50 Hz frequencies, the EVI-HD7V camera is 
compatible with a total of 11 video formats, while the EVI-HD3V is 
compatible with a total of 5 video formats.

DVI-I video output 
The DVI-I (VIDEO OUT) connector supports both digital and analog output.

VISCA camera protocol supported
The camera is equipped with an RS-232C communication interface. You can 
select the baud rate of either 38,400 bps or 9,600 bps. This allows you to 
remotely control the camera at a high communication speed.
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HD Camera Unit 
Parts Identification

This camera unit is not supplied with the 
PCS-XG100S/XG77S.

Camera

Front

a Lens
This is a 20-magnification optical zoom 
lens.

b POWER lamp
Lights when the camera is connected to 
an AC outlet using the supplied AC 
power adaptor and AC power cord.
Flashes in green when the camera 
receives an operation command from the 
supplied remote commander.
It takes about 7 to 16 seconds to display 
the image after the lamp lights.

c STANDBY lamp
Lights when the camera is turned off 
using the remote commander.

Rear

d Remote sensors
Used only for servicing.

e IMAGE FLIP switch
Flips the image upside down. Normally 
set this to OFF when you use the camera. 
When the camera is attached to the 
ceiling, set this to ON. Before you set the 
IMAGE FLIP switch, turn off the 
camera (or set to standby mode) and 
then, turn the power on by connecting 
the power adaptor or by using VISCA 
control or the remote commander. When 
you switch this, the preset setting is 
returned to the initial setting.

f IR SELECT switch
Used only for servicing.

g VISCA RS-422 connector
Used only for servicing.

PCSA-CXG100

Note

2 3

1

4

8 9 0 qa qs

5 6 7
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h SYSTEM SELECT switch

The factory default position is “1”. Do not 
change this position, as the other positions 
are used only for servicing.

i VIDEO OUT connector
Supplies the image as digital signals. An 
analog component signal is also output 
from this connector.

j VISCA IN connector
Connect to a computer via an RS-232C 
interface. When you connect multiple 
cameras, connect it to the VISCA OUT 
connector of the previous camera in the 
daisy chain connection.

k VISCA OUT connector
When you connect multiple cameras, 
connect it to the VISCA IN connector of 
the next camera in the daisy chain 
connection.

l DC 12V connector
Connect the camera cable supplied with 
the PCS-XG100S/XG77S.

Bottom

m BOTTOM switches
This switch is used only for servicing.

Do not change the factory default position 
displayed at the bottom of the unit.

n Tripod screw hole

o Ceiling bracket mounting screw 
holes

The nameplate is located on the bottom.

This camera unit is not supplied with the 
PCS-XG100S/XG77S.

Note

Note

Important

EVI-H100V

Note

qd qf qg

qg qg
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Camera

Front

a Lens
This is a 20-magnification optical zoom 
lens.

b Remote sensors
These are sensors for the supplied 
remote commander.

c POWER lamp
Lights when the camera is connected to 
an AC outlet using the supplied AC 
power adaptor and AC power cord.
Flashes in green when the camera 
receives an operation command from the 
supplied remote commander.
It takes about 7 to 16 seconds to display 
the image after the lamp lights.

d STANDBY lamp
Lights when the camera is turned off 
using the remote commander.

Rear

e Remote sensors
These are sensors for the supplied 
remote commander.

f IMAGE FLIP switch
Flips the image upside down. Normally 
set this to OFF when you use the camera. 
When the camera is attached to the 
ceiling, set this to ON. Before you set the 
IMAGE FLIP switch, turn off the 
camera (or set to standby mode) and 
then, turn the power on by connecting 
the power adaptor or by using VISCA 
control or the remote commander. When 
you switch this, the preset setting is 
returned to the initial setting.

g IR SELECT switch
Select the camera number when you 
operate multiple cameras with the same 
remote commander.

This is not available on the PCS-XG100S/
XG77S.

2 3 4

1

Note

5

9 0 qa qs qd

6 7 8
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h VISCA RS-422 connector

To communicate via RS-422, use this 
connector.
Use the supplied VISCA RS-422 
connector plug.

This is not available on the PCS-XG100S/
XG77S.

i SYSTEM SELECT switch
Used for selecting the video format of 
the signal to be output from the VIDEO 
OUT connectors.

For details, see “Setting of the SYSTEM 
SELECT switch” (page 229).

j VIDEO OUT connector
Supplies the image as digital signals. An 
analog component signal is also output 
from this connector.

k VISCA IN connector
Connect to a computer via an RS-232C 
interface. When you connect multiple 
cameras, connect it to the VISCA OUT 
connector of the previous camera in the 
daisy chain connection.

l VISCA OUT connector
When you connect multiple cameras, 
connect it to the VISCA IN connector of 
the next camera in the daisy chain 
connection.

m DC 12V connector
Connect the camera cable supplied with 
the PCS-XG100S/XG77S.

Bottom

n BOTTOM switches
Used for RS-232C and RS-422 
switching, 9,600 bps and 38,400 bps 
baud rate selection, D70 mode switching 
and IR signal output setting. 

For details, refer to the Technical 
Manual for the camera unit.

This is not available on the PCS-XG100S/
XG77S.

o Tripod screw hole

p Ceiling bracket mounting screw 
holes

The nameplate is located on the bottom.

Setting of the SYSTEM SELECT 
switch
This switch allows you to select the video 
format of the signal to be output from the 
VIDEO OUT connectors.

Note

Note

Important

qf qg qh

qh qh
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• Be sure to set this switch before 
connecting the PCS-XG100S/XG77S.

• Be sure to use a Phillips-head screwdriver 
when changing the switch position. If you 
use a tool other than the designated 
screwdriver, the crossed groove may be 
damaged.

• HDTV video signal outputs display 
without distortion on monitors with 16:9 
aspect ratios.

Yes: Outputs the image signal.
No: Does not output the image signal.
LB: Abbreviation of LETTER BOX. A 

video signal with the 16:9 aspect ratio 
is output by adding a blank area (no 
signal, black) top and bottom to 
display the image without distortion on 
a monitor that uses the 4:3 aspect ratio.

If the switch position is set to “no output,” the 
camera cannot be used.

Setting of the BOTTOM switches

Do not change the BOTTOM switches from 
their factory default positions.

This camera unit is not supplied with the 
PCS-XG100S/XG77S.

Notes

Switch 
position

Video format Support

0
1080i/
59.94(29.97PsF) –

59.94 Hz 
system

1 1080p/29.97 Yes

2 720p/59.94 Yes

3 720p/29.97 Yes

4 NTSC(LB) No

5 No output – –

6 No output – –

7 VISCA Control Yes –

Set this arrow to 
the desired video 
format.

8 1080i/50(25PsF) Yes

50 Hz 
system

9 1080p/25 Yes

A 720p/50 Yes

B 720p/25 Yes

C PAL(LB) No

D No output – –

E No output – –

F No output – –

Note

Note

EVI-HD7V/HD3V

Note

Switch 
position

Video format Support

1 2 3 4 5
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Camera

Front

a Lens
This is a 10-magnification optical zoom 
lens.

b Remote sensors (for camera 
adjustment)
These are sensors for the supplied 
remote commander.

This is not available on the PCS-XG100S/
XG77S.

c POWER lamp
Lights when the camera is connected to 
an AC outlet using the supplied AC 
power adaptor and AC power cord.
Flashes in green when the camera 
receives an operation command from the 
supplied remote commander.

d STANDBY lamp
Lights when the camera is turned off 
using the remote commander.

Rear

e DC IN 12V connector
Connect the camera cable supplied with 
the PCS-XG100S/XG77S.

f SYSTEM SELECT switch
Used for selecting the video format of 
the signal to be output from the VIDEO 
OUT connectors.

For details, see “Setting of the SYSTEM 
SELECT switch” (page 232).

g IR SELECT switch
Select the camera number when you 
operate multiple cameras with the same 
remote commander.

This is not available on the PCS-XG100S/
XG77S.

h VISCA IN connector
Connect to a computer via an RS-232C 
interface. When you connect multiple 
cameras, connect it to the VISCA OUT 
connector of the previous camera in the 
daisy chain connection.

i VISCA OUT connector
When you connect multiple cameras, 
connect it to the VISCA IN connector of 
the next camera in the daisy chain 
connection.

Note

1

32 4

Note

56 789 0
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j VIDEO OUT connector
Supplies the images as an analog 
component signal. Digital signals are 
also output from this connector.

Bottom

k BOTTOM switches
Used for RS-232C baud rate selection, 
turning the remote control signal output 
on/off, and selecting whether to add 
sync.

This is not available on the PCS-XG100S/
XG77S.

l Tripod screw holes (1/4-20UNC)
When you install the camera to a tripod, 
secure the tripod to these screw holes.

m Fixing screw holes (M3)
Used for fixing the camera to a fitting 
using M3 screws.

Setting of the SYSTEM SELECT 
switch
This switch allows you to select the video 
format of the signal to be output from the 
VIDEO OUT connectors.

• Be sure to set this switch before 
connecting the PCS-XG100S/XG77S.

• Be sure to use a Phillips-head screwdriver 
when changing the switch position. If you 

use a tool other than the designated 
screwdriver, the crossed groove may be 
damaged.

• HDTV video signal outputs display 
without distortion on monitors with 16:9 
aspect ratios.

Note

Notes

qaqs

qd

Switch 
position

Video 
format

EVI-HD7V 
support

EVI-HD3V 
support

0 1920×1080p
/59.94 Yes No

59.94 Hz 
system

1
1920×1080p
/29.97 Yes No

2 1920×1080i
/59.94 Yes No

3
1280×720p/
59.94 Yes Yes

4 1280×720p/
29.97 Yes Yes

5
640×480p/
59.94(LB) Yes Yes

6 No output – – –

7
VISCA 
CONTROL Yes Yes –

8 1920×1080p
/50 Yes No

50 Hz 
system

9
1920×1080p
/25 Yes No

A 1920×1080i
/50 Yes No

B
1280×720p/
50 Yes Yes

C 1280×720p/
25 Yes Yes

Set this arrow to 
the desired video 
format.
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Yes: Outputs the image signal.
No: Does not output the image signal.
LB: Abbreviation of LETTER BOX. A 

video signal with the 16:9 aspect ratio 
is output by adding a blank area (no 
signal, black) top and bottom to 
display the image without distortion on 
a monitor that uses the 4:3 aspect ratio.

If the switch position is set to “no output,” the 
camera cannot be used.

Setting of the BOTTOM switches

Do not change the BOTTOM switches from 
their factory default positions.

PCSA-CXG100/EVI-H100V

Setting the range of LEFT/RIGHT 
movement

Setting the range of UP/DOWN 
movement

D No output – – –

E No output – – –

F No output – – –

Note

Note

Switch 
position

Video 
format

EVI-HD7V 
support

EVI-HD3V 
support Pan/Tilt Range

–170° 170°

CENTER (±0°)

(IMAGE FLIP : OFF)

+90°

–20°
 ±0°

(IMAGE FLIP : OFF)
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EVI-HD7V/HD3V

Setting the range of LEFT/RIGHT 
movement

Setting the range of UP/DOWN 
movement

Phenomena Specific 
to CMOS Image 
Sensors

The following phenomena that may appear 
in images are specific to CMOS 
(Complementary Metal Oxide 
Semiconductor) image sensors. They do not 
indicate malfunctions.

White flecks
Although the CMOS image sensors are 
produced with high-precision technologies, 
fine white flecks may be generated on the 
screen in rare cases, caused by cosmic rays, 
etc.
This is related to the principle of CMOS 
image sensors and is not a malfunction.

The white flecks especially tend to be seen 
in the following cases:
• when operating at a high environmental 

temperature
• when you have raised the gain (sensitivity)

This phenomenon may be improved when 
you turn the power of the System off and on.

Aliasing
When fine patterns, stripes, or lines are shot, 
they may appear jagged or flicker.

CENTER (±0°)

 +100° –100°

±0°

 +25°

–25°
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Location and 
Function of Parts 
and Controls

Front

a 1 (power) switch
Turns on/off the system.
The switch indicator blinks green when 
the power switch is first turned on, then 
remains steadily lit green. The indicator 
lights orange when the system is set to 
standby mode.

b LAN 1 ALERT indicator
When the system is connected to LAN 
via the 1 connector on the rear, this 
indicator lights in yellow when packet 
error (loss) or link error occurs during 
communication.

This indicator is labeled LAN ALERT on 
the PCS-XG77S.

c LAN 2 ALERT indicator 
(PCS-XG100S only)
When the system is connected to LAN 
via the 2 connector on the rear, this 

indicator lights in yellow when packet 
error (loss) or link error occurs during 
communication.

d ON LINE indicator
Blinks in blue while dialing or receiving 
a call, and stays lit in blue during 
communication.

e  (USB) ports
Insert USB storage devices (not 
supplied) here.
You can also connect a pen tablet (not 
supplied) for annotation here.

Rear

a CAMERA connector
Connect to the VIDEO OUT connector 
on the HD camera unit.

When you connect the Camera cable of the 
unit to peripheral device, use the supplied 
cable to prevent malfunction due to 
radiation noise.

b HDMI IN connector (PCS-XG100S 
only)
Connect to the HDMI output on the 
optional second camera or video 
equipment.

We recommend using Sony’s HDMI 
cable.

Appendix

PCS-XG100S/XG77S HD 
Visual Communication 
System

Note

1

2 3 4

5

CAUTION

Note

1 2 3 4 5 6 7 8

qjqhqgqdqsqa09 qf
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c DVI-I 1 IN connector
Connect to the DVI output of the 
optional camera unit or video 
equipment.

d DVI-I 2 (PC) IN connector
Connect to the DVI output of the 
optional computer or video equipment.

e MIC (A1) 1 (R) / 2 (R) / 3 (R) / 4 (L) 
/ 5 (L) / 6 (L) jacks (minijack)
Connect to the PCS-A1 microphones 
(supplied). Power is supplied to the 
microphones from the System.

f AUDIO 1 IN L/R and AUDIO 2 IN 
L/R jacks (phono jack)
Connect to the audio outputs of the 
optional VCR or audio equipment.

g AUDIO OUT L/R jacks (phono 
jack)
Connect to the audio inputs of the TV 
monitor.

h REC OUT L/R connectors (phono 
jack)
Used when recording the audio signals 
to minute a communication. The mixed
sounds of the local and remote parties 
are output from these connectors.

i HDMI-1 OUT connector
Connect to the HDMI input of the 
optional TV monitor.

When you connect the HDMI cable of the 
unit to peripheral device, use the supplied 
cable to prevent malfunction due to 
radiation noise.

j HDMI-2 OUT connector 
(PCS-XG100S only)
Connect to the HDMI input of the 
optional TV monitor.

We recommend using Sony’s HDMI 
cable.

k DVI-I OUT connector
Connect to the DVI input of the optional 
computer or video equipment.

l 1 (LAN1) connector 
(1000BASE-T/100BASE-TX/
10BASE-T, 8-pin modular)
Used to connect via a LAN or a SIP. 
Connect to a hub or a SIP server using 
the category 6 cable.

This connector is labeled  (LAN) on the 
PCS-XG77S.

m 2 (LAN2) connector 
(1000BASE-T/100BASE-TX/
10BASE-T, 8-pin modular) 
(PCS-XG100S only)
Used to connect via a LAN. Connect to 
a hub, etc. using the category 6 cable.

For safety, do not connect the connector 
for peripheral device wiring that might 
have excessive voltage to the following 
ports.
:  (LAN) 1 connector
:  (LAN) 2 connector
Follow the instructions for the above ports.

n ISDN UNIT connector
Connect to the TERMINAL connector 
on the optional PCSA-B384S or 
PCSA-B768S ISDN Unit.

o AUX CONTROL connector (D-sub 
9-pin)
Used for maintenance service.

p MAINTENANCE connector (D-sub 
9-pin)
Used for maintenance service.

q DC 19.5V jack
Connect the supplied AC Power 
Adaptor.

CAUTION

Note

Note

CAUTION
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You can set the volume of beep that sounds 
by pressing a button on the Remote 
Commander using the menu. You can also 
set for the beep not to sound.

For the setting, see “Beep Sound” in the 
Audio setup menu on page 70.

a PRESENTATION button
Starts or stops transmission of 
presentation data.

b F1 to F4 (function) buttons
The function buttons are used for 
various operations according to the 
situation.
The current function of the buttons is 
guided at the bottom of the menu screen.

c LAYOUT button
Displays the Layout menu to select the 
screen display pattern.

d VOLUME +/– buttons
Adjust the volume of the sound received 
from a remote party.
+: to increase the volume
–: to decrease the volume

e Arrow buttons (V/v/B/b)
Used to select the menu or make various 
settings in the menu.

f ENTER button
Executes the selection or setting in the 
menu and goes to the next step.

g RETURN button
Used to return to the previous step.

h CONNECT ( ) button
Used to connect a remote party for 
communication.

i Number (0-9, , ) buttons
Used to enter the letters or numbers of a 
telephone number, etc.

j Battery compartment (rear)
Insert two size AA (R6) batteries. 

k @/1 (power on/off) button
Sets the System to standby mode when it 
is turned on. Turns on the System when 
it is in standby.

l VIDEO INPUT button
Displays the Video Input menu to switch 
the video input signal to be displayed on 
the monitor TV.

m CAMERA button
Displays the Camera menu to adjust the 
camera angle, brightness, etc.

n ZOOM (T/W) buttons
Zooms in or out.
T: to enlarge the picture

PCS-RFZ1 RF Remote 
Commander (Supplied)

F1 F2 F3 F4

T

W

1 2 3

4 5 6

7 8 9

0

/

RFZ

GHI JKL MNO

PQRS TUV WXYZ

ABC DEF

PRESENTATION

LAYOUT

RETURN

CONNECT

ON/OFF

MIC

BACK
SPACE DISCONNECT

TONE DOT

TOOLS

VOLUME ZOOM

ENTER

VIDEO INPUT CAMERA

PCS-RFZ1

1

2

3

4

5

6

7
8

9

qa

0

qs

qd

qf

qg
qh

qj

qk
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W: to reduce the picture

o TOOLS button
Displays the Tools menu.

p DISCONNECT ( ) button
Used to disconnect a remote party in 
communication.

q BACK SPACE button
Deletes the letter entered last.

r MIC ON/OFF button
Turns off the local sound to be sent to a 
remote party. To restore the sound, press 
the button again.

a POWER indicator
Lights in orange when power is supplied 
to the ISDN Unit. When initializing is 
complete, blinks in green.

b STATUS 1-3 indicators
Lights in orange when link 
synchronization of each ISDN connector 
is established. Lights in yellow when 
each ISDN line is connected.

c ISDN 1-3 terminals (8-pin modular 
jack)
Connect to the ISDN lines using the 
ISDN modular cable.

d TERMINAL connector
Connect to the ISDN UNIT connector 
on the System with the interface cable 
supplied with the ISDN Unit.

PCSA-B384S ISDN Unit 
(Optional)

Front/Upper panel

Rear
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a POWER indicator
Lights in orange when power is supplied 
to the ISDN Unit. When initializing is 
complete, blinks in green.

b STATUS 1-6 indicators
Lights in orange when link 
synchronization of each ISDN connector 
is established. Lights in yellow when 
each ISDN line is connected.

c ISDN 1-6 terminals (8-pin modular 
jack)
Connect to the ISDN lines using the 
ISDN modular cable.

d TERMINAL connector
Connect to the ISDN UNIT connector 
on the System with the interface cable 
supplied with the ISDN Unit

PCSA-B768S ISDN Unit 
(Optional)

Front/Upper panel

Rear
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Indicators
The following icons appear on the monitor depending on the functions being used.
Indicators marked with an asterisk (*) do not appear on the PCS-XG77S.

Indicator Name Description
Near camera 
control

Local camera being controlled

Far camera 
control

Remote camera being controlled

Mic off 
(Near)

Local microphone is turned off in 
communication or not in 
communication.

Mic off (Far) Remote microphone is turned 
off in communication or not in 
communication.

Volume Volume of remote party’s voice 
being adjusted

Audio level 
(stereo)

Audio input level of stereo sound

Audio level 
(monaural)

Audio input level of monaural 
sound

Character 
input mode

Character input available

LAN status 
(LAN1)

LAN connected via the 1 
connector (  connector on the 
PCS-XG77S) using Internet 
Protocol version 4 (IPv4).

LAN status 
(LAN2)

LAN connected via the 2 
connector using IPv4.

LAN status 
(LAN1, 
IPv6)

LAN connected via the 1 
connector (  connector on the 
PCS-XG77S) using Internet 
Protocol version 6 (IPv6).

ISDN status Used ISDN ports 

NEAR

NEAR

*
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Audio input Selected audio input (example of 
the input from the MIC(A1) 
connector)

Video input Selected video input (example of 
the video from the DVI-I 1 IN 
connector)

ISDN 
(telephone) 
mode

Audio only communication in 
progress 

USB storage USB storage device is inserted in 
the System.

Preset load Recalling the preset camera 
settings (1-6)

Presentation 
(transmitting)

Presentation Executing 
(transmitting the presentation data 
to a remote party)

Presentation 
(receiving)

Receiving the presentation data 
from a remote party

Streaming Stream broadcast in progress

Recording Recording in progress

Tablet Pen tablet connected

Drawing 
(near)

Drawing rights belong to the local 
party.

Drawing (far) Drawing rights belong to the 
remote party.

Pointer (near) Local party’s pointer

Indicator Name Description

–
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Pointer (far) Remote party’s pointer

Encryption Connected with encryption

Packet loss Packet loss occurring

Voice 
Activate 
mode

“Voice Activate” is selected in 
“Broadcast Mode” in a multipoint 
connection.

Broadcast 
(Near)

Local picture is broadcast in a 
multipoint connection.

Broadcast 
(A-H)

Terminal A (-H) connected first 
(-eighth) is broadcast in a 
multipoint connection.

Indicator Name Description

–
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On-Screen Messages
Check the following if a message appears on the TV monitor when operating 
the Communication System.

Message

Cannot complete connection. (The following code and message appear.)

0 Unknown network error: Try again later.

1 Number does not exist: Check the number and try again.

2 Network congestion: Try again later.

3 Try again later.

16 Normal disconnection: (The line has been disconnected normally.)

17 Line is busy: Try again later.

18,19 System not responding: Check if the remote system is connected.

20 No such subscriber: Confirm the site number.

21 Call rejected: Check if the remote system is connected.

22 Called party number changed: Check the number and try again.

26 Connection restoration request: Try again later.

27 Remote system out of order: Check if the remote system is operational.

28 Invalid number entered: Check the number and try again.

31, 41 – 43, 47
Network not available: Try again later.

33, 34
Line is busy. Try to dial again later.

44 Network not available: Line is busy. Try again later.

50 Not a Subscriber: Check the remote party’s facility contract.

57,58 Bearer capability not authorized: Check if “Restrict” is set correctly.

70 Restricted capability: Set “Restrict” to “56K” and try again.

88 Terminal attribute error: Check the connection of the remote system.

91, 95 – 102, 111
Protocol error: Turn off and restart the system and try again.

128 H.221 negotiation timeout: Restart the system and connect again.

131 Board mismatch: Check the optional line interface boards.

132 Invalid SPID: Reregister the SPID.

134 Physical link synchronization error: Check the connection of the ISDN cable.

144, 145
The remote terminal may not be compatible with the BONDING function.

177 LAN connection timeout: Try again later.
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178 LAN connection rejected: Try again later.

179 DNS error.

180 Dialing your own number is invalid.

181 GateKeeper error.

192 PPPoE server admission has failed. Check the PPPoE User Name and Password are 
entered correctly.

195 Now obtaining an IP address via DHCP.

196 Configure the DNS address or use the IP address to dial.

205 Check the user name or user number for dialing is correct.

207 The remote terminal may not be registered in gatekeeper. Contact the gatekeeper 
administrator.

209 – 212
Gatekeeper does not respond. Contact the gatekeeper administrator, or use the IP address 
to dial.

201, 217
Call not responded.

218 Local number is not set correctly in the ISDN Setup menu. Set it correctly. Line 
connected with 1B (64K).

219 Local number setting for ISDN configuration may not be correct in the remote party. 
Line connected with 1B (64K).

230, 231
PPPoE server admission fails. Dial again after confirmation of the PPPoE settings.

232 Access to the DNS server has failed. Check the PPPoE DNS settings.

233 Connection to the remote party via DNS disabled. Dial using IP address.

234 Dialing the same address is invalid.

235 Regarded as a secondary terminal as the number of lines for ISDN configuration is 
different.

236 Regarded as a secondary terminal as Far End Camera Control is set to Off.

237 Check the line interface or the IP address is set correctly.

238 The conference could not start because the encryption feature at the near-end side was 
disabled.

239 The conference could not start because the encryption feature at the far-end side was 
disabled.

240 The conference could not start because the signal encryption method at the near-end side 
differed from that of the far-end side.

241 The standard encryption videoconference with SIP connection is not available.

242 The Proprietary encryption videoconference with ISDN connection is not available.

243 Connection with the current communication mode is not available via the specified line 
interface.

244 Disconnected due to failure to receive packet from remote site.

Message
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Troubleshooting
If the Communication System does not function correctly, check the following.

Symptom Cause Solution

The power is not 
turned on.

The power switch is not set to on. Press the power switch to turn on the 
power of the system (page 38).

The batteries in the Remote 
Commander are low or dead.

Replace the batteries with new ones 
(page 35).

The Remote 
Commander does 
not operate.

Pairing with the Remote 
Commander fails.

Perform pairing of the Remote 
Commander with the System (page 
36).

No sound or the 
volume is very low.

The volume of the system is too 
low.

Adjust the sound volume by pressing 
the VOLUME +/– buttons on the 
Remote Commander (page 40).

The volume of the TV monitor is 
too low.

Adjust the volume of the TV monitor.

The microphone on the remote 
party is turned off.

Ask the remote party to turn on the 
microphone.

Audio input is not selected 
properly.

• Set up “Input Select (MIC)” on the 
Basic Setup1 page of the Audio 
setup menu properly (page 68).

• Set up “Audio Input” properly on 
the Basic Setup1 page of the Audio 
setup menu (page 68).

The microphone or external 
equipment is not connected 
correctly.

Check the connection (pages 164 and 
168).

Picture is blurred. Manual focus is selected but picture 
remains blurred.

Adjust the focus (page 141).

When auto focus is selected, the 
background is too bright, contrast is 
too high, or the background or the 
participants’ clothes contain fine 
line patterns.

Select manual focus and adjust 
manually (page 141).

No picture. The selected picture source is not 
tuned on.

Turn on the selected video equipment.

Video input is not selected properly. Select the video input properly (page 
143).

The selected picture source is not 
correctly connected to the system.

Check the connections (page 168).

A voice meeting is held. This is not a malfunction.

Movement of the camera is 
prevented.

Turn off the system, then turn it on 
again.
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No connection. Wrong number was dialed. Check the entered number.

The setting of “Line I/F” is not 
correct (when using direct dialing).

Set “Line I/F” to correct interface 
referring to “Calling a Remote Party 
by Entering Their Address or Number 
Directly (Direct Dial)” (page 109).

The registered items in the Phone 
Book are not correct.

Register the party correctly referring 
to “Registering a Remote Party – 
Phone Book” (page 121).

Some of the system settings are not 
correct.

Set the system settings correctly 
referring to “Registering Local 
Information” (page 58).

The IP address and network mask 
are not set correctly (when using 
LAN).

Ask the system administrator to set 
them correctly (page 74).

The LAN cable is connected to the 
2 connector.

Set “Use LAN2” to “On” in the Line 
I/F setup menu (page 62).
Some of the functions are restricted 
when connecting the LAN cable to 
the 2 connector. SIP connection, 
use of gatekeeper and SNMP, and 
Web and Telnet accesses are not 
available.

The LAN or ISDN cable is 
disconnected.

Connect correctly (pages 31, 32, 33).

The LAN or ISDN cable is 
connected to the incorrect 
connector. 

Connect correctly (pages 31, 32, 33).

The LAN or ISDN cable is down. Replace the cable with a new one.

The cable exclusively designed for 
the ISDN connection is used for 
LAN connection (when using 
LAN).

Use the cable for LAN connection.

Incorrect type of cable (cross or 
straight cable) is used for the LAN 
or ISDN connection.

Use the correct type of cable.

The DSU is turned off (when using 
ISDN).

Turn on the DSU.

Symptom Cause Solution
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No connection. If you disconnect the 
communication with an abnormal 
procedure, e.g., unplugging an 
ISDN cable or turning off the 
system during communication, you 
may not connect to the ISDN line 
for a while (when using ISDN).

Turn off the power of the system and 
wait for a few minutes before turning 
it on again.

If you repeat plugging/unplugging 
or turning on/off, you may not 
connect to the network for a while 
(when using LAN).

Turn off the power of the system and 
wait for a few minutes before turning 
it on again.

LAN connection timeout (when 
using LAN).

Try again later.

Packet for communication is not 
acceptable under the current LAN 
environment (when using LAN).

Consult with the system administrator 
so that the packet for Communication 
becomes acceptable under your LAN 
environment.

The remote terminal is not turned 
on.

Ask the remote party to turn on the 
terminal.

It takes a long time for the remote 
party to be able to answer from the 
standby mode.

Ask the remote party to cancel the 
standby mode.

The remote party is in 
communication with another party.

Call the remote party after they end 
the communication with another 
party.

Answering the call is not permitted 
by the remote terminal as it is 
operating for setups, etc.

Ask the remote party to permit 
answering a call.

The remote terminal is not set to 
auto answer mode.

Ask the remote party to set the 
terminal to auto answer mode, or to 
answer a call manually.

The ISDN telephone numbers are 
not set up in the remote terminal 
(when using bonding).

Ask the remote party to set up “Area 
Code” and “Local Number” in the 
ISDN Setup menu correctly (page 
79).

The eighth digit and up of the ISDN 
telephone numbers are not the same 
when connecting using bonding 
(when the remote party uses the 
communication system of an older 
model such as the PCS-1600).

Connect without using bonding, or 
use the ISDN telephone numbers that 
are the same in the eighth digit and 
up.

There is some problem with the 
remote terminal.

Try to dial the number of another 
terminal.

A message appears on the screen. See “On-Screen Messages” (page 
243).

Symptom Cause Solution
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Still pictures or the 
Phone Book cannot 
be saved to the USB 
storage device.

The USB storage device has 
already been recorded to full 
capacity.

Use another USB storage device.

Symptom Cause Solution
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Specifications

This unit is compliant with ITU-T 
Recommendations H.320 and H.323. 

Motion picture
Operating bandwidth

64 Kbps to 16 Mbps (standard, 
LAN connection) (up to 4 Mbps 
on the PCS-XG77S)

56 Kbps to 768 Kbps (when 
installing the PCSA-B768S, 
ISDN connection)

56 Kbps to 384 Kbps (when 
installing the PCSA-B384S, 
ISDN connection)

Coding H.261/H.263/H.263+/H.263++/
H.264 Baseline Profile/H.264 
High Profile

MPEG4 Simple Profile (when 
using SIP)

Picture elements
CIF: 352 pixels × 288 lines
QCIF: 176 pixels × 144 lines
4CIF: 704 pixels × 576 lines
WCIF (W288p): 512 pixels × 288 

lines
W432p: 768 pixels × 432 lines
W4CIF: 1024 pixels × 576 lines
720p: 1280 pixels × 720 lines
1080p: 1920 pixels × 1080 lines 

(PCS-XG100S only)

Sound
Bandwidth 22 kHz (MPEG4 AAC)

14 kHz (MPEG4 AAC)
7 kHz (G.722 compliant with 

ITU-T Recommendation)
3.4 kHz (G.711/G.728 compliant 

with ITU-T Recommendation)
Transmission rate

56 Kbps, 64 Kbps (G.711 
compliant with ITU-T 
Recommendation)

48 Kbps, 56 Kbps, 64 Kbps (G.722 
compliant with ITU-T 
Recommendation)

64 Kbps, 96 Kbps (MPEG4 AAC) 
(when using LAN)

16 Kbps (G.728 compliant with 
ITU-T Recommendation)

48 Kbps (MPEG4 AAC) (when 
using ISDN)

Network
Multiplexing

Video, audio, data
Frame format

H.221 (compliant with ITU-T 
Recommendation)

Interface LAN (standard), 64 Kbps to 
16 Mbps (up to 4 Mbps on the 
PCS-XG77S)

ISDN (BRI), up to 3 lines (when 
installing the PCSA-B384S) 
up to 6 lines (when installing the 
PCSA-B768S)

Data transmission rate
LSD 1.2 Kbps, 4.8 Kbps, 6.4 Kbps
MLP 6.4 Kbps, 24 Kbps, 32 Kbps
HMLP 62.4 Kbps, 64 Kbps, 

128 Kbps
LAN protocol supported

HTTP
Telnet
RTP/RTCP
TCP/UDP 
SNMP
SSH

Remote control
Far end camera control

H.281 (compliant with ITU-T 
Recommendation)

General
Power requirements

DC 19.5 V
Current consumption

5 A
Operating temperature

5 °C to 35 °C (41 °F to 95 °F)
Operating humidity

20% to 80%
Storage temperature

–20 °C to +60 °C 
(–4 °F to +140 °F)

Storage humidity
20% to 80% (no condensation)

Dimensions 370 mm × 60 mm × 244 mm 
(W × H × D) (14 5/8 inches × 
2 3/8 inches × 9 5/8 inches) (not 
including projections except for 
the feet)

PCS-XG100S/XG77S HD 
Visual Communication 
System
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Mass Approx. 2.3 kg (5 lb 1.1 oz)
Supplied accessories

PCS-RFZ1 RF Remote 
Commander (1)

Size AA (R6) manganese batteries 
(2)

PCS-A1 Microphone 
(PCS-XG100S:2 / 
PCS-XG77S:1)

Camera cable 1-846-654-11 
(Sony) (1)

HDMI cable (3 m) (9.8 feet) 
1-838-020-11 (Sony) (1)

AC adaptor (1)
Power cord (1)
CD-ROM (1)
Before Using this Unit (1)
Installation Guide (1)
Quick Connection Guide (1)
User registration form (1) 

(Japan only)

Signal format
Compliant with IEEE802.15.4

Control DC 3V using two size AA (R6) 
batteries

Power requirements
100 V to 240 V AC, 50 Hz/60 Hz, 

1.6 A to 0.7 A
Output DC 19.5 V, 6.2 A
Operating temperature

5 °C to 35 °C (41 °F to 95 °F)
Operating humidity

20% to 80%
Storage temperature

–20 °C to +60 °C 
(–4 °F to +140 °F)

Storage humidity
20% to 80% (no condensation)

Dimensions 140 mm × 63 mm × 30.5 mm 
(W × H × D) (5 5/8 inches × 
2 1/2 inches × 1 1/4 inches) (not 
including projections)

Mass Approx. 400 g (14 oz)

Bandwidth 13 kHz
Directional characteristic

Omnidirectional
Dimensions 74 mm × 16 mm × 93 mm 

(W × H × D) (3 inches × 
21/32 inches × 3 3/4 inches)

Mass Approx. 170 g (6.0 oz)
Power Plug in power
Cable length 8 m (26.2 ft)

PCS-RFZ1 Remote 
Commander (Supplied)

VGP-AC19V45 AC Adaptor 
(Supplied)

PCS-A1 Microphone (Two 
supplied with PCS-XG100S / 
one supplied with 
PCS-XG77S)
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Power requirements
DC 19.5 V

Current consumption
0.3 A

Operating temperature
5 °C to 35 °C (41 °F to 95 °F)

Operating humidity
20% to 80%

Storage temperature
–20 °C to +60 °C 

(–4 °F to +140 °F)
Storage humidity

20% to 80% (no condensation)
Dimensions 166 mm × 34 mm × 128 mm 

(W × H × D) (6 5/8 inches × 
1 3/8 inches × 5 1/8 inches) (not 
including projections except for 
the feet)

Mass Approx. 400 g (14 oz)
Supplied accessories

Interface cable (5 m) (16.4 ft) (1)
Operating Instructions (1)
Warranty booklet (1)

Power requirements
DC 19.5 V

Current consumption
0.5 A

Operating temperature
5 °C to 35 °C (41 °F to 95 °F)

Operating humidity
20% to 80%

Storage temperature
–20 °C to +60 °C 

(–4 °F to +140 °F)
Storage humidity

20% to 80% (no condensation)
Dimensions 166 mm × 34 mm × 128 mm 

(W × H × D) (6 5/8 inches × 
1 3/8 inches × 5 1/8 inches) (not 
including projections except for 
the feet)

Mass Approx. 400 g (14 oz)
Supplied accessories

Interface cable (5 m) (16.4 ft) (1)
Operating Instructions (1)
Warranty booklet (1)

Design and specifications are subject to change 
without notice.

The terms HDMI and HDMI High-Definition 
Multimedia Interface, and the HDMI Logo are 
trademarks or registered trademarks of HDMI 
Licensing LLC in the United States and other 
countries.

PCSA-B384S ISDN Unit 
(Optional)

PCSA-B768S ISDN Unit 
(Optional)

PCSA-MCG106 HD MCU 
Software (Optional)

PCSA-MCG109 HD MCU 
Software (Optional)

PCSA-RXG77 HD Upgrade 
Software (Optional)

• Always make a test recording, and verify 
that it was recorded successfully.
SONY WILL NOT BE LIABLE FOR 
DAMAGES OF ANY KIND 
INCLUDING, BUT NOT LIMITED TO, 
COMPENSATION OR 
REIMBURSEMENT ON ACCOUNT OF 
FAILURE OF THIS UNIT OR ITS 
RECORDING MEDIA, EXTERNAL 
STORAGE SYSTEMS OR ANY OTHER 
MEDIA OR STORAGE SYSTEMS TO 
RECORD CONTENT OF ANY TYPE.

• Always verify that the unit is operating 
properly before use. SONY WILL NOT 
BE LIABLE FOR DAMAGES OF ANY 
KIND INCLUDING, BUT NOT 
LIMITED TO, COMPENSATION OR 
REIMBURSEMENT ON ACCOUNT OF 
THE LOSS OF PRESENT OR 
PROSPECTIVE PROFITS DUE TO 
FAILURE OF THIS UNIT, EITHER 
DURING THE WARRANTY PERIOD 
OR AFTER EXPIRATION OF THE 
WARRANTY, OR FOR ANY OTHER 
REASON WHATSOEVER.

Notes
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Sales and distribution of MPEG-4 
Visual encoders/decoders
THIS PRODUCT IS LICENSED UNDER 
THE MPEG-4 VISUAL PATENT 
PORTFOLIO LICENSE FOR THE 
PERSONAL AND NON-COMMERCIAL 
USE OF A CONSUMER FOR 

(i) ENCODING VIDEO IN COMPLIANCE 
WITH THE MPEG-4 VISUAL 
STANDARD (“MPEG-4 VIDEO”) 

AND/OR 
(ii) DECODING MPEG-4 VIDEO THAT 

WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL AND 
NON-COMMERCIAL ACTIVITY AND/
OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED BY MPEG LA 
TO PROVIDE MPEG-4 VIDEO. 

NO LICENSE IS GRANTED OR SHALL BE 
IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION 
INCLUDING THAT RELATING TO 
PROMOTIONAL, INTERNAL AND 
COMMERCIAL USES AND LICENSING 
MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM 

MPEG LA is offering licenses for 
(i) manufacturing/sales of any storage media 

storing MPEG-4 Visual video information 
(ii) distribution/broadcasting of MPEG-4 

Visual video information in any manner 
(such as online video distribution service, 
internet broadcasting, TV broadcasting). 

Other usage of this product may be required to 
obtain license from MPEG LA. 
Please contact MPEG LA for any further 
information. MPEG LA, L.L.C., 250 STEELE 
STREET, SUITE 300, DENVER, 
COLORADO 80206, 
http://www.mpegla.com

Sales and distribution of MPEG-4 
AVC (3-1) encoders/decoders
THIS PRODUCT IS LICENSED UNDER 
THE AVC PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL AND 
NON-COMMERCIAL USE OF A 
CONSUMER TO 

(i) ENCODE VIDEO IN COMPLIANCE 
WITH THE AVC STANDARD (“AVC 
VIDEO”) 

AND/OR 
(ii) DECODE AVC VIDEO THAT WAS 

ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL AND 

NON-COMMERCIAL ACTIVITY AND/OR 
WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED TO PROVIDE AVC 
VIDEO. NO LICENSE IS GRANTED OR 
SHALL BE IMPLIED FOR ANY OTHER 
USE. ADDITIONAL INFORMATION MAY 
BE OBTAINED FROM MPEG LA, L.L.C. 
SEE HTTP://MPEGLA.COM 
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PCS-XG100S/XG77S HD Visual Communication System (DVI-I OUT) (DVI / 
Analog RGB)

* Supported only for DVI

PCS-XG100S/XG77S HD Visual Communication System (CAMERA IN)

Acceptable DVI-I Output Signals

Picture 
element

Transmission 
format

Remarks Horizontal sync 
frequency fH (kHz)

Vertical sync 
frequency fV (Hz)

1024 × 768 Progressive XGA VESA 60 Hz 48.4 60

Progressive XGA VESA 70 Hz 56.5 70

Progressive XGA VESA 75 Hz 60 75

Progressive XGA VESA 85 Hz 68.7 85

1280 × 768 Progressive WXGA VESA 60 Hz 47.4 60

Progressive WXGA VESA 60 Hz 47.6 60

Progressive WXGA VESA 75 Hz 60.3 75

1280 × 1024 Progressive SXGA VESA 60 Hz 63.98 60

Progressive SXGA VESA 75 Hz 79.98 75

1920 × 1080 Progressive FHD VESA 60 Hz 67.5 60

Progressive FHD 59.94 Hz* 67.43 59.94

Progressive FHD 29.97 Hz* 67.43 29.97

Interlaced FHD 59.94 Hz* 33.75 59.94

Progressive FHD 50 Hz* 56.25 50

Progressive FHD 25 Hz* 56.25 25

Interlaced FHD 50 Hz* 28.13 50

Acceptable CAMERA/DVI-I Input Signals

Picture 
element

Transmission 
format

Remarks Horizontal sync 
frequency fH (kHz)

Vertical sync 
frequency fV (Hz)

1920 × 1080 Progressive FHD 59.94 Hz 67.43 59.94

Progressive FHD 29.97 Hz 67.43 29.97

Interlaced FHD 59.94 Hz 33.75 59.94

Progressive FHD 50 Hz 56.25 50

Progressive FHD 25 Hz 56.25 25

Interlaced FHD 50 Hz 28.13 50
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PCS-XG100S/XG77S HD Visual Communication System (DVI-I 1 IN) (DVI / 
Analog Component (YPbPr))

PCS-XG100S/XG77S HD Visual Communication System (DVI-I 2 (PC) IN) 
(DVI / Analog RGB)

* Supported only for DVI

Picture 
element

Transmission 
format

Remarks Horizontal sync 
frequency fH (kHz)

Vertical sync 
frequency fV (Hz)

1920 × 1080 Progressive FHD 59.94 Hz 67.43 59.94

Progressive FHD 29.97 Hz 67.43 29.97

Interlaced FHD 59.94 Hz 33.75 59.94

Progressive FHD 50 Hz 56.25 50

Progressive FHD 25 Hz 56.25 25

Interlaced FHD 50 Hz 28.13 50

Picture 
element

Transmission 
format

Remarks Horizontal sync 
frequency fH (kHz)

Vertical sync 
frequency fV (Hz)

1024 × 768 Progressive XGA VESA 60 Hz 48.4 60

Progressive XGA VESA 70 Hz 56.5 70

Progressive XGA VESA 75 Hz 60 75

Progressive XGA VESA 85 Hz 68.7 85

1280 × 768 Progressive WXGA VESA 60 Hz 47.4 60

Progressive WXGA VESA 60 Hz 47.6 60

Progressive WXGA VESA 75 Hz 60.3 75

1280 × 1024 Progressive SXGA VESA 60 Hz 63.98 60

Progressive SXGA VESA 75 Hz 79.98 75

1920 × 1080 Progressive FHD VESA 60 Hz 67.5 60

Progressive FHD 59.94 Hz* 67.43 59.94

Progressive FHD 29.97 Hz* 67.43 29.97

Progressive FHD 50 Hz* 56.25 50

Progressive FHD 25 Hz* 56.25 25
254 Specifications



A
ppendix
PCS-XG100S/XG77S HD Visual Communication System (HDMI-1/2 OUT)

PCS-XG100S/XG77S HD Visual Communication System (HDMI IN)

Acceptable HDMI Output Signals

Picture 
element

Transmission 
format

Remarks Horizontal sync 
frequency fH (kHz)

Vertical sync 
frequency fV (Hz)

1920 × 1080 Progressive FHD 59.94 Hz 67.43 59.94

Interlaced FHD 59.94 Hz 33.75 59.94

Progressive FHD 50 Hz 56.25 50

Interlaced FHD 50 Hz 28.13 50

Acceptable HDMI Input Signals

Picture 
element

Transmission 
format

Remarks Horizontal sync 
frequency fH (kHz)

Vertical sync 
frequency fV (Hz)

1920 × 1080 Progressive FHD 59.94 Hz 67.43 59.94

Progressive FHD 29.97 Hz 67.43 29.97

Interlaced FHD 59.94 Hz 33.75 59.94

Progressive FHD 50 Hz 56.25 50

Progressive FHD 25 Hz 56.25 25

Interlaced FHD 50 Hz 28.13 50
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1000BASE-T/100BASE-TX/
10BASE-T jack 

Modular jack

ISDN UNIT connector

CAMERA connector

D-Sub 36-pin connector (amphenol 
type) (female)

Pin Assignments

Pin Signal Description

1 TPOPTX+ Transmit+

2 TPONTX– Transmit–

3 TPIPRX+ Receive+

4 NC —

5 NC —

6 TPINRX– Receive–

7 NC —

8 NC —

Pin Signal Description

1 GND Ground

2 19.5V 19.5V

3 DCLK+ Clock+

4 DCLK– Clock–

5 DR+ Receive data+

6 DR– Receive data–

7 FS+ Frame sync+

8 FS– Frame sync–

9 DX+ Transmit data+

10 DX– Transmit data–

11 RX Serial receive data

12 TX Serial transmit data

13 19.5V 19.5V

1 8

1 13

2 14

14 GND Ground

Pin Signal Description

1 RX0+ Data_0+

2 GND Ground

3 RX1+ Data_1+

4 RX2+ Data_2+

5 GND Ground

6 RXC+ Clock+

7 GND Ground

8 5V 5 V

9 DDC_SCL DDC_CLOCK

10 VISCA_DSR VISCA_DSR

11 GND Ground

12 VISCA_RXD VISCA_RXD

13 GND Ground

14 GND Ground

15 GND Ground

16 VISCA 12V 12 V

17 VISCA 12V 12 V

18 VISCA 12V 12 V

19 RX0– Data_0–

20 GND Ground

21 RX1– Data_1–

22 RX2– Data_2–

23 GND Ground

24 RXC– Clock–

25 GND Ground

26 IN_HPD Hot Plug Detect

27 DDC_SDA DDC_DATA

Pin Signal Description

18 1

36 19
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ISDN 1-3 jacks (PCSA-B384S)
ISDN 1-6 jacks (PCSA-B768S)

Modular jack

TERMINAL connector 
(PCSA-B384S/PCSA-B768S)28 VISCA_DTR VISCA_DTR

29 GND Ground

30 VISCA_TXD VISCA_TXD

31 GND Ground

32 GND Ground

33 GND Ground

34 VISCA 12V 12 V

35 VISCA 12V 12 V

36 VISCA 12V 12 V

Pin Assignments on Optional 
Board Connectors

Pin Signal Description

1 NC –

2 NC –

3 TA Transmit+

4 RA Receive+

5 RB Receive–

6 TB Transmit–

7 NC –

8 NC –

Pin Signal Description

1 8

Pin Signal Description

1 GND Chassis ground

2 19.5V 19.5V

3 DCLK+ Clock+

4 DCLK– Clock–

5 DR+ Transmit data+

6 DR– Transmit data–

7 FS+ Frame sync+

8 FS– Frame sync–

9 DX+ Receive data+

10 DX– Receive data–

11 TX Serial transmit data

12 RX Serial receive data

13 19.5V 19.5V

14 GND Ground

1 13

2 14
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For point-to-point connection

For multipoint connection

The port numbers for RTCP that can be set are 49152 to 65535.

List of Port Numbers Used on the PCS-XG100S/XG77S

Signal Port number Type
RAS 1719 UDP

Gatekeeper Discovery 224.0.1.41:1718 UDP Multicast

Q.931 (dial) 2253-2269 TCP

Q.931 (answer) 1720 TCP

H.245 2253-2269 TCP

Audio RTP 49152-49159 UDP

Audio RTCP 49152-49159 UDP

Video RTP 49152-49159 UDP

Video RTCP 49152-49159 UDP

FECC RTP 49152-49159 UDP

FECC RTCP 49152-49159 UDP

2nd Video RTP 49152-49159 UDP

2nd Video RTCP 49152-49159 UDP

SIP 5060 UDP/TCP

Auto bandwidth detection 51234-51235 UDP/TCP

Signal Port number of the 
first point

Port numbers of the second to 
eighth points

Type

RAS 1719 UDP

Gatekeeper Discovery 224.0.1.41:1718 UDP Multicast

Q.931 (dial) 2253-2269 TCP

Q.931 (answer) 1720 TCP

H.245 2253-2269 TCP

Audio RTP

49152-49159

second point: 49172-49179
third point: 49192-49199
forth point: 49212-49219
fifth point: 49232-49239
sixth point: 49252-49259
seventh point: 49272-49279
eighth point: 49292-49299

UDP

Audio RTCP

Video RTP

Video RTCP

FECC RTP

FECC RTCP

2nd Video RTP

2nd Video RTCP

SIP 5060 UDP/TCP

Auto bandwidth 
detection

51234-51235 UDP/TCP

Note
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Meeting Room 
Layout

Lighting Considerations
Do not point the camera toward a window 
where sunlight comes in as back lighting 
may decrease the contrast. If it is necessary, 
cover the window with a thick curtain.

Adjust room lighting so that it falls on the 
participants. Avoid direct light on the TV 
monitor. Light intensity on faces should be 
about 300 lux or more.

USB Storage

Use USB storage devices that support 
USB2.0 with this unit. We recommend using 
the Sony USM32GM / USM32GR 
“POCKET BIT.”

Connection
Connect the device directly to the USB port 
on the main unit.

Access indicator
Off: Standby
Lit: Data being transferred

Removal
Always make sure that the POCKET BIT is 
in standby mode (i.e., the indicator is off) 
before removing it.

Usage precautions
• Do not apply excessive force on the 

POCKET BIT while it is connected to a 
device. Damage to the USB connector 
may result in malfunction of the POCKET 
BIT as well as the connected device.

• Be aware that the surface of this product 
may become hot after extended periods of 
access or use.

• If the connected device is started, 
restarted, or awakened from sleep mode 
while the POCKET BIT is connected, the 
product may not function properly. 
Remove the POCKET BIT before 
performing such operations.

• We recommend creating backups of 
important data.

SONY WILL NOT BE LIABLE FOR 
DAMAGES OF ANY KIND 
INCLUDING, BUT NOT LIMITED 
TO, COMPENSATION OR 
REIMBURSEMENT FOR LOSS OF 
RECORDED DATA ON ACCOUNT 
OF FAILURE OF THIS UNIT OR ITS 
SOFTWARE.

POCKET BIT is a trademark of 
Sony Corporation.
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Glossary

ARC
An abbreviation for Adaptive Rate Control. 
Technology which automatically lowers a 
video streaming bitrate against network 
congestion.

ARQ
An abbreviation for Automatic Repeat 
reQuest. Error control method in which the 
receiver requests a retransmission from the 
transmitter when a packet loss occurs.

Auto Bandwidth Detection
Detects the network bandwidth and others 
before communication. By using this value 
for the QoS function, optimum QoS control 
is available from the beginning of the 
communication.

Bonding*
Bonding is one of the Inverse Multiplexing 
methods allowing the connection of the 
communication system with multiple ISDN 
lines. Dialing the first ISDN line enables you 
to connect all other lines. Dialing the second 
and later lines is done automatically by the 
communication between the communication 
systems on both sites. To use bonding, it is 
required that both communication systems 
be equipped with the bonding function and 
that “Area Code” and “Local Number” in the 
ISDN Setup menu of the answering site be 
set correctly. As the communication 
between the systems when using the 
bonding function is made via the ISDN 
numbers of the answering site, the “Area 
Code” and “Local Number” settings in the 
ISDN Setup menu are not essential at the 
dialing site.

* Bonding (Bandwidth on Demand 
Interoperability Group) is a registered 
trademark of THE BONDING 
CONSORTIUM.

BRI
An abbreviation for Basic Rate Interface. 
Basic interface standardized by the ITU-T. 
Single ISDN has two B channels and one D 
channel.

Codec
An abbreviation for Coder-Decoder. An 
integrated device of a coder that converts an 
analog audio/video signal to a digital data 
stream and compresses it, and a decoder for 
expanding to restore the original analog 
signal.

DHCP
An abbreviation for Dynamic Host 
Configuration Protocol. Manages IP 
addresses in the network.

DNS
An abbreviation for Domain Name System. 
Defines the domain name system.

Echo Canceller
Device to eliminate echo that occurs when 
transmitting audio.

FEC
An abbreviation for Forward Error 
Correction. Error control method in which 
the receiver can correct errors without 
requesting a retransmission from the 
transmitter.

Frame rate
The number of frames which can be 
encoded/decoded in one second.

G.711
Audio encoding/decoding format 
recommended by the ITU-T. A phone 
bandwidth audio signal is converted to a 
digital signal with a data rate of 64 Kbps. It 
can be transmitted with a data rate of 56 
Kbps.

G.722
Audio encoding/decoding format 
recommended by the ITU-T. A 7-kHz 
bandwidth audio signal is converted to a 
digital signal with a data rate of 48 Kbps, 56 
Kbps or 64 Kbps.

G.728
Audio encoding/decoding format 
recommended by the ITU-T. A phone 
bandwidth audio signal is converted to a 
digital signal with a data rate of 16 Kbps.
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Gatekeeper
Controls the access of H.323 
communication devices on a network. 
Administers the zone, access limitation, 
audio/video bandwidth, and alias etc.

H.221
Frame structure for a digital channel in 
audiovisual teleservices.

H.239
ITU-T standard for sharing data and 
presentations with video. This supports the 
dual video presentation mode, enabling 
endpoints to receive and transmit video and 
presentation data simultaneously.

H.261
Video codec for audio/visual services as p × 
64 Kbps. A standard that defines a video 
coding algorithm, picture format and error 
correcting technology for communication 
between different manufacturers’ video 
codecs.

H.263
A video coding algorithm based on the 
H.261 standard. This format enables 
communication via a lower bit rate.

H.263+
Video encoding/decoding format based on 
the H.263 standard, added by the Annex I to 
T (I, J, K …… T), that allows enhanced 
picture quality and error resistance. 
Normally, this format is a profile used with 
a combination of some of the Annex for 
H.263/H.263+.

H.264
A video coding algorithm standardized by 
the ITU-T in May 2003. This format realizes 
high-quality picture via a lower bit rate. It 
provides an equal picture quality via half as 
low bit rate as the H.263 format. The H.264 
format is also called as MPEG4 Advanced 
Video Coding (AVC).

H.320
A standard for communication between 
different communication systems.

H.323
This enables communications on the 
non-Qos (Quality of Service) LAN.

HD
An abbreviation for High Definition. High 
Definition television provides a 
high-resolution and high-quality picture. 
There are 1080i, 1080p and 720P HD 
formats.

HOP
Number of routers that have passed through 
to reach the remote party.

I-MUX
An abbreviation for Inverse Multiplexer. 
This protocol allows you to transmit the data 
at 384 Kbps via 6B-channel.

ISDN
An abbreviation for Integrated Services 
Digital Network. This is a communication 
protocol by CCITT on transmission of 
integrated voice, video, and data. 
Bandwidths include basic (64 Kbps) and 
primary rate (1.544 and 2.048 Mbps).

ITU-T
An abbreviation for International 
Telecommunication Union, 
Telecommunications.

Lip synchronization
A function that synchronizes sound with 
motion. Sound processing is much faster 
than motion processing, thus sound and 
motion sometimes get out of step with each 
other.

P in P
An abbreviation for “Picture in Picture.” 
This is a function which allows you to 
monitor your own party on a small window 
on your TV monitor.

QoS
An abbreviation for Quality of Service. QoS 
reserves a bandwidth for specific 
communication in the network and 
guarantees a given communication speed.
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SIP
An acronym for Session Initiation Protocol. 
SIP is a communication control protocol 
used for Internet telephony, instant 
messaging, etc.

SNMP
An abbreviation for Simple Network 
Management Protocol. This protocol is for 
management information between the 
management station and the managed 
terminals. This enables the monitoring of 
Sony Communication Systems.

SPID
An abbreviation for Service Profile ID.

Streaming
A technology that allows audio and video 
data to be played back as it is downloaded 
for real time viewing over a network, such as 
the Internet. 

Sub-address
An identification number given to devices 
sharing a common ISDN line.

TOS
Inputting the information data in the TOS 
field of the IP address allows the 
communication system to judge the packet 
transmission priority, etc. It also enables 
change of path according to the types of 
service (Delay or Size).
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Menu Configuration
The menus of the HD Visual Communication System are configured as 
described below.
For detailed information, see pages in parentheses. The initial settings of each 
item are bolded.
Settings and options marked with an asterisk (*) do not appear on the 
PCS-XG77S.
Settings and options marked with two asterisks (**) will be supported in 
version 2.0.

Home  Camera  Adjustments  Camera Angle 
  Brightness  Auto Adjustment, Manual Adjustment 
  Preset  Preset Setting List 
   New Entry  Preset Number, Camera   
    Angle, Thumbnails
  Details Digital Zoom   Off, On
   Backlight  On, Off
   White Balance Auto, Indoor, Outdoor,   
    ONE PUSH
   Focus  Auto, Manual
   Focus Adjustment
   WIDE D1) Off, Low, Mid, High
   Shutter Speed Auto, 1/100
    
 Tools  Presentation  Execute, Stop
 
  Streaming  Execute, Stop
 
  Recording  Execute, Stop
 
  Annotation  Execute  Background Screen,    
   Stop Annotation Mode, Start
  Icon Display  On, Off 

  Reject Answer*  On, Off

  Screen Capture  Execute 

  Machine Status Machine Information 
   Peripheral Status 
   Communication Mode Status 
   LAN Line Status 
   Network Routing Check
  Setup  Line I/F A 
   Dial B
   Answer C
   Multipoint* D
   Communication E
   Audio F
   Video G
   LAN H
   QoS  I

Continued on next page Continued on next page

(page 45) (page 135)

(page 150) (page 153)

(page 155)

(page 157)

(page 160)

(page 58)

(page 91)

(page 148)
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  TOS  J
  SIP K

   ISDN** L
   Annotation M
   Camera N
   General O
   Home Menu P
   Administrator Q
   Encryption R
   Shared Phone Book S
 
 History  Dial, Answer, Missed Call  
  Phone Book “Phone Book” 
  Detailed Dial “Detailed Dial” 

 Phone Book/  Phone Book List  
 Private Phone  New Entry Index, Group Select, Dial to:, Auto Dial, Image,
 Book  One-Touch Dial Specified, Line I/F, Communication  
   Bit Rate, Number of Lines, More Options     “More  
   Options”
                        
  Group Edit  
  History “History” 
  Detailed Dial “Detailed Dial” 

 One-Touch Dial  F1, F2, F3, F4

  
 Direct Dial  Line interface  IP, IP(2)*, ISDN**, TEL, SIP
  IP address, Telephone number 
  Dial 

 Connect Enter Number/Address “Detailed Dial” 
  Select from Phone Book “Phone Book” 
  Select from History “History” 

 Detailed Dial  Detailed Dial  Dial to:, Line I/F, Communication Bit Rate,   
   Number of Lines 
  Phone Book “Phone Book” 
  History “History” 
  More Options Enable “List Edit” 

(page 109)

(page 121)

(page 108)

(page 115)

(page 112)

(page 111)

1) Only available when a SRG-120DH Camera Unit is connected.

A Line I/F  Line Interface  IP, ISDN**, SIP 
   
 Primary Line Interface  IP, ISDN**, SIP

 Use LAN2* Off, On                       

(page 62)
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B Dial  Telephone Mode  Auto, G.711  -law, G711A-law 
More Options Enable  Off, On 
User Name Input  Off, On
Prefix  Prefix-None, Prefix-A, Prefix-B, Prefix-C
Prefix-A
Prefix-B
Prefix-C
Select LAN Prefix  Disable, Enable
LAN Prefix   

(page 62)

C Answer   Auto Answer  On, Off 
ISDN MSN**  Off, On 
Mic on Answer  On, Off
Reject Answer* On, Off

(page 63)

D Multipoint*   Multipoint Mode   AUTO, On 

 Broadcast Mode  Split, Voice Activate, Voice Activate (1080P)   
  
 Split  Automatic, Six-screen Mosaic, Nine-screen Mosaic

(page 63)
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E Communication  IP  Individual Settings for   Off, On
(Communication) Transmission/Reception
 Individual Settings for  Off, On
 Point-to-Point/Multipoint*

IP:Mode Total Bandwidth* 128Kbps, 384Kbps, 
(Communication)4)  512Kbps, 768Kbps, 
  1Mbps, 2Mbps, 3Mbps,  
  4Mbps, 5Mbps, 6Mbps, 
  7Mbps, 8Mbps, 9Mbps, 
  10Mbps, 11Mbps,    
  12Mbps, 13Mbps,    
  14Mbps, 15Mbps,    
  16Mbps, Other
 Communication Bit Rate1) 128Kbps, 384Kbps, 
  512Kbps, 768Kbps, 
  1Mbps, 2Mbps, 3Mbps,  
  4Mbps, 5Mbps*, 6Mbps*, 
  7Mbps*, 8Mbps*, 
  9Mbps*, 10Mbps*,    
  11Mbps*, 12Mbps*,   
  13Mbps*, 14Mbps*,    
  15Mbps*, 16Mbps*,   
  Other

 Audio Mode1)  G.711, G.722, G.728,   
  MPEG4
 Far End Camera Control2)  On, Off
 H.239  On, Off
 H.239 Ratio  2/3, 1/2, 1/3
 Screen Size1)  1080*3), 720, W4CIF,   
  W432P, WCIF, 4CIF, CIF,  
  QCIF, AUTO
 Video Mode1) H.261**, H.263+, H.264
 Video Frame1)  15fps, 30fps, 60fps, AUTO

ISDN** Individual Settings for  Off, On
 Point-to-Point/Multipoint*

Continued on next page

(page 64)
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 ISDN:Mode  ISDN Bandwidth (Dial)5)  1B(64K), 2B(128K),   
 (Communication)** 4)  3B(192K), 4B(256K),   
   5B(320K), 6B(384K),   
   8B(512K), 12B(768K)
  ISDN Bandwidth 1B(64K), 2B(128K),   
  (Answer)5) 3B(192K), 4B(256K),   
   5B(320K), 6B(384K),   
   8B(512K), 12B(768K)
  Audio Mode5)  G.711, G.722, G.728,   
   MPEG4
  Far End Camera Control5)  On, Off
  H.239  On, Off
  H.239 Ratio  2/3, 1/2, 1/3
  Restrict  Auto, 56K
  Screen Size5)  720, W4CIF, W432P,   
   WCIF, 4CIF, CIF, AUTO
  Video Mode5) H.261**, H.263+, H.264
  Video Frame5)  15fps, 30fps, AUTO

 SIP:Mode Communication Bit Rate  128Kbps, 384Kbps,    
 (Communication)4)  512Kbps, 768Kbps,    
   1Mbps, 2Mbps, 3Mbps,   
   4Mbps, Other
  Audio Mode  G.728, G.722, G.711 
  Far End Camera Control  On, Off
  Screen Size  720, W4CIF, W432P,   
   WCIF, 4CIF, CIF, QCIF,   
   AUTO
  Video Mode  H.261**, H.263+, H.264,  
   MPEG4
  Video Frame  15fps, 30fps, 60fps, AUTO

1) When “Individual Settings for Transmission/Reception” or “Individual Settings for Point-to-Point/
Multipoint” is set to “On” on the IP page, the item is set up for transmission, reception, point-to-point 
and multipoint individually.

2) When “Individual Settings for Point-to-Point/Multipoint” is set to “On” on the IP page, the item is 
set up for point-to-point and multipoint individually.

3) Also available on the PCS-XG77S when the PCSA-RXG77 HD Upgrade Software is installed.
4) The page number after “Communication2” varies with the on/off setting in “Individual Settings for 

Transmission/Reception” or “Individual Settings for Point-to-Point/Multipoint”.
5) When “Individual Settings for Point-to-Point/Multipoint” is set to “On” on the ISDN page, the item 

is set up for point-to-point and multipoint individually.
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F Audio Basic Setup1   Audio Input  MIC, AUX, MIC+AUX
(Audio1)  Input Select (MIC)/  MIC(A1), AUDIO 1, AUDIO 2 
 Input Select (AUX)  
 Echo Canceller  On, Off
 Audio Output HDMI, AUDIO
 Lip Sync  Auto, Off
 Recording Mute  Off, On
 Input Mode  Stereo, Monaural1)

 Output Mode  Stereo, Monaural

Basic Setup2  AUX Local Monitor Out  On, Off
(Audio2)  Reversed MIC Inputs  Off, On
 Audio Input Delay Setting Default–100ms, Default–50ms, 
  Default, Default+50ms,   
  Default+100ms, Custom
 Audio Input Delay 
 Audio Output Delay Setting Default–100ms, Default–50ms, 
  Default, Default+50ms,   
  Default+100ms, Custom  
 Audio Output Delay 
 REC OUT Mode  Stereo, Monaural 2ch
 
Sound Effect   Beep Sound  Loud, Medium, Quiet, Off
(Audio3) Sound Effect  Loud, Medium, Quiet, Off
 Dial Tone   Loud, Medium, Quiet, Off
 Ringer Tone  Loud, Medium, Quiet, Off

(page 68)

1) The initial setting on the PCS-XG77S is “Monaural”.

G Video  Basic Setup  Video Input  Camera, HDMI*, DVI-I 1, DVI-I 2
 (Video1)   Presentation Screen  Full Screen
  Monitor Output  HDMI 1, DVI-I OUT, HDMI 1 + DVI-I  
   OUT, HDMI 1 + HDMI 2*,   
   Triple monitors*

  DVI-I Monitor Output Format XGA, WXGA, SXGA, 1080i, 1080p 
  Blanking Period Long, Medium, Short
  Frequency  60Hz, 50Hz  

 Custom Input  Custom Input Label (Camera) 
 Label  Custom Input Label (DVI-I 1) 
 (Video2)  Custom Input Label (DVI-I 2) 
  Custom Input Label (HDMI )*

 
 Link to Mic Link to Audio Input  Off, On
 (Video3)  Video Input  Camera, DVI-I 1, DVI-I 2
  Audio Input  MIC, AUX, MIC+AUX
  Input Select (MIC)/  MIC(A1), AUDIO 1, AUDIO 2  
  Input Select (AUX) 

(page 71)
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1) When “Use LAN2” is set to “On” in the Line I/F setup menu, the Basic Setup pages for 
LAN1 and LAN2 are displayed, and you can set up the items on those pages.

H LAN  Basic Setup1)  Host Name 
(LAN)  DHCP Mode  Auto, Off
 Prefix Length
 IP Address 
 Network Mask 
 Gateway Address 
 Primary DNS 
 Secondary DNS 
 LAN Mode  Auto, 1000Mbps, 100Mbps Full Duplex,
   100Mbps  Half Duplex, 
  10Mbps Full Duplex,    
  10Mbps Half Duplex

PPPoE  PPPoE  Off,  LAN1, LAN2*

 (LAN)  User Alias
 Password
 Fixed IP for PPPoE Off,  On
 Fixed IP Address for PPPoE  
 DNS  Obtain automatically, Specify
 Primary DNS 
 Secondary DNS 

NAT Setup  NAT Mode  Auto, On, Off
(LAN)  WAN IP Address 

Gatekeeper  Gatekeeper Mode  Auto, On, Off
(LAN)  Gatekeeper Address 
 User Alias 
 User Number 

Used Port  Q.931 
Number,    H.245

 RTP/RTCP Setup  RTP/RTCP
(LAN) MTU Size
 
SNMP SNMP Mode On, Off
(LAN) Trap Destination
 Community
 Description
 Location
 Contact

(page 73)
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I QoS  Basic Setup Adaptive Rate Control (ARC)  On, Off
(QoS1)  Auto Bandwidth Detection  On, Off
 TCP Port Number 
 UDP Port Number 
 Packet Resend Request(ARQ)  On, Off
  ARQ Buffering Time  300ms, 150ms, 80ms, Auto, Custom
 ARQ Buffering Time 
 Forward Error Correction(FEC)  On, Off
 FEC Redundancy  8, 4, 2, Auto
 Audio Duplex Transmission  On, Off 

Re-Order/Shaping Re-Order  On, Off
(QoS2)  Re-Order Buffer  Auto, 1, 2, Custom
 Re-Order Buffer Rate
 Shaping  On, Off

(page 76)

J TOS TOS Data Type Video, Audio, Data, Presentation
 TOS Off, IP Precedence, DSCP
 Precedence
 Low Delay On, Off 
 High Throughput On, Off  
 High Reliability On, Off 
 Minimum Cost On, Off
 DSCP

(page 78)

K SIP  Basic Setup SIP Server Mode  On, Off
 (SIP)  Transport Protocol  TCP, UDP
  Port Number 
  SIP Domain 
  Registered User Name 
  Password 
  SIP Server Address 
  SIP Server Port 

(page 78)
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L ISDN** Basic Setup Country/Region  Country/region selectable    
(ISDN1)      
 Protocol  Japan(NTT), National ISDN, Euro ISDN,  
  Euro ISDN(France), 5ESS(P-MP),    
  5ESS(P-P), DMS-100

Telephone Number Area Code (A1, A2, B1, B2, C1, C2) 
(ISDN2)  Local Number (A1, A2, B1, B2, C1, C2) 

 Telephone Number Area Code (D1, D2, E1, E2, F1, F2) 
(ISDN3)  Local Number (D1, D2, E1, E2, F1, F2)

Sub Address Sub Address (A1, A2, B1, B2, C1, C2, D1, D2, E1, E2, F1, F2) 
(ISDN4) 

SPID SPID (A1, A2, B1, B2, C1, C2, D1, D2, E1, E2, F1, F2, Auto SPID) 
(ISDN5) 

(page 79)

M Annotation Enable On, Off
 Color Black, Red, Blue, Green, Yellow, Orange,    
  Purple, White
 Line Density Thick, Medium, Thin

(page 81)

N Camera    Second Camera Input  HDMI*, DVI-I 1, DVI-I 2
(page 81)
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O General  Device Setup Terminal Name 
 (General1)  Standby Mode  On, Off
  Standby Time  1-99 minutes
  Last Number Registration  Off, On
  Control by Far End  On, Off
  Language  Japanese, English, French, German,   
   Spanish, Italian, Simplified Chinese,    
   Portuguese, Traditional Chinese, Korean,   
   Dutch, Danish, Swedish, Finnish, Polish,   
   Russian, Arabic, Thai, Norwegian, 
   Turkish, Welsh, Czech, Hungarian
   
 Clock Set NTP  On, Off
 (General2)  Primary NTP Server 
  Secondary NTP Server 
  Time Zone
  Clock Display Pattern  Year/Month/Day, Month/Day/Year,    
   Day/Month/Year, Year-Month-Day,    
   Day.Month.Year
  Date 
  Time
  Time Update  Execute

 Menu Screens Display Time in   Off, Time Display, Current Time
 (General3) Communication
  Display Terminal Name Off, Always Show, Show Temporarily  
  Guide  On, Off
  Display Indicator  On, Off
  Communication Mode   On, Off
   Display 
  Display On-Screen   On, Off
  Keyboard
  Menu Transparency High, Medium, Low

Continued on next page

(page 81)
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Function Keys F1  Far/Near, HDMI*, DVI-I 1, DVI-I 2, 
in Communication   No Operation
(General4) F2  Camera, HDMI*, DVI-I 1, DVI-I 2, No Operation
 F3  Camera, HDMI*, DVI-I 1, DVI-I 2, No Operation
 F4  Camera, HDMI*, DVI-I 1, DVI-I 2, No Operation

P Home Menu Home Menu1 Clock Display  On, Off
(Home Menu1)  Local Terminal Name  On, Off
 Number Display  IP:Address, SIP:User Name, SIP:Address,
  GK:User Alias, GK:User Number, 
  NAT:Address, No Display
 Terminal Status  On, Off
 Warning Messages  On, Off

Home Menu2 Connect Button Display  Simple, Individual, Off   
(Home Menu2) Phone Book Button  On, Off
 History Button  On, Off
 Detailed Dial Button  On, Off
 Camera Button  On, Off
 Tools Button  Off, On
 One-Touch Dial  On, Off
 Direct Dial  Off, On

Home Menu3 Video Input Display  On, Off
(Home Menu3)  Audio Input Display  On, Off
 Audio Level Meter  On, Off
 Volume  On, Off
 LAN Status  On, Off
 ISDN Status  On, Off

(page 83)
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Q Administrator  Password   Administrator Password 
 (Administrator1) Phone Book Modification Password 
  Save Settings Password 
  Remote Access Password 
  Streaming Broadcast Password 

 Setup Password1 Line I/F  Enabled, Disabled
 (Administrator2)  Dial  Enabled, Disabled
  Answer  Enabled, Disabled
  Multipoint* Enabled, Disabled
  IP Mode  Enabled, Disabled
  SIP Mode  Enabled, Disabled
  ISDN Mode  Enabled, Disabled

 Setup Password2 Audio  Enabled, Disabled
 (Administrator3)  Video  Enabled, Disabled
  LAN  Enabled, Disabled
  QoS  Enabled, Disabled
  TOS  Enabled, Disabled
  SIP  Enabled, Disabled
  ISDN  Enabled, Disabled
 
 Setup Password3 General  Enabled, Disabled
 (Administrator4) Home Menu Enabled, Disabled
   Administrator  Enabled, Disabled
  Annotation  Enabled, Disabled
  Camera  Enabled, Disabled
  Encryption  Enabled, Disabled
  Shared Phone Book Enabled, Disabled

 Streaming/Recording Streaming  Enabled, Disabled
 (Administrator5)  Recording  Enabled, Disabled
   Video  512Kbps, 1Mbps 
  Multicast Address 
  Audio Port Number 
  Video Port Number 
  HOP 

 Access Permit1) Web Monitor On, Off
 (Administrator6) Web Access Enabled, Disabled
  Telnet Access  Enabled, Disabled
   SSH Access  Enabled, Disabled

Continued on next page

(page 85)

1) The items on the Access Permit page are displayed and can be set only when 
“Internet Protocol” is set to “IPv4”.
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Other Use History  On, Off
  (Administrator7)  Save Setup  Execute
  Load Setup  Execute
  AMX Device Discovery  Off, On
  HOP 
  Auto Restore  On, Off
  Internet Protocol IPv4, IPv6, IPv4/IPv6**

 Phone Book Save Phone Book  Execute
 (Administrator8) Load Phone Book Execute
  Clear Phone Book  Execute
  Auto Dialing  On, Off
  Create Private Phone Book  Execute
  Delete Private Phone Book  Execute
  Copy to Private Phone Book  Execute

 Software Option Software Option 1
 Screen  Software Option 2
 (Administrator9) Software Option 3
  Software Option 4
  Software Option 5
  Software Option 6
  Software Option 7
  Software Option 8

R Encryption  Encryption Mode Off, Connect Priority, Encrypt Priority
(page 90)

S Shared Phone Book      SPB Mode On, Off
 SPB Server Address
 SPB Server Password

(page 90)
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Index

A

Access Permit    88
Adaptive Rate Control (ARC)    77
Adjustments (cameras)    135
Administrator    87
Administrator Password    85
Administrator setup menu    85
AMX Device Discovery    88
Annotation    18, 81, 87, 151, 159, 235
Annotation Mode    161
Annotation setup menu    81
Answer    63, 86
Answer setup menu    63
Area Code    79
ARQ Buffering Time    77
Audio    86
Audio Duplex Transmission    77
Audio Input    68, 73
Audio Input (AUX)    93
Audio Input (MIC)    93
Audio Input Delay    70
Audio Input Delay Setting    70
Audio Input Display    84
Audio Level Meter    84
Audio level meter    50
Audio Mode    65, 67, 68, 94
Audio Output    93
Audio Output Delay    70
Audio Output Delay Setting    70
Audio Port Number    88
Audio setup menu    68
Auto Answer    63
Auto answer mode    118
Auto Bandwidth Detection    77
Auto Dialing    89
Auto Restore    89
Auto SPID    80
Automatic (split)    198
Automatic adjustment    141
AUX Local Monitor Out    70

B

Background Screen    160
Backlight compensation    141
Basic connections    107

Beep Sound    70
Bit rate - Decode    94
Bit rate - Encode    94
Blanking Period    72
Brightness    137
Broadcast Mode    64, 198
Broadcast select mode    200

C

Camera    81, 87
Camera Button    84
Camera button    47
Camera Control    94
Camera menu    47
Camera setup menu    81
Camera units    34
Cameras    135, 166, 223, 235
Cascade connections via LAN    182
Check Code    94
Clear Phone Book    89
Clock Display    83
Clock Display Pattern    82
Clock Set    82
Color    81
Communication Bit Rate    65, 67
Communication Mode Display    82
Communication Mode Status    94
Communication setup menu    64
Community    76
Connect button    48
Connect Button Display    84
Connect menu    49, 108
Connect Priority    176
Connecting    118
Connecting a computer    153
Connections    107
Contact    76
Control by Far End    81
Copy to Private Phone Book    90
Country/Region    79
Create Private Phone Book    89
Custom Input Label    72
Custom Input Label (Camera)    72
Custom Input Label (DVI-I 1)    72
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On-screen keyboard    19
Option I/F    93
Optional software    187
Output Mode    70

P

Packet Resend Request (ARQ)    77
Pairing    36
Password    75, 79, 85
PCS-A1    164
PCS-A1 Microphone    20, 21, 250
PCSA-B384S ISDN Unit    21
PCSA-B768S ISDN Unit    21
PCSA-MCG106 HD MCU Software    22, 180
PCSA-MCG109 HD MCU Software    22, 180
PCS-XG100S    20
PCS-XG100S HD Visual Communication 

System    20, 235, 249
PCS-XG77S    21
PCS-XG77S HD Visual Communication 

System    21, 235, 249
Pen tablets    159, 235
Peripheral Status    93
Phone Book    48, 85, 89, 113, 120, 121, 124, 

125, 193, 218

Phone Book Button    84
Phone Book button    48
Phone Book Modification Password    85
Port Number    79
PPPoE    75, 104
Precedence    78
Prefix    62
Prefix Length    74
Prefix-A    62
Prefix-B    63
Prefix-C    63
Preparing the system    35
Presentation    151, 153, 241
Presentation mode    153
Presentation Screen    71
Preset function    138
Presets    19
Primary DNS    74, 75
Primary Line Interface    62
Primary NTP Server    82
Private Phone Book    114, 218
Projectors    170
Protocol    79

Q

Q.931    76
QoS    19, 77, 86
QoS setup menu    76

R

Rate    94
REC OUT Mode    70
Recording    19, 87, 151, 157, 241
Recording audio    167
Recording Mute    69
Redialing    117
Registered User Name    79
Reject Answer    63, 151
Remote Access Password    86
Remote Address    94
Remote Commander    35, 36, 55, 83, 144, 146, 

217, 237, 250
Re-Order    77
Re-Order Buffer    78
Re-Order Buffer Rate    78
Restrict    67
Restrictions on the use of IPv6    97
Restrictions on the use of LAN2    96
279Index



Reversed MIC Inputs    70
Ringer Tone    71
Router    99
RTP/RTCP    76
RTP/RTCP Setup    76

S

Save Phone Book    89
Save Settings Password    85
Save Setup    88
Screen Capture    148, 152
Screen Size    66, 67, 68
Second Camera    94
Second Camera Input    81
Second cameras    166
Secondary DNS    74, 75
Secondary NTP Server    82
Secondary terminals    207
Select LAN Prefix    63
Selecting the input picture and sound    143
Serial Number    93
Session Initiation Protocol    78
Setup menus    58
Setup Password    86, 87
Shaping    78
Shared Phone Book    87, 90, 129, 218
Shared Phone Book setup menu    90
SIP    19, 44, 78, 87
SIP connections    25, 33
SIP Domain    79
SIP Mode    86
SIP Server Address    79
SIP Server Mode    78
SIP Server Port    79
SIP setup menu    78
SIP: Mode    67
Six-screen Mosaic    198
SNMP    76
SNMP Mode    76
Software Option    93
Software Option Screen    90
Sound Effect    70
SPB Mode    90
SPB Server Address    90
SPB Server Password    90
SPID    80
Split    64
Split mode    198
SSH Access    88

Standby Mode    39, 81
Standby Time    81
Start Measurement    95
Streaming    19, 86, 87, 151, 155, 218, 221, 241
Streaming Broadcast Password    86
Sub Address    79
Switching the picture display    143
Switching the picture displayed on the monitor 

screen    146
Switching the picture from the remote system    

145
Switching the sound to be sent to the remote 

party    144
Switching video and audio at the same time    

144
System configuration    23
System connections    30
System status    46

T

Tablets    241
TCP Port Number    77
Telephone Mode    62
Telephone Number    79
Telnet    174
Telnet Access    88
Terminal Name    81
Terminal Status    84
Time    82
Time Update    82
Time Zone    82
Tools Button    84
Tools button    47
Tools menu    47, 150
TOS    78, 86
TOS Data Type    78
TOS setup menu    78
Total Bandwidth    65
traceroute    95
Transport Protocol    79
Trap Destination    76
Traversal server    103
Turning power on/off    38, 107
Two LAN connections    26

U

UDP Port Number    77
USB storage    19, 128, 148, 157, 235, 241, 259
280 Index



A
ppendix
Use History    88
Use LAN2    62
Used Port Number    76
User Alias    75, 76
User Name Input    62
User Number    76

V

Video    86, 87
Video Frame    66, 67, 68
Video Input    71, 73, 93
Video Input Display    84
Video Mode    66, 67, 68, 94
Video Output    93
Video Port Number    88
Video setup menu    71
Voice Activate mode    200
Voice meetings    172
Volume    84
Volume adjustment    40, 51, 132

W

WAN IP Address    75
Warning Messages    84
Web Access    88, 174
Web browsers    174, 210
Web Control Function    210
Web Monitor    88, 218, 222
White balance    141
281Index



Sony Corporation


	Table of Contents
	Chapter 1: Installation and Preparation
	Using This Manual
	Features
	System Components
	Basic System Components
	Optional Equipment

	System Configuration
	System Configuration via a LAN
	System Configuration via an ISDN
	System Configuration via a SIP
	System Configuration Using Two LAN Connections (PCS-XG100S only)
	System Configuration via a LAN for Multipoint (PCS-XG100S only)
	System Configuration via an ISDN for Multipoint (PCS-XG100S only)
	System Configuration via a LAN and ISDN for Multipoint (PCS-XG100S only)

	System Connections
	System Connection via a LAN
	System Connection via an ISDN
	System Connection via a SIP
	Attaching the Camera Unit to a Tripod

	Preparing the System
	Inserting Batteries into the Remote Commander
	Pairing the Remote Commander with the Main Unit

	Turning the System On/Off
	Turning On
	Standby Mode Function
	Setting the HD Visual Communication System to Standby Mode
	Turning Off
	Adjusting the Volume on the TV Monitor

	Setting Up the System Immediately after the Installation - Initial Setup Wizard
	Using the Menus
	Identifying the Home Menu
	Operation Using the Menu
	Entering Characters Using the Remote Commander
	Entering Characters Using the On-Screen Keyboard


	Chapter 2: Registration and Setup for System Administrators
	Registering Local Information
	Opening the Setup Menu
	Line Interface Setup Menu
	Dial Setup Menu
	Answer Setup Menu
	Multipoint Setup Menu (PCS-XG100S only)
	Communication Setup Menu
	Audio Setup Menu
	Video Setup Menu
	LAN Setup Menu
	QoS Setup Menu
	TOS Setup Menu
	SIP Setup Menu
	ISDN Setup Menu
	SPID Settings for Customers in the USA and Canada
	Annotation Setup Menu
	Camera Setup Menu
	General Setup Menu
	Home Menu Setup Menu
	Administrator Setup Menu
	Encryption Setup Menu
	Shared Phone Book Setup Menu

	Displaying the Machine Status
	Displaying the Machine Status Menu
	Machine Information
	Peripheral Status
	Communication Mode Status
	LAN Line Status
	Network Routing Check

	Restrictions on the Use of LAN2 (PCS-XG100S only)
	Restrictions on the Use of IPv6
	Setting Up the Network Configurations
	LAN Connection via DHCP (LAN1/LAN2)
	LAN Connection through a Router (LAN1/LAN2)
	LAN Connection through a Gatekeeper (LAN1 Only)
	LAN Connection through NAT (LAN1 Only)
	LAN Connection with H.460 Firewall Traversal (LAN1 Only)
	LAN Connection Using PPPoE (LAN1/LAN2)
	ISDN Connections

	About the Network Routing Check

	Chapter 3: Basic Connection
	Starting a Connection by Calling a Remote Party
	Turning On the Power
	Calling a Remote Party by Using the Connect Menu
	Calling a Remote Party by Entering Their Address or Number Directly (Direct Dial)
	Calling a Remote Party Using the One-Touch Dial Buttons
	Calling a Remote Party by Selecting Them in the History List
	Calling a Remote Party Registered in the Phone Book
	Calling a Remote Party Not Registered in the Phone Book

	Receiving a Call from a Remote Party
	Answering Calls (Manual/Auto Answer Mode)
	Answering a Call from a Remote Party

	Ending the Connection
	Registering a Remote Party - Phone Book
	Registering a New Remote Party
	Editing the Contents of the Phone Book
	Copying a Registered Party in the Phone Book
	Deleting the Registered Remote Party
	Creating a Group in the Phone Book (Group Edit)
	Creating a Private Phone Book
	Using the Shared Phone Book

	Adjusting the Sound
	Adjusting the Volume of the Received Sound
	Turning Off the Sound Momentarily - Muting Function
	Turning Off the Sound on Answering - Mic on Answer Function
	Synchronizing Audio and Video - Lip Sync Function
	Reducing Echo - Echo Canceller

	Adjusting the Camera
	Adjusting the Camera Angle and Zoom
	Adjusting the Brightness
	Using the Preset Function
	Adjusting the Camera in the Detailed Setup Menu

	Selecting the Input Picture and Sound
	Switching the Displayed Picture between the Local and Remote Pictures
	Selecting the Input Picture
	Selecting the Video Input Using the F1 to F4 (Function) Buttons on the Remote Commander
	Switching the Sound to Be Sent to the Remote Party
	Switching Video and Audio at the Same Time
	Switching the Picture from the Remote System

	Switching the Picture Displayed on the Monitor Screen
	Capturing the Screen

	Chapter 4: Connection with Optional Equipment
	Using a Tools Menu
	Using the Computer Picture for Presentation
	Connecting a Computer
	Making a Presentation

	Streaming a Communication
	Recording a Visual Communication
	Using the Annotation Function
	Connecting a Pen Tablet
	Using the Annotation Function while in Communication

	Using Multiple Microphones
	Using a Second Camera
	Recording during a Communication
	Sending Audio/Video from the External Equipment to a Remote Party
	Viewing the Picture from the System on a Monitor or Projector
	Communicating without the Picture - Voice Meeting
	Controlling the Remote System with the Tone Signal - DTMF Transmission
	Accessing the Communication System
	Using a Web Browser
	Using Telnet
	Using SSH


	Chapter 5: Encrypted Connection
	Preparing for an Encrypted Connection via LAN
	Starting an Encrypted Connection

	Chapter 6: Multipoint Connection
	Connection Examples of a Multipoint Connection
	Using the LAN Connection (Up to Nine Points)
	Using the Cascade Connection via LAN (Up to 16 Points)
	Using the ISDN Connection
	Using Both LAN and ISDN
	Using the LAN Cascade and ISDN Connection

	Adding Optional Software
	Confirming that the Installation of the Optional Software is Complete

	Configuring Multipoint
	Setting Up Multipoint
	Registering the Remote Parties in the Multipoint Connection List

	Starting a Multipoint Connection
	Calling Remote Parties
	Receiving a Call from a Remote Party

	Using the Display Control
	Broadcast Mode
	Broadcast Modes and Displayed Windows
	Switching the Broadcast Mode
	Receiving the Broadcast Requested From Another Terminal

	Ending the Multipoint Connection
	Notes on Secondary Terminals
	Multipoint Attributes

	Chapter 7: Web Control Function
	Opening the Web Page
	Identifying a User
	Selecting a Menu
	How to Use [Home] Menu
	How to Use [Download] Menu
	How to Use [Remote Commander] Menu
	Selecting a Tool
	How To Configure KIOSK Mode

	How to Use [Version Up] Page
	How to Use [Streaming] Page
	How to Use [Monitor] Page

	Chapter 8: Camera Units
	HD Camera Unit Features
	PCSA-CXG100
	EVI-H100V
	EVI-HD7V/HD3V

	HD Camera Unit Parts Identification
	PCSA-CXG100
	EVI-H100V
	EVI-HD7V/HD3V
	Pan/Tilt Range

	Phenomena Specific to CMOS Image Sensors

	Appendix
	Location and Function of Parts and Controls
	PCS-XG100S/XG77S HD Visual Communication System
	PCS-RFZ1 RF Remote Commander (Supplied)
	PCSA-B384S ISDN Unit (Optional)
	PCSA-B768S ISDN Unit (Optional)

	Indicators
	On-Screen Messages
	Troubleshooting
	Specifications
	PCS-XG100S/XG77S HD Visual Communication System
	PCS-RFZ1 Remote Commander (Supplied)
	VGP-AC19V45 AC Adaptor (Supplied)
	PCS-A1 Microphone (Two supplied with PCS-XG100S / one supplied with PCS-XG77S)
	PCSA-B384S ISDN Unit (Optional)
	PCSA-B768S ISDN Unit (Optional)
	PCSA-MCG106 HD MCU Software (Optional)
	PCSA-MCG109 HD MCU Software (Optional)
	PCSA-RXG77 HD Upgrade Software (Optional)
	Acceptable DVI-I Output Signals
	Acceptable CAMERA/DVI-I Input Signals
	Acceptable HDMI Output Signals
	Acceptable HDMI Input Signals
	Pin Assignments
	Pin Assignments on Optional Board Connectors
	List of Port Numbers Used on the PCS-XG100S/XG77S

	Meeting Room Layout
	USB Storage
	Glossary
	Menu Configuration
	Index


